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About This Guide

This ZENworks 10 Configuration Management Software Distribution Reference includes conceptual 
and task-based information to help you effectively manage software distribution in your Novell 
ZENworks 10 Configuration Management SP3 system. This guide is organized as follows:

 Chapter 1, “Basic Concepts,” on page 11

 Chapter 2, “Creating Bundles,” on page 19

 Chapter 3, “Managing Bundles,” on page 45

 Chapter 4, “Managing Bundle Groups,” on page 77

 Chapter 5, “Managing Folders,” on page 85

 Chapter 6, “Managing Bundles by using the ZENworks Adaptive Agent,” on page 87

 Appendix A, “Install, Uninstall, and Repair Parameters,” on page 97

 Appendix B, “Authentication Hook,” on page 105

 Appendix C, “Novell File Upload Extension,” on page 107

 Appendix D, “Bundle Schedules Types,” on page 111

 Appendix E, “Actions,” on page 117

 Appendix F, “Troubleshooting,” on page 181

 Appendix G, “Best Practices,” on page 187

 Appendix H, “Macros,” on page 189

 Appendix I, “Documentation Updates,” on page 199

Audience

This guide is intended for ZENworks Configuration Management administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.

Additional Documentation

ZENworks Configuration Management is supported by other documentation (in both PDF and 
HTML formats) that you can use to learn about and implement the product. For additional 
documentation, see the ZENworks 10 Configuration Management SP3 documentation (http://
www.novell.com/documentation/zcm10/).
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1
1Basic Concepts

Novell ZENworks Configuration Management provides great flexibility in distributing software. 
You can distribute applications and individual files, or simply make modifications to existing files 
on a device.

The following sections contain additional information that is important as you begin creating and 
managing bundles:

 Section 1.1, “Bundles,” on page 11

 Section 1.2, “Assigning Bundles to Devices vs. Users,” on page 12

 Section 1.3, “Packaging Considerations,” on page 12

 Section 1.4, “Dependency Bundles,” on page 13

 Section 1.5, “Content,” on page 16

1.1  Bundles
Software is distributed through the use of bundles. A bundle consists of all the files, configuration 
settings, installation instructions, and so forth required to deploy and manage the application or files 
on a device. There are four types of bundles you can create:

 Directive Bundle: Performs one or more actions on a device. For example, you can use a 
Directive bundle to edit a Windows INI file or text file. You can run a script, start or stop a 
service, or delete a file. In addition, the bundle includes creating various other actions and 
personality actions such as Store Personality and Apply Personality actions.

 File Bundle: Copies or installs files or directories to a device. For example, you can use a File 
bundle to include configuration files or data files. A File bundle is useful to distribute files that 
are not part of a Windows bundle.

 Imaging Bundle: Performs operations before the operating system boots. The various Imaging 
bundle types let you install images on one or more devices, or run ZENworks scripts containing 
any commands that you can issue from the imaging bash prompt.

 Windows Bundle: Distributes a Microsoft Windows Installer (MSI) package, Microsoft 
Windows Software Patch (MSP) package, thin-client application, or other Windows-based 
applications to a Windows device.

The software included with a bundle is uploaded to the ZENworks Server repository. This enables 
the ZENworks Server and ZENworks Adaptive Agent to distribute the software without requiring 
access to any other network locations.

To create a software bundle, you use the Create New Bundle Wizard in ZENworks Control Center or 
by using the zman command line utility. For more information on Creating Bundle using ZENworks 
Control Center, see Chapter 2, “Creating Bundles,” on page 19 and for Creating Bundle using zman 
command line utility, see “ZENworks Command Line Utilities” in the ZENworks 10 Configuration 
Management Command Line Utilities Reference.

The sections in this guide provide conceptual and task-based information to help you effectively 
manage software distribution in your ZENworks system. You can also use the online Help system 
for information about creating bundles.
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1.2  Assigning Bundles to Devices vs. Users
You can assign bundles to both users and devices. There are differences between the two assignment 
types that you need to be aware of. When you assign a bundle to users, the bundle is available to all 
assigned users regardless of the device they log on to. When you assign a bundle to a device, the 
bundle is available to all users who log on to the assigned device.

1.3  Packaging Considerations
Because of the way that ZENworks Configuration Management handles bundle packaging, be aware 
of the following when you create bundles:

 Time Required for Packaging: Creating large MSI and MSP bundles might take several 
hours to package before they are available on ZENworks content servers (ZENworks Servers 
and Content Distribution Points) in your Management Zone. 

Large application files are compressed and encrypted, resulting in smaller bundles that reduce 
bandwidth during transmission and provide greater security during transmission and on the 
content server. The encrypted bundles cannot be removed from the content server and 
inappropriately used.

 Space Required for Packaging: Creating bundles that contain content temporarily requires up 
to twice the amount of disk space as the original files. The bundle creation process uploads 
copies of the original files from the local machine to a temporary directory on the ZENworks 
content server. The process then packages those files as encrypted, compressed ZENworks 
content files. After the ZENworks content files are created, the original uploaded files are 
automatically deleted.

If you are using ZENworks Control Center to create the bundle, and if for some reason you do 
not log out correctly (you close your browser before completing the Create New Bundle 
Wizard, you browse to somewhere else, or your machine crashes), the temporary directory 
mentioned above is automatically cleared after the session time-out is reached (30 minutes, by 
default).

In some circumstances (the ZENworks Server goes down during processing, for example), the 
bundle creation process is unable to delete these temporary files. You can manually delete these 
temporary files, as needed.

Depending on the operating system and the utility used to create the bundle, the temporary files 
are located in the following directories:

Table 1-1   Location of Temporary Files for Windows

Utility Used to Create Bundle Location of Temporary Files

ZENworks Control Center zenworks_home\share\tomcat\temp

zman (command line utility) zenworks_home\work\content-repo\tmp

ZENworks Migration Utility zenworks_home\work\collection\datamodel
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Table 1-2   Location of Temporary Files for Linux

If the space on the temporary location is insufficient, you can specify a different disk drive to 
be the location of temporary files. 

For more information on changing the location of temporary files on a Windows device, see 
“Changing the Location of the Temporary Location on a Windows Server” in the ZENworks 10 
Configuration Management System Administration Reference.

For more information on changing the location of temporary files on a Linux device, see 
“Changing the Location of the Temporary Location on a Linux Server” in the ZENworks 10 
Configuration Management System Administration Reference.

1.4  Dependency Bundles
When you create the following actions for a bundle, you create bundle dependencies:

 Action - Install Bundle

 Action - Launch Bundle

 Action - Uninstall Bundle

 Action - Verify Bundle

A bundle’s Dependency Bundles tree shows the chaining information of that bundle and the action 
sets that each dependency is in. To view the Dependency Bundles tree in ZENworks Control Center, 
click the Bundles tab, click a bundle that has dependent bundles, then on the Summary tab, click the 
Display Bundle Dependencies link in the Dependency Bundles row. If the selected bundle does not 
have dependent bundles, the link displays None instead of Display Bundle Dependencies.

The following sections contain additional information:

 Section 1.4.1, “Primary Applications vs. Dependent Applications,” on page 13

 Section 1.4.2, “Bundle Chains,” on page 14

 Section 1.4.3, “Distributing, Installing, and Launching a Bundle That Has Dependencies,” on 
page 15

1.4.1  Primary Applications vs. Dependent Applications

When working with bundle dependencies, the primary bundle is the bundle for which you are 
establishing dependencies. The bundles that are defined as dependencies are called the dependent 
bundles. The following illustration shows this relationship. Application A as the primary bundle 
with Applications B, C, and D as dependent bundles.

Utility Used to Create Bundle Location of Temporary Files

ZENworks Control Center /var/temp/

zman (command line utility) /var/opt/novell/zenworks/content-repo/tmp/

ZENworks Migration Utility /var/opt/novell/zenworks/collection/datamodel/
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Figure 1-1   Dependency Bundle Tree

A primary bundle can have one dependent application or, as shown in the above example, it can 
have multiple dependent applications.

In addition, a bundle can be both a primary bundle and a dependent bundle, as shown in the 
following illustration. Application A as the primary bundle, with Applications B, B1, B2, C, and D 
as dependent bundles.

Figure 1-2   Dependency Bundle Tree

In the above example, Application B is one of Application A's dependent bundles. At the same time, 
Application B has dependencies on two bundles, Application B1 and Application B2.

1.4.2  Bundle Chains

A bundle chain is two or more bundles linked together by dependencies. In its simplest form, a 
application chain consists of two levels, as shown in the following illustration.

Figure 1-3   Dependency Bundle Tree

However, when bundle dependencies are nested, a bundle chain can grow to include many levels. In 
the following example, Application A has a dependency on Application B. Application B, in turn, 
has dependencies on Application B1 and Application B2. As a result, all three bundles (B, B1, B2), 
in addition to applications C and D, must be present in order for Application A to run.
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Figure 1-4   Dependency Bundle Tree

In some cases, a bundle might belong to more than one bundle chain, as in the following example 
where Application D is a dependent application for both Application A and Application E.

1.4.3  Distributing, Installing, and Launching a Bundle That Has 
Dependencies

When setting up bundle dependencies, you should be aware of the following:

Bundle Assignment: A dependent bundle does not need to be assigned to devices or users. The 
primary bundle, however, must be assigned to one or more devices or users for it to function 
properly.

Distribution and Installation: If dependent bundles have not already been distributed to or 
installed on the user's workstation, when a user launches or installs a bundle, ZENworks Adaptive 
Agent distributes and installs them. ZENworks Adaptive Agent distributes a dependent bundle only 
once, unless the dependent bundle’s version is updated or the distribution or installation is 
unsuccessful. If ZENworks Adaptive Agent is unable to distribute or install a dependent bundle (for 
example, the user’s workstation does not meet the dependent bundle’s system requirements), the 
primary bundle is not launched or installed.

Distribution Through an Add-On Image: If you distribute a bundle through an image add-on, its 
dependent bundles must be included as another image add-on. Otherwise, the distribution of the 
primary bundle fails.

Distribution to Disconnected Workstations: For disconnected workstations, the bundles must be 
force cached to the workstation before it becomes disconnected. If changes are made to dependent 
bundles after the bundles have been cached to workstations, the version number of the primary 
bundle must be updated in order to force a re-cache of the bundles.

Launch: Each time a bundle is launched, ZENworks Adaptive Agent performs any launch 
operations, such as other actions, defined for its dependent bundles.
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Reboot/Shutdown: Ensure that the dependent bundle does not include a Reboot / Shutdown action.

Redeploying a Bundle to Refresh Its Dependencies:  If you change the dependencies of a bundle 
that has already been replicated to content servers, you must redeploy the bundle. This ensures that 
each content server has all of the dependencies required by the bundle. 

To redeploy the bundle from the Bundles tab, locate and click the bundle to display its details, then 
click the Content Servers tab. In the Primary Server Replication Status list, select the check box next 
to the Primary Servers, then click Include to replicate the bundle to the servers. Repeat this 
procedure for Satellite devices as necessary. 

To redeploy the bundle from the Devices tab, locate and click the appropriate device to display its 
details, then click the Content tab. In the Replication Settings list, select the check box next to the 
bundles, then click Include to replicate the bundle.

The bundle will be redeployed according to your Content Replication settings. For more 
information, see “Content Replication” in the ZENworks 10 Configuration Management System 
Administration Reference.

1.5  Content
When you create bundles containing content, the content is copied to content servers (ZENworks 
Servers or Content Distribution Points), replicated to other content servers, and delivered to 
managed devices.

The following sections contain additional information:

 Section 1.5.1, “Content Replication,” on page 16

 Section 1.5.2, “Content Delivery,” on page 16

1.5.1  Content Replication

Content Replication lets you determine how often content (bundle and policy files) is updated on the 
ZENworks (primary) Servers and Content Distribution Points. ZENworks Servers and Content 
Distribution Points are collectively referred to as content servers when discussing them in their roles 
of hosting content.

When a bundle or policy that contains content is added to the Management Zone, the ZENworks 
database is updated to reflect the addition of the content. Content servers are responsible for 
periodically reading the ZENworks database to discover new content. Each content server that does 
not have the content then retrieves the content from a content server where it resides.

If content has been removed from the Management Zone, each content server also removes the 
obsolete content during the periodic update.

For more information, see “Content Replication” in the ZENworks 10 Configuration Management 
System Administration Reference.

1.5.2  Content Delivery

Content delivery, or distribution, refers to the process of transferring bundle and policy content from 
a content server (ZENworks Server or Content Distribution Point) to a managed device.
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There are a variety of settings you can use to determine how content is delivered to managed 
devices. You can:

 Set up Closest Server rules that determine from which content server a managed device 
downloads its content.

 Schedule times, referred to as delivery blackout dates, when content cannot be downloaded by 
managed devices.

 Decide how often you want managed devices to look for new content to download.

For information about performing these tasks, see “Content Delivery” in the ZENworks 10 
Configuration Management System Administration Reference.
Basic Concepts 17
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2
2Creating Bundles

A bundle consists of all the files, configuration settings, installation instructions, and so forth 
required to deploy and manage the application or files on a device. 

Novell ZENworks Configuration Management lets you create bundles by using ZENworks Control 
Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating bundles by using ZENworks 
Control Center:

 Section 2.1, “Creating Directive Bundles,” on page 19

 Section 2.2, “Creating File Bundles,” on page 23

 Section 2.3, “Creating Imaging Bundles,” on page 31

 Section 2.4, “Creating Windows Bundles,” on page 31

The following section explains how to create bundles by using the zman command line utility:

 Section 2.5, “Creating Bundles by Using the zman Command Line Utility,” on page 39

2.1  Creating Directive Bundles
A Directive bundle lets you perform one or more actions on one or more devices, regardless of 
platform. For example, you can use a Directive bundle to edit a Windows INI file or text file. You 
can run a script, start or stop a service, delete a file, and more. In addition, the bundle includes 
various other actions and personality actions such as Store Personality and Apply Personality.

You can use ZENworks Control Center or the zman command line utility to create bundles. The 
following procedure explains how to create a bundle using ZENworks Control Center. If you prefer 
the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

To create a Directive bundle:

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
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3 Select Directive Bundle, then click Next to display the Select Bundle Category page.

4 Select the desired bundle category:

Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create 
a bundle without performing all of the tasks in the Create New Bundle Wizard. After you create 
the empty bundle, you can edit its details to add assignments, actions, and so forth, at a later 
time.

Action Bundle: A bundle with one or more actions.

Apply Personality: A bundle that applies the personality of one or more users on the managed 
device from a personality file stored on the local or network path.

Store Personality: A bundle that stores the personality of one or more users on the managed 
device to a personality file on the local or network path. The personality files are not uploaded 
to the ZENworks content repository.

5 Click Next to display the Define Details page, then fill in the fields.

Bundle Name: Provide a name for the bundle. The bundle name must be different than the 
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The 
name you provide displays in ZENworks Control Center and the ZENworks Adaptive Agent 
(on managed devices).
orks 10 Configuration Management Software Distribution Reference



For more information, see “Naming Conventions in ZENworks Control Center”.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you 
want the bundle to reside. The default is /bundles, but you can create additional folders to 
organize your bundles.

Icon: ZENworks Configuration Management lets you select an icon that users see during 
installation of a particular bundle. This icon applies only to the icon displayed by the 
ZENworks Adaptive Agent on the managed device. ZCC uses default icons to represent the 
different bundles (Directive, File, Imaging, and Windows).

To select an icon, click Browse, then browse to and select the icon you want to display on 
managed devices.

If the desired icon is embedded in a .exe, .dll, or .ico file that has multiple icons from 
which to choose, you must install additional items before you can browse to and select the 
desired icon.

For Mozilla Firefox, if you have not already installed the Novell File Upload extension on this 
device, you must do so before you can download and install the download plug-in or browse to 
and upload the icon. For more information, see “Novell File Upload Extension” on page 107. 
After you install the Novell File Upload extension, you must also install the download plug-in. 
To do so, click the Click here to download plugin message box that displays in the Select Icon 
dialog box (if you have already installed the plug-in on this device, the plug-in box does not 
display), click Manual Install, then click Install Now.

For Microsoft Internet Explorer, you must install the Novell File Upload ActiveX control only; 
there is no download plug-in for Internet Explorer. For more information, see “Novell File 
Upload Extension” on page 107.

After you have downloaded and installed the necessary extensions and plug-in, click  to 
browse to and select the icon you want the ZENworks Adaptive Agent to display to represent 
the bundle. If the icon is embedded in a .exe, .dll, or .ico file that contains multiple icons, 
an additional dialog box displays to let you select the desired icon. 

If you do not specify an icon, a default icon is used.

Description: Provide a short description of the bundle's contents. This description displays in 
ZENworks Control Center and in the ZENworks Adaptive Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in 
Step 4:

 Action Bundle: Continue with Step 7.

 Apply Personality: Continue with Step 8.

 Store Personality: Skip to Step 9.

7 (Conditional) If you are creating an Action bundle, follow the wizard prompts until you reach 
the Summary page, then skip to Step 10. 

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Add Actions page > Add Click Add, then click an action. Fill in the options in the dialog 
box that displays. Click the Help button if you need additional 
information.

Add Actions page > Remove Select the check box next to the action (or actions) you want to 
remove. Click Remove
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8 (Conditional) If you are creating an Apply Personality action, follow the wizard prompts until 
you reach the Summary page, then skip to Step 10. 

Click Help for information about each page or refer to the following table:

9 (Conditional) If you are creating a Store Personality action, follow the wizard prompts until 
you reach the Summary page, then skip to Step 10.

Click Help for information about each page or refer to the following table:

Add Actions page > Move Up Select the check box next to the action (or actions) you want to 
move up. Click Move Up.

Add Actions page > Move Down Select the check box next to the action (or actions) you want to 
move down. Click Move Down.

Add Actions page > Enable Select the check box next to the action (or actions) you want to 
enable. Click Enable.

Add Actions page > Disable Select the check box next to the action (or actions) you want to 
disable. Click Disable.

Add Actions page > Options Click Options. Modify the desired settings, then click OK to 
return to the Add Actions page. Click the Help button if you need 
additional information.

Add Actions page > Continue on 
Failure

Select the check box next to the action (or actions) if you want 
to continue performing the remaining actions in the set on failure 
of the selected action. Select the check box in the Continue on 
Failure column, then click Apply.

Wizard Page and Field Details

Apply Personality page > 
Upload a template from this 
device field 

Select this option and click  to display the Upload Content dialog 
box. Browse to and select the template to upload. 

Apply Personality page > 
Specify a template on the 
managed device field

Select this option to specify the path of the personality migration 
template file on the managed device. You can also specify the UNC 
path of the file.

Apply Personality page > 
Path from where the PNP file 
is to be loaded field

Specify the path of the PNP file containing the migration settings 
and data on the managed device. You can also specify the UNC 
path of the file.

Apply Personality page > 
Password to decrypt the PNP 
file

Select this check box to enter the password to decrypt the PNP file.

If you spanned the PNP file, be sure to keep the spanned files and 
the PNP file in the same folder.

Wizard Page and Field Details

Store Personality page > 
Upload a template from this 
device field 

Select this option and click  to display the Upload Content dialog 
box. Browse to and select the template to upload. 

Wizard Page and Field Details
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10 Review the information on the Summary page, making any changes to the bundle settings by 
using the Back button as necessary.

11 (Conditional) Select the Define Additional Properties check box to display the bundle’s 
Summary page after the wizard completes. You can use the various tabs to edit the bundle’s 
assignments, system requirements, actions, settings, and content replication settings.

12 Click Finish to create the bundle as configured according to the settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, 
schedules, and group membership. At some point, you need to configure additional options for 
the bundle by continuing with Section 3.2, “Assigning Existing Bundles to Devices,” on 
page 46 or Section 3.3, “Assigning Existing Bundles to Users,” on page 49.

2.2  Creating File Bundles
A File bundle lets you copy or install files or directories to a device. For example, you can use a File 
bundle to include configuration files or data files. A File bundle is useful to distribute files that are 
not part of a Windows bundle.

You can use ZENworks Control Center or the zman command line utility to create bundles. The 
following procedure explains how to create a bundle using ZENworks Control Center. If you prefer 
the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

For important information about creating File bundles, see Section 1.3, “Packaging Considerations,” 
on page 12.

To create a File bundle:

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.

Store Personality page > 
Specify a template file on the 
managed device field

Select this option to specify the path of the personality migration 
template file on the managed device. You can also specify the UNC 
path of the file.

Store Personality page > 
Path where the PNP file is to 
be created field

Specify the path of the PNP file on the managed device for storing 
the migration settings and data. You can also specify the UNC path 
of the file.

Store Personality page > 
Password to encrypt the PNP 
file

Select this check box to enter a password to protect the PNP file. 

In the Re-enter the password field, re-enter the password to confirm 
it.

Store Personality page > 
Span to multiple files

Select this option to span the personality migration data across 
multiple files to enable you to store data in removable media.

Select the Never Span option to migrate personalities without 
spanning the files.

Select the Span at the size option to specify a span size for the files. 
The default span size is 650 MB.

Wizard Page and Field Details
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3 Select File Bundle, then click Next to display the Select Bundle Category page.

4 Select the desired bundle category:

Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create 
a bundle without performing all of the tasks in the Create New Bundle Wizard. After you create 
the empty bundle, you can edit its details to add assignments, actions, and so forth, at a later 
time.

Copy Directory: Copies a directory (folder) onto a managed device (or from the device to 
somewhere else). The directory is copied from one location to another at the time this bundle is 
launched on the managed device. The directory is not uploaded to the ZENworks content 
system.

Copy Files: Copies one or more files onto a managed device (or from the device to somewhere 
else). The files are copied from one location to another at the time this bundle is launched on 
the managed device. The files are not uploaded to the ZENworks content system.

Create/Delete Directory: Creates or deletes a directory on the managed device. 

Install Directory: Uploads the contents of a directory and all of its subdirectories to the 
ZENworks content system and then installs them to the destination path on the managed 
device. The content (by default) is replicated to all primary servers.
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Install Files: Uploads selected files to the ZENworks content system and then installs them to 
the destination path on the managed device. The content (by default) is replicated to all primary 
servers.

NOTE: Copying a file or directory copies the file or directory from one location to another 
without uploading the files into the ZENworks content repository. Copying a file or directory is 
described as copying without using content. When copying a file or directory, the managed 
device performs the copy operation and must be able to resolve both the source and destination 
paths. Also, when copying a file or directory, the file or directory is not cached on the managed 
device. 

Installing a file or directory uploads the file or directory to the ZENworks content repository 
before it is distributed to assigned devices. Installing a file or directory is described as copying 
using content. When installing a file or directory, the file or directory is cached on the managed 
device.

Installing an executable file does not launch or execute the file. To launch or execute the file, 
you must add a launch executable action (Launch Windows Executable, Launch Java 
Application, and so forth) to the bundle. For more information, see Appendix E, “Actions,” on 
page 117.

5 Click Next to display the Define Details page, then fill in the fields:

Bundle Name: Provide a name for the bundle. The bundle name must be different than the 
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The 
name you provide displays in ZENworks Control Center and the ZENworks Adaptive Agent 
(on managed devices).

For more information, see “Naming Conventions in ZENworks Control Center”.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you 
want the bundle to reside. The default is /bundles, but you can create additional folders to 
organize your bundles.

Icon: ZENworks Configuration Management lets you select an icon that users see during 
installation of a particular bundle. This icon applies only to the icon displayed by ZENworks 
Adaptive Agent on the managed device. ZCC uses default icons to represent the different 
bundles (Directive, File, Imaging, and Windows).

To select an icon, click Browse, then browse to and select the icon you want to display on 
managed devices.

If the desired icon is embedded in a .exe, .dll, or .ico file that has multiple icons from 
which to choose, you must install additional items before you can browse to and select the 
desired icon.

For Mozilla Firefox, if you have not already installed the Novell File Upload extension on this 
device, you must do so before you can download and install the download plugin or browse to 
and upload the icon. For more information, see “Novell File Upload Extension” on page 107. 
After you install the Novell File Upload extension, you must also install the download plugin. 
To do so, click the Click here to download plugin message box that displays in the Select Icon 
dialog box (if you have already installed the plugin on this device, the plugin box does not 
display), click Manual Install, then click Install Now.

For Microsoft Internet Explorer, you must install the Novell File Upload ActiveX control only; 
there is no download plugin for Internet Explorer. For more information, see “Novell File 
Upload Extension” on page 107.
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After you have downloaded and installed the necessary extensions and plugin, click  to 
browse to and select the icon you want ZENworks Adaptive Agent to display to represent the 
bundle. If the icon in embedded in a .exe, .dll, or .ico file that contains multiple icons, an 
additional dialog box displays to let you select the desired icon. 

If you do not specify an icon, a default icon is used.

Description: Provide a short description of the bundle's contents. This description displays in 
ZENworks Control Center and in the ZENworks Adaptive Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in 
Step 4:

 Copy Directory: Continue with Step 7 on page 26.

 Copy Files: Skip to Step 8 on page 27. 

 Create/Delete Directory: Skip to Step 9 on page 28. 

 Install Directory: Skip to Step 10 on page 29. 

 Install Files: Skip to Step 11 on page 29.

7 (Conditional) If you are creating a Copy Directory bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 12 on page 30. 

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Directory page > 
Source Directory field

Specify the source directory. The path must be resolvable by the 
device on which the bundle is run.

Select Directory page > 
Install the Novell File Upload 
extension link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select Directory page > 
Destination Directory field

Specify the destination directory on the device in which you want to 
copy the directory. The path must be resolvable by the device on 
which the bundle is run.

Select Directory page > 
Hidden check box

Select the Hidden check box to specify that the directory is hidden 
after installation.

Select Files page > Read-
only check box

Select the Read-only check box to specify that the directory is read-
only after installation.
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8 (Conditional) If you are creating a Copy Files bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 12 on page 30. 

Click Help for information about each page or refer to the following table:

Select Files page > Copy 
Option list

Select a copy option from the list:

Copy Always: Copies the contents of the directory regardless of 
whether the files currently exists on the workstation.

Copy If Exists: Copies the contents of the directory only if the files 
currently exists on the workstation.

Copy If Does Not Exist: Copies the contents of the directory only if 
the files does not currently exist on the workstation

Copy If Newer: Copies the contents of the directory only if the 
modified date and time of the file is newer than the existing file’s 
date and time, or if the files does not currently exist on the 
workstation.

Copy If Newer and Exists: Copies the contents of the directory 
only if it already exists on the workstation and the date and time of 
the file is newer than the existing file’s date and time.

Copy if Newer Version: Copies the contents of the directory only if 
the internal version of the file is newer than the existing file’s version 
(if version information is present).

Request Confirmation: Prompts the user to verify that the contents 
of the directory should be copied.

Copy If Different: Copies the contents of the directory if the 
creation date, creation time, or size of the file is different than the 
existing file’s date, time, or size.

Wizard Page and Field Details

Select Files page > File field Click Add to display the Select File dialog box. Click Browse to 
browse and select the file you want to copy to the device, then click 
OK. Repeat these steps as many times as necessary to copy the 
desired files. The path must be resolvable by the device on which 
the bundle is run.

Select Files page > Install the 
Novell File Upload extension 
link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select Files page > 
Destination Directory field

Specify the destination directory on the device in which you want to 
copy the file. The path must be resolvable by the device on which 
the bundle is run.

Select Files page > Create 
Shortcuts for Source Files 
check box

Select the Create Shortcuts for Source Files option to create 
shortcut icons for the source file on the destination directory. The 
source files are not copied to the destination directory. 

Wizard Page and Field Details
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9 (Conditional) If you are creating a Create/Delete Directory bundle, follow the wizard prompts 
until you reach the Summary page, then skip to Step 12 on page 30. 

Click Help for information about each page or refer to the following table:

Select Files page > Hidden 
check box

Select the Hidden check box to specify that the file is hidden after 
installation.

Select Files page > Read-
only check box

Select the Read-only check box to specify that the file is read-only 
after installation.

Select Files page > Copy 
Option list

Select a copy option from the list:

Copy Always: Copies the file regardless of whether the file 
currently exists on the workstation.

Copy If Exists: Copies the file only if the file currently exists on the 
workstation.

Copy If Does Not Exist: Copies the file only if the file does not 
currently exist on the workstation.

Copy If Newer: Copies the file only if its date and time are newer 
than the existing file’s date and time, or if the file does not currently 
exist on the workstation.

Copy If Newer and Exists: Copies the file only if it already exists 
on the workstation and the date and time of the file is newer than the 
existing file’s date and time.

Copy if Newer Version: Copies the file only if its internal version is 
newer than the existing file’s version (if version information is 
present).

Request Confirmation: Prompts the user to verify that the file 
should be copied.

Copy If Different: Copies the file if its date, time, or size is different 
than the existing file’s date, time, or size.

Wizard Page and Field Details

Select Directory page > 
Create Directory field

Select Create Directory option to create a directory on the managed 
device.

Select Files page > Install the 
Novell File Upload extension 
link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select Directory page > 
Delete Directory field

Select Delete Directory option to delete a directory on the managed 
device.

Select Directory page > 
Directory Name

Click Browse to browse and select the directory you want to create 
or delete on the managed device. You can also specify the directory 
name. The path must be resolved by the device on which the bundle 
is run.

Wizard Page and Field Details
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10 (Conditional) If you are creating an Install Directory Files bundle, follow the wizard prompts 
until you reach the Summary page, then skip to Step 12 on page 30. 

Click Help for information about each page or refer to the following table:

11 (Conditional) If you are creating a Install Files bundle, follow the wizard prompts until you 
reach the Summary page, then skip to Step 12 on page 30. 

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Select Directory page > 
Source Directory field

Click  to display the Select Directory dialog box. Browse to and 
select the file to upload. The Status field displays each file’s upload 
status. 

Select Files page > Install the 
Novell File Upload extension 
link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select Directory page > 
Destination Directory field

Specify the destination directory in which you want to install the 
directory. The path must be resolvable by the device on which the 
bundle is run.

Select Directory page > 
Hidden check box

Select the Hidden check box to specify that the directory is hidden 
after installation.

Select Directory page > 
Read-only check box

Select the Read-only check box to specify that the directory is read-
only after installation.

Select Directory page > Copy 
Option list

Select a copy option from the list:

Copy Always: Installs the directory regardless of whether the 
directory currently exists on the workstation.

Copy If Exists: Installs the directory only if the directory currently 
exists on the workstation.

Copy If Does Not Exist: Installs the directory only if the directory 
does not currently exist on the workstation.

Copy If Newer: Installs the directory only if its date and time are 
newer than the existing directory’s date and time, or if the file does 
not currently exist on the workstation.

Copy If Newer and Exists: Installs the directory only if it already 
exists on the workstation and the time of the directory is newer than 
the existing file’s date and time.

Copy if Newer Version: Installs the directory only if its internal 
version is newer than the existing directory’s version (if version 
information is present).

Request Confirmation: Prompts the user to verify that the 
directory should be installed.

Copy If Different: Installs the directory if its date, time, or size is 
different than the existing directory’s date, time, or size.
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12 Review the information on the Summary page, making any changes to the bundle settings by 
using the Back button as necessary.

13 (Conditional) Select the Define Additional Properties check box to display the bundle’s 
Summary page after the wizard completes. You can use the various tabs to edit the bundle’s 
assignments, system requirements, actions, settings, and content replication settings.

Wizard Page and Field Details

Select Files page > File field Click Add to display the Select File dialog box. Click Add to browse 
and select the file you want to install on the device, then click OK. 
Repeat these steps as many times as necessary to copy the desired 
files.

You can click Clear to remove all the files from the list.

Select Files page > Install the 
Novell File Upload extension 
link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select Directory page > 
Destination Directory field

Specify the destination directory in which you want to install the file. 
The path must be resolvable by the device on which the bundle is 
run.

Select Files page > Hidden 
check box

Select the Hidden check box to specify that the file is hidden after 
installation.

Select Files page > Read-
only check box

Select the Read-only check box to specify that the file is read-only 
after installation.

Select Files page > Copy 
Option list

Select a copy option from the list:

Copy Always: Copies the file regardless of whether the file 
currently exists on the workstation.

Copy If Exists: Copies the file only if the file currently exists on the 
workstation.

Copy If Does Not Exist: Copies the file only if the file does not 
currently exist on the workstation.

Copy If Newer: Copies the file only if its date and time are newer 
than the existing file’s date and time, or if the file does not currently 
exist on the workstation.

Copy If Newer and Exists: Copies the file only if it already exists 
on the workstation and the time of the file is newer than the existing 
file’s date and time.

Copy if Newer Version: Copies the file only if its internal version is 
newer than the existing file’s version (if version information is 
present).

Request Confirmation: Prompts the user to verify that the file 
should be copied.

Copy If Different: Copies the file if its date, time, or size is different 
than the existing file’s date, time, or size.
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14 Click Finish to create the bundle as configured per settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, 
schedules, and group membership. At some point in the future, you need to configure 
additional options for the bundle by continuing with Section 3.2, “Assigning Existing Bundles 
to Devices,” on page 46 or Section 3.3, “Assigning Existing Bundles to Users,” on page 49.

2.3  Creating Imaging Bundles
Imaging bundles let you performs operations before the operating system boots. The various 
Imaging bundle types let you install images on one or more devices, or run ZENworks scripts 
containing any commands that you can issue from the imaging bash prompt.

For more information about Imaging bundles, see the ZENworks 10 Configuration Management 
Preboot Services and Imaging Reference.

2.4  Creating Windows Bundles
A Windows bundle lets you distribute a Microsoft Windows Installer (MSI) package, Microsoft 
Windows Software Patch (MSP) package, thin-client application, or other Windows-based 
applications to a Windows device.

You can use ZENworks Control Center or the zman command line utility to create bundles. The 
following procedure explains how to create a bundle using ZENworks Control Center. If you prefer 
the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

To create a Windows bundle:

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.

3 Select Windows Bundle, then click Next to display the Select Bundle Category page.
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4 Select the desired bundle category:

Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create 
a bundle without performing all of tasks in the Create New Bundle Wizard. After you create the 
empty bundle, you can edit its details to add assignments, actions, and so forth, at a later time.

MSI Application: An application that is packaged as a .msi file so that it can be installed by 
the Microsoft Windows Installer program.

For important information about creating MSI Application bundles, see Section 1.3, 
“Packaging Considerations,” on page 12.

MSP Application: An application patch that is packaged as a .msp file so that it can be applied 
by the Microsoft Windows Installer program.

For important information about creating MSP Application bundles, see Section 1.3, 
“Packaging Considerations,” on page 12.

Simple Application: An example of a Simple Application would be launching Windows 
Notepad. Typically, Simple Applications requires ZENworks Adaptive Agent to copy a few 
files to the workstation or make a few changes to the workstations registry, INI files, 
environment variables, and so forth. 

If you have a non-MSI application that is more complex than this, we recommend that you use 
ZENworks Software Packaging, powered by AdminStudio ZENworks Edition, to create an 
MSI package for the application and then use the MSI Application option to create a bundle. 
For more information on installing AdminStudio, see AdminStudio ZENworks Edition 
Installation Guide (http://www.novell.com/documentation/zcm10/pdfdoc/adminstudio/
AS10SP2ZENworksInstallGuide.pdf). 

For more information on the Software Packaging, see AdminStudio ZENworks Edition User 
Guide (http://www.novell.com/documentation/zcm10/pdfdoc/adminstudio/
AS10SP2UserGuide.pdf).

Thin-Client Application: An application, running on a terminal server, that is accessed 
through a terminal server client session (either RDP or ICA). 

Web Application: An application that is launched by using a URL in a Web browser.

5 Click Next to display the Define Details page, then fill in the fields:
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Bundle Name: Provide a name for the bundle. The bundle name must be different than the 
name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The 
name you provide displays in ZENworks Control Center and the ZENworks Adaptive Agent 
(on managed devices).

For more information, see “Naming Conventions in ZENworks Control Center”.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you 
want the bundle to reside. The default is /bundles, but you can create additional folders to 
organize your bundles.

Icon: ZENworks Configuration Management lets you select an icon that users see during 
installation of a particular bundle. This icon applies only to the icon displayed by ZENworks 
Adaptive Agent on the managed device. ZCC uses default icons to represent the different 
bundles (Directive, File, Imaging, and Windows).

To select an icon, click Browse, then browse to and select the icon you want to display on 
managed devices.

If the desired icon is embedded in a .exe, .dll, or .ico file that has multiple icons from 
which to choose, you must install additional items before you can browse to and select the 
desired icon.

For Mozilla Firefox, if you have not already installed the Novell File Upload extension on this 
device, you must do so before you can download and install the download plugin or browse to 
and upload the icon. For more information, see “Novell File Upload Extension” on page 107. 
After you install the Novell File Upload extension, you must also install the download plugin. 
To do so, click the Click here to download plugin message box that displays in the Select Icon 
dialog box (if you have already installed the plugin on this device, the plugin box does not 
display), click Manual Install, then click Install Now.

For Microsoft Internet Explorer, you must install the Novell File Upload ActiveX control only; 
there is no download plugin for Internet Explorer. For more information, see “Novell File 
Upload Extension” on page 107.

After you have downloaded and installed the necessary extensions and plugin, click  to 
browse to and select the icon you want ZENworks Adaptive Agent to display to represent the 
bundle. If the icon in embedded in a .exe, .dll, or .ico file that contains multiple icons, an 
additional dialog box displays to let you select the desired icon. 

If you do not specify an icon, a default icon is used.

Description: Provide a short description of the bundle's contents. This description displays in 
ZENworks Control Center and in the ZENworks Adaptive Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in 
Step 4:

 MSI Application: Continue with Step 7 on page 33.

 MSP Application: Skip to Step 8 on page 36. 

 Simple Application: Skip to Step 9 on page 37. 

 Thin Client Application: Skip to Step 10 on page 37.

 Web Application: Skip to Step 11 on page 38. 

7 (Conditional) If you are creating an MSI Application bundle, follow the wizard prompts until 
you reach the Summary page, then skip to Step 12 on page 38. 

Click Help for information about each page or refer to the following table:
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Wizard Page and Field Details

Select .msi File page > 
Upload .msi file for normal 
install field

Use this option if you want the .msi file copied to the ZENworks 
Server and then distributed from the ZENworks Server to assigned 
users and devices. This is referred to a normal install because 
ZENworks Adaptive Agent copies the .msi file to the managed 
device’s local drive and then the Microsoft Windows Installer program 
installs the application from the local .msi file. 

Click  to display the Select .msi File dialog box. Click Browse to 
select the .msi file to upload. Select the Include all files in and below 
the directory of this file option to include all the supporting files that are 
within the directory containing the .msi file and the subdirectories 
within it. 

NOTE: By default, ZENworks Control Center has a 30-minute timeout 
value. If you leave ZENworks Control Center idle on your computer for 
more than 30 minutes, you are prompted to log in again before 
continuing. Because the upload process can take considerable time for 
a large .msi file, the default timeout value does not apply for this page.

Select .msi File page > 
Enter UNC path of .msi file 
for network install field

Use this option if you want the Microsoft Windows Installer program to 
install the application from the .msi file on a network location. You 
must specify the complete path to the .msi file to use as the source file 
during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive mapping, 
you must ensure that all workstations have the same drive mapped to 
the source location. For this reason, we recommend that you specify a 
UNC path. 

After you create the MSI bundle, you cannot change the .msi 
filename; however, you can change the path to the .msi file. If you 
change the .msi filename, the installation fails.

Select .msi File page > 
Install the Novell File 
Upload extension link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. For 
more information, see Appendix C, “Novell File Upload Extension,” on 
page 107.

Select .msi File page > 
Install Parameters field

Click  to display the Install Parameters dialog box, then specify the 
desired parameters. For more information, click the Help button or see 
Section A.1, “Install Parameters,” on page 97. 

Select .msi File page > 
Unistall Parameters field

Click  to display the Uninstall Parameters dialog box, then specify 
the desired parameters. For more information, click the Help button or 
see Section A.2, “Uninstall Parameters,” on page 99. 

Select .msi File page > 
Repair Parameters field

Click  to display the Repair Parameters dialog box, then specify the 
desired parameters. For more information, click the Help button or see 
Section A.3, “Repair Parameters,” on page 101. 
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Select .msi File page > 
Select Transforms File 
field

Click Add to browse to and select the desired transform file. You can 
upload the transform file or you can specify its location.

Different groups within an organization often use the same application, 
but that doesn’t mean they require the same feature set. One of the 
benefits of Windows Installer is that if you have 10 groups needing 10 
different feature sets or other alterations for the same application, you 
can deploy the same MSI package to all 10 user groups, but with a 
different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSI installation. 
It contains all modification information, such as whether features are 
installed; how they are installed; which files, shortcuts, and registry 
entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio  
ZENworks Edition to create and manage transforms.

Select .msi File page > 
MSI Properties field

The MSI package contains the property values that were defined 
during the administrative installation of the application. These property 
values determine the way the Microsoft Windows Installer installs the 
application to the workstation. In some cases, you might want to 
change one or more of the property values. For example, a property 
value might define the default location for a user’s work files. By adding 
the property to the list and changing the property’s value, you can 
override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in 
the MSI package. When doing so, you should be careful to add only 
those properties that are valid for the package.

To override a property value, you change the property value and add 
the property to the Properties list so that Application Launcher knows to 
use that property value rather than the one defined in the MSI package. 
To do so, click Add to display the MSI Properties dialog box. In the 
Name field, select the property whose value you want to override, 
specify the new value in the Value field, then click OK to add the 
property to the MSI Properties list.

To modify a property that is in the MSI Properties list, select the 
property, click Edit, modify the value data, then click OK.

To remove a property from the MSI Properties list, select the property, 
then click Remove. Deleting the property causes future installations of 
the application to use the property value defined in the MSI package.

Wizard Page and Field Details
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8 If you are creating an MSP Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 12 on page 38.

Click Help for information about each page or refer to the following table:

Select Command page > 
Executable to run field

The Select Command page lets you specify an optional executable to 
run after the .msi file installs. Click Browse to browse for and select 
the executable to run.

If the executable is installed in the Program Files directory on the 
managed device, you must use macros as follows:

 On 32-bit managed device: %ProgramFiles%\filename.

 On 64-bit managed device: %ProgramFiles32%\filename.

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. For 
more information, see Appendix C, “Novell File Upload Extension,” on 
page 107.

Wizard Page and Field Details

Select .msp File page > 
Upload .msp file for normal 
install field

Use this option if you want the .msp file copied to the ZENworks 
Server and then distributed from the ZENworks Server to assigned 
users and devices. This is referred to a normal install because 
ZENworks Adaptive Agent copies the .msp file to the managed 
device’s local drive and then it is installed from the local .msp file. 

Select .msp File page > Enter 
UNC path of .msp file for 
network install field

Use this option if you want to install from the .msp file on a network 
location. You must specify the complete path to the .msp file to use 
as the source file during distribution to the workstation.

You can use a mapped drive or UNC path. If you use a drive 
mapping, you must ensure that all workstations have the same drive 
mapped to the source location. For this reason, we recommend that 
you specify a UNC path. 

After you create the MSP bundle, you cannot change the .msp 
filename; however, you can change the path to the .msp file. If you 
change the .msp filename, the installation fails.

Select .msp File page > 
Install the Novell File Upload 
extension link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Select .msp File page > 
Command Line Parameters 
field

After you select the .msp file, the Command Line Parameters field 
is automatically populated, for example /p patch_package /qn where 
/p designates a patch file, patch_package specifies the .msp file, 
and /qn specifies an installation with no user interface (silent 
installation). To install a .msp file, you should normally use the /qn 
option. 

You can, however, specify additional options. For more information, 
see the MSDN Web site (http://msdn2.microsoft.com/en-us/library/
aa372866.aspx).

Wizard Page and Field Details
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9 If you are creating Simple Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 12 on page 38.

Click Help for information about each page or refer to the following table:

10 If you are creating a Thin Client Application bundle, follow the wizard prompts until you reach 
the Summary page, then skip to Step 12 on page 38.

Click Help for information about each page or refer to the following table:

Wizard Page and Field Details

Enter the Command to Run 
page > Command field

Specify the command to launch the application. You should include 
the full path to the executable in case the executable is not in the 
device’s search path. This path, whether the application is on the 
device’s local drive or a network resource, must be relative to the 
device.

For example, if the executable file is on the device’s local drive, you 
would specify something like c:\winnt\notepad.exe. If the 
executable file is on a network resource, you would specify 
something like j:\apps\notepad.exe (if all users will have J: 
mapped to the location) or 
\\server1\vol1\apps\notepad.exe.

Enter the Command to Run 
page > Install the Novell File 
Upload extension link

If you have not installed the Novell File Upload extension on this 
device, you must do so before you can browse to and upload files. 
For more information, see Appendix C, “Novell File Upload 
Extension,” on page 107.

Enter the Command to Run 
page > Command Line 
Parameters field

Specify any command line parameters that need to be passed to the 
executable.

ZENworks Adaptive Agent passes the parameters exactly as they 
are specified. Therefore, the parameter syntax you use must exactly 
match the syntax the executable requires. For example, if 
word.exe has a /f=filepath parameter that requires paths with 
spaces to be enclosed in quotation marks, you would specify the 
following:

/f="c:\my docs\sample.doc"

Enter the Command to Run 
page > Working Directory 
field

Specify the path to the directory you want the application to use for 
its working files.

Wizard Page and Field Details

Configure Thin Client Details 
page > ICA Session: 
Published Application Name 
field

Type the published application name exactly as it is defined in Citrix.

Configure Thin Client Details 
page > ICA Session: Servers 
Hosting the Application field

Add the Citrix servers that host the application. To add a server, 
specify the server’s IP address or hostname, then click Add.

The order in which the servers are listed is the preferred order for 
launching. You can use the Move Up and Move Down buttons to 
change the order if necessary.
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11 If you are creating a Web Application bundle, follow the wizard prompts until you reach the 
Summary page, then skip to Step 12 on page 38.

Click Help for information about each page or refer to the following table:

12 Review the information on the Summary page, making any changes to the bundle settings by 
using the Back button as necessary.

13 (Conditional) Select the Define Additional Properties check box to display the bundle’s 
Summary page after the wizard completes. You can use the various tabs to edit the bundle’s 
assignments, system requirements, actions, settings, and content replication settings.

14 Click Finish to create the bundle as configured per settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, 
schedules, and group membership. At some point in the future, you need to configure 
additional options for the bundle by continuing with Section 3.2, “Assigning Existing Bundles 
to Devices,” on page 46 or Section 3.3, “Assigning Existing Bundles to Users,” on page 49.

Configure Thin Client Details 
page > RDP Session: 
Terminal Server Address field

Type the terminal server’s IP address or hostname.

Configure Thin Client Details 
page > RDP Session: Server 
Port field

If the terminal server is not using the default port 3389, specify the 
correct port number.

Configure Thin Client Details 
page > RDP Session: Server 
Domain field

If the terminal server is part of a Windows NT domain or an Active 
Directory domain, enter the domain name. If the user’s name and 
password in the domain matches the user name and password in 
Novell eDirectory, the user is not prompted to log in to the terminal 
server when launching the application.

Configure Thin Client Details 
page > RDP Session: 
Application Path field

Specify the path to the application’s executable file from the 
perspective of the terminal server.

Configure Thin Client Details 
page > RDP Session: 
Application Working Directory 
field

Specify the path to the directory you want the application to use for 
its working files.

Configure Thin Client Details 
page > RDP Session: Color 
Depth field

Select the number of colors for the RDP client session. You can 
select 256 Colors, High Color (15 bits), High Color (16 bits), or True 
Color (24 bits). The default is True Color (24 bits).

Configure Thin Client Details 
page > RDP Session: Screen 
Size field

If you want the RDP client session to use the entire desktop area, 
select Operate in full screen mode. Otherwise, select Use specified 
screen size and manually set the width and height (in pixels).

Wizard Page and Field Details

Enter URL page > URL field Specify the location (URL) of the Web application. The URL should 
point to the primary file for the Web application or to a Web page 
that allows access to the Web application.

Click the Test URL button to test the URL.

Wizard Page and Field Details
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2.5  Creating Bundles by Using the zman 
Command Line Utility
ZENworks Configuration Management allows you to create different types of bundles, such as 
Windows bundle, File bundle, Directive bundle, and Imaging bundle. Each bundle has its own set of 
data and configuration settings. Because it is complex to pass the data as arguments in the command 
line, the zman utility takes XML files as an input to create bundles. To use the zman command line 
utility to create a bundle, you must have a bundle of the same type already created through 
ZENworks Control Center and export it to XML. For more information on creating bundles by using 
ZENworks Control Center, see Chapter 2, “Creating Bundles,” on page 19. You can use the exported 
XML file as a template to create bundles by using zman.

For example, you can export a File bundle already created through ZENworks Control Center into 
an XML file, then use it to create another File bundle with zman. 

A bundle can have file content associated with it. For example, an MSI file to be installed is a file 
content associated with a Windows MSI Bundle. 

Bundles can also have dependencies on other bundles. 

Review the following sections to create a bundle by using the zman command line utility:

 Section 2.5.1, “Creating a Bundle without Content or Dependency on Another Bundle,” on 
page 39

 Section 2.5.2, “Creating a Bundle with Content and Dependency on Another Bundle,” on 
page 40

 Section 2.5.3, “Understanding the zman Bundle XML File Format,” on page 42

2.5.1  Creating a Bundle without Content or Dependency on 
Another Bundle

1 Create a bundle in ZENworks Control Center.

For example, use ZENworks Control Center to create a Web Application bundle called google, 
which launches the Google Web site (http://www.google.com).

2 Export the bundle to an XML file by using the following command:

zman bundle-export-to-file bundle_name bundle_filename.xml

For example, export the google bundle to google.xml by using the zman bundle-export-
to-file google google.xml command. 

If you want to create a new bundle with new data, continue with Step 3. If you want to create a 
new bundle with the same data as the google bundle, skip to Step 4. 

3 Modify the XML file according to your requirements.

For example, change the value of <URL> from http://www.google.com to http://
www.yahoo.com in the Launch URL Action section of Launch ActionSet in the XML file 
as shown below.

   <ns2:ActionSets>

        <Id>104e5d74804052eb7ddc4a2f54358d97</Id>

       <Type>Launch</Type>
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        <Version>1</Version>

        <Modified>false</Modified>

        <Data>

            <ns1:Launch/>

        </Data>

        <Actions>

            <Id>2ef5c645774759e9868ba2c157301949</Id>

            <Type>Launch URL Action</Type>

            <Data>

                <ns1:LaunchUrlActionData>

                    <URL>http://www.yahoo.com</URL>

                    <WaitForExit>false</WaitForExit>

                </ns1:LaunchUrlActionData>

            </Data>

            <ContinueOnFailure>false</ContinueOnFailure>

            <Enabled>true</Enabled>

            <Properties />

        </Actions>

    </ns2:ActionSets>

4 Create a new bundle by using the following command:

zman bundle-create new_bundle_name bundle_xml_filename.xml

For example, to create the yahoo bundle, enter the zman bundle-create yahoo google.xml 
command at the console prompt.

2.5.2  Creating a Bundle with Content and Dependency on 
Another Bundle

1 Create two bundles in ZENworks Control Center.

For example, use ZENworks Control Cener to create two MSI application bundles called 
officeXP and officeXPSP1. The officeXP bundle installs Microsoft Office XP through an MSI. 
The officeXPSP1 bundle installs the Service Pack 1 for Microsoft Office XP. In the officeXP 
bundle, add an Install Bundle action to install officeXPSP1.

2 Export the bundle, which has the dependency on another bundle, to an XML file by using the 
following command:

zman bundle-export-to-file bundle_name bundle_filename.xml

This creates bundle_filename.xml and bundle_filename_ActionContentInfo.xml 
files.

For example, export the officeXP bundle to officeXP.xml by using the zman bundle-
export-to-file officeXP officeXP.xml command. The officeXP.xml and 
officeXP_ActionContentInfo.xml files are created. 
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Sample xml format templates, WindowsMSIBundle.xml and ActionInfo.xml, are available 
at /opt/novell/zenworks/share/zman/samples/bundles on a Linux server and in 
"%ZENWORKS_HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows 
server. For more information about ActionContentInfo.xml, see Section 2.5.3, 
“Understanding the zman Bundle XML File Format,” on page 42.

If you want to create a new bundle with new data, continue with Step 3. If you want to create a 
new bundle with the same data as the officeXP bundle, skip to Step 4.

3 Modify the officeXP.xml and officeXP_ActionContentInfo.xml files according to your 
requirements.

For example, to create a new bundle to install ApplicationX and its support pack, do the 
following:

 Change all references of officeXP.msi to ApplicationX.msi in the 
officeXP_ActionContentInfo.xml file.

 Create another bundle called as ApplicationX-SP1 that installs the support pack for 
Application X.

 Change the path of the dependent OfficeXPSP1 bundle to ApplicationX-SP1 in the 
officeXP_ActionContentInfo.xml to install both ApplicationX and its support pack.

A sample officeXP_ActionContentInfo.xml is as follows: 

<ActionInformation>

   <ActionSet type="Install">

        <Action name="Install MSI" index="1">

            <Content>              

                <ContentFilePath includeAllFilesinFolder="false"

includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>

            </Content>                            

        </Action>

        <Action name="Install Bundle" index="2">

         <DependentBundlePath>bundlefolder/ApplicationX-SP1</
DependentBundlePath>             

        </Action>

    </ActionSet>

    <ActionSet type="Uninstall">

        <Action name="Undo Install Actions" index="1">

            <Content>                

                <ContentFilePath includeAllFilesinFolder="false" 
includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>

            </Content>

        </Action>

    </ActionSet>

</ActionInformation>

4 Create a bundle by using the following command:
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zman bundle-create new_bundle_name bundle_xml_filename.xml bundle_location 

--actioninfo bundle_name_ActionContentInfo.xml

If you do not specify the location of the bundle creation, the bundle is created in the root folder 
(/Bundles) by default.

For example, use the following command to create a bundle called ApplicationX in the root 
folder (/Bundles):

zman bundle-create ApplicationX officeXP.xml --actioninfo 
officeXP_ActionContentInfo.xml

You can also specify the folder in which the bundle should be created.

For example, use the following command to create a bundle called ApplicationY in the 
Software folder under the root folder (/Bundles/Software):

zman bundle-create ApplicationY officeXP.xml /Bundles/Software --

actioninfo officeXP_ActionContentInfo.xml

2.5.3  Understanding the zman Bundle XML File Format

The bundle-export-to-file command serializes the bundle information, which is stored in the 
database, into an XML file. Each bundle contains actions that are grouped into action sets such as 
Install and Launch. An exported bundle XML file contains information for the bundle, such as UID, 
Name, Path, PrimaryType, SubType, Category, System Requirements, and information on all 
ActionSets and their actions. The file does not include information about assignment of the bundle 
to devices or users, and add-on images for the bundle.

A sample XML format template, WindowsMSIBundle.xml, is available at /opt/novell/
zenworks/share/zman/samples/bundles on a Linux server and in 
"%ZENWORKS_HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.

NOTE: If the exported XML file contains extended ASCII characters, you must open it in an editor 
by using UTF-8 encoding instead of ANSI encoding, because ANSI encoding displays the extended 
ASCII characters as garbled.

When you create a bundle from the XMLfile, zman uses the information specified in the 
<Description>, <SubType>,<Category>, <ActionSets>, and <SysReqs> elements of the file. 
The values for the Name and Parent Folder are taken from the command line. For the remaining 
elements, the default value is used.

Follow the guidelines listed below to work with the XML file:

 If you want to create a bundle without file content or dependency on another bundle, you need 
only the bundle XML file to create a bundle.

 If you want to create a bundle with content or dependency on another bundle, you must provide 
an additional XML file, which contains the path of the content file or the dependent bundle, as 
an argument to the --actioninfo option of the bundle-create command.

A sample XML format template, ActionInfo.xml, is available at /opt/novell/zenworks/
share/zman/samples/bundles on a Linux server and in 
"%ZENWORKS_HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows 
server.
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 If you want to modify the <Data> element of actions in the exported XMLfile, ensure that the 
new data is correct and that it conforms to the schema. The zman utility does a minimal 
validation of the data and does not check for the errors in the data. Hence, the bundle might be 
successfully created, but with invalid data. Such a bundle fails when deployed on a managed 
device. 

 File content or bundle dependencies are associated with a particular action in <ActionSet>. 
The Action Content Information XML file should contain the path of the file to which the file 
content is to be associated and the index of the action in the <ActionSet>.

For example, the MSI file to be installed when you create the Windows MSI Bundle is 
associated to the first Install MSI action in the Install action set of the created Windows MSI 
Bundle.

 The <ActionSet> is specified by the type attribute. It should be the same as the Action Set 
type of the bundle XML file.

 The <Action> element has a name attribute, which is optional, for user readability.

 The index attribute is mandatory. It specifies the action to which the content or dependency 
should be associated. The index value of the first action in <ActionSet> is 1.

 Each action can have multiple <Content> elements, each containing a <ContentFilePath> 
element. The <ContentFilePath> element contains the path of the file content to be 
associated with the Action. Ensure that the filename is the same as the filename specified in the 
bundle XML file in <Data> for that action.

 Ensure that the order of the <Content> elements is in accordance with the order in the bundle 
XML file. For example, the Windows MSI bundle should have the MSI file in the first 
<Content> element, followed by <Content> elements with the path to the MST files in the 
order specified in <Data> for that action.

 For creating Windows MSI bundles, you can include all the files in the folder or subfolders by 
setting the includeAllFilesinFolder and includeAllFilesinSubFolders attributes to 
True. The dependency to another bundle can be specified by giving the bundle path as a value 
of the <DependentBundlePath> element. The path of the bundle specified should be relative 
to /Bundles as shown below.

<ActionSet type="Install">

<Action name="Install MSI" index="1">

<Content>

<ContentFilePath includeAllFilesinFolder="false" 
includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</
ContentFilePath>

</Content>

<Content>

<ContentFilePath includeAllFilesinFolder="false"

includeAllFilesinSubFolders="false">E:\files\ApplicationX_MST1.mst</
ContentFilePath>

</Content>

</Action>

<Action name="Install Bundle" index="2">

<DependentBundlePath>bundlefolder/ApplicationX-SP1</DependentBundlePath>

</Action>

</ActionSet>
Creating Bundles 43



44 ZENw
 To get the UID of an object, use the object-get-GUID command. You must manually edit the 
object UIDs in the bundle XML file in the following scenarios:

 In the Bundle Installed system requirement, the path and the UID of the bundle must be 
changed in the <BundleInstalledReq> element under the <SysReqs> element.

 In the Imaging bundle, the UID of the server containing the .img file must be manually 
changed in the ZENworks Image and Multicast Image Set actions. Also, the UID of the 
linked application bundle must be manually changed in the Linked Application Bundle 
and Multicast Image Set actions. Ensure that the linked bundle already has an add-on 
image that was created manually, because it is not automatically created when the bundle 
is linked to the image bundle.
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3
3Managing Bundles

The Novell ZENworks Configuration Management Software Management features let you 
effectively manage software and content in your ZENworks system. 

For information about creating Directive, File, Imaging, and Windows bundles, see Chapter 2, 
“Creating Bundles,” on page 19. For information about creating Imaging bundles, see the ZENworks 
10 Configuration Management Preboot Services and Imaging Reference.

The following sections contain information to help you manage existing bundles:

 Section 3.1, “Creating Bundles,” on page 45

 Section 3.2, “Assigning Existing Bundles to Devices,” on page 46

 Section 3.3, “Assigning Existing Bundles to Users,” on page 49

 Section 3.4, “Adding a Bundle to a Group,” on page 52

 Section 3.5, “Renaming, Copying, or Moving Bundles,” on page 53

 Section 3.6, “Adding System Requirements for a Bundle,” on page 54

 Section 3.7, “Copying a Bundle’s System Requirements,” on page 59

 Section 3.8, “Managing Bundle Settings,” on page 60

 Section 3.9, “Managing Bundle Variables,” on page 61

 Section 3.10, “Deleting a Bundle,” on page 62

 Section 3.11, “Editing Bundle Schedules,” on page 63

 Section 3.12, “Incrementing a Bundle’s Version Number,” on page 63

 Section 3.13, “Installing a Bundle,” on page 64

 Section 3.14, “Launching a Bundle,” on page 65

 Section 3.15, “Copying a Bundle to a Content Server,” on page 66

 Section 3.16, “Preventing a Bundle from Being Deployed,” on page 68

 Section 3.17, “Enabling a Bundle to Be Deployed,” on page 68

 Section 3.18, “Enabling a Bundle to Be Uninstalled,” on page 69

 Section 3.19, “Uninstalling a Bundle,” on page 70

 Section 3.20, “Understanding the Bundle Page,” on page 71

 Section 3.21, “Modifying Action Set Options,” on page 72

 Section 3.22, “Show Bundle Activity on the Managed Device,” on page 75

 Section 3.23, “Viewing the Predefined Reports,” on page 75

3.1  Creating Bundles
For step-by-step instructions on creating Directive, File, and Windows bundles, see Chapter 2, 
“Creating Bundles,” on page 19. For more information about creating Imaging bundles, see the 
ZENworks 10 Configuration Management Preboot Services and Imaging Reference.
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3.2  Assigning Existing Bundles to Devices
When you create bundles, the object is created without assigning devices or users to it, or specifying 
distribution, launch, or availability schedules. Before the bundle can be used on assigned devices, 
you must complete the steps in this procedure.

You can use ZENworks Control Center or the zman command line utility to assign bundles. The 
following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer 
the zman command line utility, see the “Bundle Commands” in “ZENworks Command Line 
Utilities”.

1 In ZENworks Control Center, click the Bundles tab.

2 Select the desired bundle in the Bundles list by clicking the box next to its name, click Action, 
then click Assign to Device.

or

Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.

A bundle must be assigned to devices and users before it can be distributed to them.

You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle 
to a folder or group is the preferred method of assigning bundles. This allows for easier 
management of the bundle assignments and can decrease the possibility of high server 
utilization caused by assigning the bundle to a large number of items (for example, more than 
250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign 
the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you have 
created in the Devices folder.

Browse for and select the devices or users, groups, and folders to which you want to assign the 
bundle. To do so:

3a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Item name box to search for the 
item.
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3b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

3c Click OK to add the selected devices, folders, and groups to the Devices list.

4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device 
where ZENworks Adaptive Agent displays the bundle’s icon. The possible locations include 
the following:

Application Window: Places the icon in the Application window. This location is selected by 
default.

Quick Launch:  Places the icon on the Quick Launch area of the Windows taskbar.

Desktop: Places the icon on the device’s desktop.

System Tray: Places the icon in the system tray (notification area) of the Windows taskbar.

Start Menu: Places the icon on the Start menu on all Windows devices except for Windows 
Vista. On Windows Vista, it places the icon in Start > All Programs. 

On a Windows Vista device, if you want to change the look and feel of the Start menu or pin 
applications to the Start menu, see Appendix G, “Best Practices,” on page 187.

5 Click Next to display the Schedules page, then select the schedules you want to define:

Distribution Schedule: Defines the dates and times when the content of the bundle is 
distributed from the ZENworks Server to the managed device or user. If you do not establish a 
schedule, the bundle’s content is distributed to the device or user when it is first launched. 
However, the schedule does not define the date and time when the action in the bundle runs.

Launch Schedule: Defines the dates and times when the ZENworks Adaptive Agent 
automatically launches the bundle. If you do not establish a schedule, the bundle is launched 
only when the user launches it. Before launching the bundle, the ZENworks Adaptive Agent 
checks if the bundle is distributed and installed. If the bundle is not yet distributed, the agent 
first distributes the bundle, performs the bundle’s install actions to install the bundle, then 
performs the bundle’s launch actions to launch it.

Availability Schedule: Defines the dates and times when the bundle is available to the device 
or user. The ZENworks Adaptive Agent displays the bundle icon only during the times defined 
by the schedule. If you do not establish a schedule, the bundle is available at all times.

NOTE: If a bundle with an assignment schedule fails to execute on a device, an attempt to 
execute the bundle on the device is made five times, by default. 

To change the default value:

1.Open the Registry Editor.

2.Go to HKLM\Software\Novell\ZCM\.

3.Create a STRING called ScheduleRetries, and set its value as desired.

For example, if you do not want the failed bundle to be executed again on the device, set the 
value of the ScheduleRetries to 0.

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle 
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the 
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle 
to be distributed to the device when it is first launched.
Managing Bundles 47



48 ZENw
7 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

8 Select the following options as desired:

Wake on LAN:  If the device is not on at the scheduled time, ZENworks attempts to use Wake 
on LAN (WoL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after 
the bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled.

9 (Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle 
Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent 
automatically launches the bundle. The default schedule (no schedule) results in the bundle 
only being launched if the user launches it.

10 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

11 (Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle 
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the 
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times 
defined by the schedule. The default schedule (no schedule) makes the bundle available at all 
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

12 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

13 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

14 Click Finish.
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3.3  Assigning Existing Bundles to Users
When you create bundles, the object is created without assigning devices or users to it, or specifying 
distribution, launch, or availability schedules. Before the bundle can be used on assigned devices, 
you must complete the steps in this procedure.

You can use ZENworks Control Center or the zman command line utility to assign bundles. The 
following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer 
the zman command line utility, see the “Bundle Commands” in “ZENworks Command Line 
Utilities”.

1 In ZENworks Control Center, click the Bundles tab.

2 Select the desired bundle in the Bundles list by clicking the box next to its name, click Action, 
then click Assign to User.

or

Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.

A bundle must be assigned to devices and users before it can be distributed to them.

You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle 
to a folder or group is the preferred method of assigning bundles. This allows for easier 
management of the bundle assignments and can decrease the possibility of high server 
utilization caused by assigning the bundle to a large number of items (for example, more than 
250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign 
the bundle.

The Select Objects dialog box opens with the Users folder as the root folder. By default, the 
user sources that have been defined are displayed, as well as the ZENworks User Groups 
folder.

Browse for and select the users, groups, and folders to which you want to assign the bundle. To 
do so:

3a Click  next to a folder to navigate through the folders until you find the user, group, or 
folder you want to select. 

If you are looking for a specific item, such as a User or a User Group, you can use the 
Items of type list to limit the types of items that are displayed. If you know the name of the 
item you are looking for, you can also use the Item name box to search for the item.
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3b Click the underlined link in the Name column to select the user, group, or folder and 
display its name in the Selected list box.

3c Click OK to add the selected users, folders, and groups to the Devices list.

4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device 
where ZENworks Adaptive Agent displays the bundle’s icon. The possible locations include 
the following:

Application Window: Places the icon in the Application window. This location is selected by 
default.

Quick Launch: Places the icon on the Quick Launch toolbar area of the Windows taskbar.

Desktop: Places the icon on the device’s desktop.

System Tray: Places the icon in the system tray (notification area) of the Windows taskbar.

Start Menu: Places the icon on the Start menu on all Windows devices except for Windows 
Vista. On Windows Vista, it places the icon in Start > All Programs. 

On Windows Vista device, if you want to change the look and feel of the Start menu or pin 
applications to the Start menu, see Appendix G, “Best Practices,” on page 187.

5 Click Next to display the Schedules page, then select the schedules you want to define:

Distribution Schedule: Defines the dates and times when the content of the bundle is 
distributed from the ZENworks Server to the managed device or user. If you do not establish a 
schedule, the bundle’s content is distributed to the device or user when it is first launched. 
However, the schedule does not define the date and time when the action in the bundle runs.

Launch Schedule: Defines the dates and times when the ZENworks Adaptive Agent 
automatically launches the bundle. If you do not establish a schedule, the bundle is launched 
only when the user launches it. Before launching the bundle, the ZENworks Adaptive Agent 
checks if the bundle is distributed and installed. If the bundle is not yet distributed, the agent 
first distributes the bundle, performs the bundle’s install actions to install the bundle, then 
performs the bundle’s launch actions to launch it.

Availability Schedule: Defines the dates and times when the bundle is available to the device 
or user. The ZENworks Adaptive Agent displays the bundle icon only during the times defined 
by the schedule. If you do not establish a schedule, the bundle is available at all times.

NOTE: If a bundle with an assignment schedule fails to execute on a device, an attempt to 
execute the bundle on the device is made five times, by default. 

To change the default value:

1.Open the Registry Editor.

2.Go to HKLM\Software\Novell\ZCM\.

3.Create a STRING called ScheduleRetries, and set its value as desired.

For example, if you do not want the failed bundle to be executed again on the device, set the 
value of ScheduleRetries to 0.

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle 
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the 
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle 
to be distributed to the device when it is first launched.
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7 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

8 Select the following options as desired:

Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake 
on LAN (WoL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after 
the bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled.

9 (Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle 
Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent 
automatically launches the bundle. The default schedule (no schedule) results in the bundle 
only being launched if the user launches it.

10 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

11 (Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle 
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the 
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times 
defined by the schedule. The default schedule (no schedule) makes the bundle available at all 
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

12 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

13 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

14 Click Finish.

If you assign bundles to Active Directory users, the assignments are available to the users only if the 
ZENworks server is able to resolve the DNS name of the Active Directory.
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3.4  Adding a Bundle to a Group
You can add the bundle to any bundle groups that already exist or you can create a new bundle group 
as part of the assignment process. The bundle inherits the group’s assignments and schedules, which 
means that you save time by managing one bundle group rather than each individual bundle. Adding 
a bundle to a group is not the same as assigning a bundle to a group (user or device). For more 
information on assigning bundles to devices, see Assigning Existing Bundles to Devices and 
assigning bundles to users, see Assigning Existing Bundles to Users.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Add to Group.

4 Select Add selected items to an existing group if the group to which you want to add the objects 
already exists.

or

Select Create a new group to contain the selected items if you need to create a new group for 
the selected objects.

5 (Conditional) If you chose Add selected items to an existing group in Step 4, click Next to 
display the Targets page.

The Targets page lets you select the groups to which you want to add the objects (users, 
devices, bundles, policies). 

5a Click Add to display the Select Groups dialog box.

5b Browse for and select the groups to which you want to add the objects. To do so:

5b1 Click  next to a folder to navigate the folders until you find the group you want to 
select. 

If you know the name of the group you are looking for, you can also use the Item 
name box to search for the group.

5b2 Click the underlined link in the Name column to select the group and display its name 
in the Selected list.

5b3 Repeat Step 5b1 and Step 5b2 to add additional groups to the Selected list.

5b4 When you are finished selecting groups, click OK.

6 (Conditional) If you chose Create a new group to contain the selected items in Step 4, click 
Next to display the Basic Information page, then fill in the fields:
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Name: Provide a name for the group. The group name must be different than the name of any 
other object (group, folder, device, user, bundle, policy, and so forth) that resides in the same 
folder and must conform to the ZENworks object naming conventions. 

For more information on naming conventions, see “Naming Conventions in ZENworks Control 
Center” in ZENworks 10 Configuration Management System Administration Reference.

Folder: By default, the group is created in the current folder. If you want to create the group in 
another folder, browse to and select the folder. 

Description: Provide a short description of the group’s purpose or contents.

7 Click Next to display the Summary page, review the information and, if necessary, use the Back 
button to make changes to the information.

8 Click Finish to add the selected objects to the group.

3.5  Renaming, Copying, or Moving Bundles
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the 
option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the bundle's name, click Edit, then click an option:

Rename: Click Rename, provide a new name for the bundle, then click OK.

IMPORTANT: Do not rename Windows MSP bundles.

Copy: Click Copy, provide a new name for the copy, then click OK.

The copy option is useful to create a new bundle that is similar to an existing bundle. You can 
copy a bundle and then edit the new bundle's settings.
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Move: Click Move, select a destination folder for the selected objects, then click OK.

If you rename or move a bundle, its assignments are still in place and ZENworks Configuration 
Management does not redistribute the bundle to devices or users because of the name or 
location change.

3.6  Adding System Requirements for a Bundle
The System Requirements panel lets you define specific requirements that a device must meet for 
the bundle to be distributed to it.

You define requirements through the use of filters. A filter is a condition that must be met by a 
device in order for the bundle to be applied. For example, you can add a filter to specify that the 
device must have exactly 512 MB of RAM in order for the bundle to be applied, and you can add 
another filter to specify that the hard drive be at least 20 GB in size.

To specify system requirements for a bundle:

1 In ZENworks Control Center, click the Bundles tab.

2 Click the underlined link for the desired bundle to display the bundle’s Summary page.

3 Click the Requirements tab.

4 Click Add Filter, select a filter condition from the drop-down list, then fill in the fields.

As you construct filters, you need to know the conditions you can use and how to organize the 
filters to achieve the desired results. For more information, see Section 3.6.1, “Filter 
Conditions,” on page 54 and Section 3.6.2, “Filter Logic,” on page 58.

5 (Conditional) Add additional filters and filter sets.

6 Click Apply to save the settings.

NOTE: After defining a bundle’s system requirements, you can copy its requirements and apply it 
to other bundles or policies. To do so, click the Bundles tab, select the check box in front of the 
bundle, click Edit, click Copy System Requirements, select Bundles or Policies, then click Add to 
select the bundles or policies to which you want to copy the selected bundle’s system requirements.

3.6.1  Filter Conditions

You can choose from any of the following conditions when creating a filter. Place your mouse 
pointer over fields that require input to display a tooltip containing example usage.

Architecture:  Determines the architecture of Windows running on the device. The condition you 
use to set the requirement includes a property, an operator, and a property value. The possible 
operators are equals (=) and does not equal (<>). For example, if you set the condition to 
architecture = 32, the device’s Windows operating system must be 32-bit to meet the 
requirement. 

Bundle Installed: Determines if a specific bundle is installed. After specifying the bundle, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle 
must already be installed to meet the requirement. If you select No, the bundle must not be installed.

If you click  to browse to specify a bundle, you are not allowed to select any of the existing 
directive bundles because directive bundles cannot be installed on the managed device.
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Connected: Determines if the device is connected to the network. The two conditions you can use 
to set the requirement are Yes and No. If you select Yes, the device must be connected to the network 
to meet the requirement. If you select No, it must not be connected. 

Connection Speed: Determines the speed of the device’s connection to the network. The condition 
you use to set the requirement includes an operator and a value. The possible operators are equals 
(=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is 
less than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps), 
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition 
to >= 100 Mbps, the connection speed must be greater than or equal to 100 megabits per second to 
meet the requirement.

Disk Space Free: Determines the amount of free disk space on the device. The condition you use to 
set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). 
For example, if you set the condition to c: >= 80 MB, the free disk space must be greater than or 
equal to 80 megabytes to meet the requirement.

Disk Space Total: Determines the amount of total disk space on the device. The condition you use 
to set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). 
For example, if you set the condition to c: >= 40 GB, the total disk space must be greater than or 
equal to 40 gigabytes to meet the requirement.

Disk Space Used: Determines the amount of used disk space on the device. The condition you use 
to set the requirement includes a disk designation, an operator, and a value. The disk designation can 
be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal 
(<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to 
(<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). 
For example, if you set the condition to c: <= 10 GB, the used disk space must be less than or equal 
to 10 gigabytes to meet the requirement.

Environment Variable Exists: Determines if a specific environment variable exists on the device. 
After specifying the environment variable, the two conditions you can use to set the requirement are 
Yes and No. If you select Yes, the environment variable must exist on the device to meet the 
requirement. If you select No, it must not exist.

Environment Variable Value: Determines if an environment variable value exists on the device. 
The condition you use to set the requirement includes the environment variable, an operator, and a 
variable value. The environment variable can be any operating system supported environment 
variable. The possible operators are equal to, not equal to, contains, and does not contain. The 
possible variable values are determined by the environment variable. For example, if you set the 
condition to Path contains c:\windows\system32, the Path environment variable must contain 
the c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the 
filename, an operator, and a date. The filename can be any filename supported by the operating 
system. The possible operators are on, after, on or after, before, and on or before. The possible dates 
are any valid dates. For example, if you set the condition to app1.msi on or after 6/15/07, the 
app1.msi file must be dated 6/15/2007 or later to meet the requirement.
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File Exists: Determines if a file exists. After specifying the filename, the two conditions you can 
use to set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the 
requirement. If you select No, the file must not exist. 

File Size:  Determines the size of a file. The condition you use to set the requirement includes the 
filename, an operator, and a size. The filename can be any file name supported by the operating 
system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater 
than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are 
designated in bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if 
you set the condition to doc1.pdf <= 3 MB, the doc1.pdf file must be less than or equal to 3 
megabytes to meet the requirement.

File Version:  Determines the version of a file. The condition you use to set the requirement 
includes the filename, an operator, and a version. The filename can be any file name supported by 
the operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), 
is greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. 
For example, the file version for calc.exe might be 5.1.2600.0. Each component is treated 
independently. For this reason, the system requirements that you set might not provide your 
expected results. If you do not specify all four components, wildcards are assumed.

For example, if you set the condition to calc.exe <= 5, you are specifying only the first 
component of the version number (Major). As a result,  versions 5.0.5, 5.1, and 5.1.1.1 also meet the 
condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, 
the calc.exe file must be less than or equal to version 5.1 to meet the requirement.

IP Segment: Determines the device’s IP address. After specifying the IP segment name using CIDR 
(Classless Inter-Domain Routing) format, the two conditions you can use to set the requirement are 
Yes and No. If you select Yes, the device’s IP address must match the IP segment. If you select No, 
the IP address must not match the IP segment.

You must specify the IP address using CIDR format. With CIDR, the dotted decimal portion of the 
IP address is interpreted as a 32-bit binary number that has been broken into four 8-bit bytes. The 
number following the slash (/n) is the prefix length, which is the number of shared initial bits, 
counting from the left side of the address. The /n number can range from 0 to 32, with 8, 16, 24, and 
32 being commonly used numbers. Examples:

123.45.67.12/16: Matches all IP addresses that start with 123.45.

123.45.67.12/24: Matches all IP addresses that start with 123.45.67.

Logged on to Primary Workstation: Determines whether the user is logged on to his or her 
primary workstation. The two conditions you can use to set the requirement are Yes and No. If you 
select Yes, the user must be logged on to his or her primary workstation to meet the requirement. If 
you select No, if no user is logged on to the workstation, the requirement is not met. However, if a 
user other than the primary user is logged on to the workstation, the requirement is met.

Memory: Determines the amount of memory on the device. The condition you use to set the 
requirement includes an operator and a memory amount. The possible operators are equals (=), does 
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than 
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or equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). For 
example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of memory to 
meet the requirement.

Novell Client Installed: Determines if the device is using the Novell Client for its network 
connection. The two conditions you can use to set the requirement are Yes and No. If you select Yes, 
the device must be using the Novell Client to meet the requirement. If you select No, it must not be 
using the Novell Client.

Operating System - Windows: Determines the service pack level, server type, and version of 
Windows running on the device. The condition you use to set the requirement includes a property, an 
operator, and a property value. The possible properties are service pack, server type, and version. 
The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or 
equal to (>=), is less than (<), and is less than or equal to (<=). The property values vary depending 
on the property. For example, if you set the condition to version = Windows XP Versions, the 
device’s Windows version must be XP to meet the requirement. 

NOTE: Be aware that operating system version numbers contain four components: Major, Minor, 
Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 
5.0.2159.262144. Each component is treated independently. For this reason, the system 
requirements that you set might not provide your expected results. 

For example, if you specify Operating System - Windows in the first field, Version in the second 
field, > in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only 
the first two components of the version number: Major (Windows) and Minor (5.0). As a result, for 
the requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 
is version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000 
SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 
5.0.0 to make the requirement evaluate as true because the actual revision component is greater than 
0.

When you select the OS version from the drop-down, the Major and Minor components are 
populated. The Revision and Build components must be typed in manually.

Primary User Is Logged In: Determines if the device’s primary user is logged in. The two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the primary user must 
be logged in to meet the requirement. If you select No, the user must not be logged in.

Processor Family: Determines the device’s processor type. The condition you use to set the 
requirement includes an operator and a processor family. The possible operators are equals (=) and 
does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, 
Pentium III, Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For 
example, if you set the condition to <> Celeron, the device’s processor can be any processor family 
other than Celeron to meet the requirement. 

Processor Speed: Determines the device’s processor speed. The condition you use to set the 
requirement includes an operator and a processor speed. The possible operators are equals (=), does 
not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than 
or equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), 
and gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be 
at least 2 gigahertz meet the requirement.
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Registry Key Exists: Determines if a registry key exists. After specifying the key name, the two 
conditions you can use to set the requirement are Yes and No. If you select Yes, the specified key 
must exist to meet the requirement. If you select No, the key must not exist. For example, if you 
specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login and set the requirement to 
Yes, the specified registry key must exist to meet the requirement. 

Registry Key Value: Determines if a registry key value meets a defined condition. The condition 
you use to set the requirement includes the key name, the value name, an operator, a value type, and 
value data. The key and value names must identify the key value you want to check. The possible 
operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is 
less than (<), and is less than or equal to (<=). The possible value types are Integer Type(specify a 
decimal value) and Sting Type. The possible value data is determined by the key, value name, and 
value type. 

If the value type is String Type, ZCM compares only those values in the registry if the actual type in 
the registry is REG_STRING or REG_EXPANDED_STRING. 

If the value type is Integer, ZCM compares only those values in the registry if the actual type in the 
registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no 
name and is displayed in regedit as (Default).

For example, if you specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login as the 
key name, Port as the value name, select = as the operator, select Integer Type as the value type, 
and specify 443 as the value data, the port specified as the value data must match with the port 
specified in the registry key to meet the requirement. 

Registry Key and Value Exists: Determines if a registry key and value exist. After specifying the 
key name and value, the two conditions you can use to set the requirement are Yes and No. If you 
select Yes, the specified key and value must exist to meet the requirement. If you select No, the key 
and value must not exist. 

For example, if you specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login as the 
key name, Port as the value name, and set the requirement to Yes, then the 
HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login key having Port as its value, 
must exist to meet the requirement. 

Service Exists: Determines if a service exists. After specifying the service name, the two conditions 
you can use to set the requirement are Yes and No. If you select Yes, the service must exist to meet 
the requirement. If you select No, the service must not exist. 

Specified Devices: Determines if the device is one of the specified devices. After specifying the 
devices, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the 
device must be included in the specified devices list to meet the requirement (an inclusion list). If 
you select No, the device must not be included in the list (an exclusion list).

3.6.2  Filter Logic

You can use one or more filters to determine whether the bundle should be distributed to a device. A 
device must match the entire filter list (as determined by the logical operators that are explained 
below) for the bundle to be applied to the device.
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There is no technical limit to the number of filters you can use, but there are practical limits, such as:

 Designing a filter structure that is easy to understand 

 Organizing the filters so that you do not create conflicting filters 

Filters, Filter Sets, and Logical Operators

You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine 
each filter and filter set. By default, filters are combined using OR (as determined by the Combine 
Filters Using field) and filter sets are combined using AND. You can change the default and use 
AND to combined filters, in which case filter sets are automatically combined using OR. In other 
words, the logical operator that is to combine individual filters (within in a set) must be the opposite 
of the operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set 
options a few times each to create a few filter sets, then switch between AND and OR in the 
Combine Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals, 
where filters are contained within parentheses, and sets are separated into a series of parenthetical 
groups. Logical operators (AND and OR) separate the filters within the parentheses, and the 
operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the 
filter list, this looks like:

u AND
v AND
w
OR
x AND
y AND
z

Nested Filters and Filter Sets

Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter 
set to match the device is used. Therefore, the order in which they are listed does not matter. You are 
simply looking for a match to cause the bundle to be applied to the device.

3.7  Copying a Bundle’s System Requirements
1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle.

3 Click Edit > Copy System Requirements.
Managing Bundles 59



60 ZENw
If more than one check box is selected, the Copy System Requirements option is not available 
on the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to 
copy the selected bundle’s system requirements.

3.8  Managing Bundle Settings
The Settings page lets you manage bundle settings, including the variables that are available for use 
on bundles and content replication settings for ZENworks Primary Servers and Satellite devices.

Settings can be inherited from the following locations:

 (System): The bundle is inheriting the setting established for the Management Zone 
(Configuration tab > Management Zone Settings).

 Folder: The bundle is inheriting the setting established for one of its parent folders.

 Device: The bundle is not inheriting the setting, but the setting is configured directly on the 
bundle.

 ---: The bundle is not inheriting the setting and the setting is not configured directly on the 
bundle. In other words, the setting is not configured at the system level, the folder level, or the 
bundle level.

To configure a setting for the bundle:

1 Click Bundle Management.

2 Click the setting name. 

3 If the setting is configured at the system or folder level, click Override settings to enable you to 
configure the setting at the bundle level.

4 Fill in the fields.

To get information about the fields, click the Help button or select the appropriate topic from 
the following list:

 System Variables: Lets you manage the variables that are available for use on devices, 
including those inherited from the Management Zone and new variables that you define.

For more information on content replication, see Section 3.9, “Managing Bundle 
Variables,” on page 61.
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 Primary Server Replication: Lets you manage content replication to Primary Servers. 
You can specify whether or not new Primary Servers added to the system are assigned to 
host the bundle. You can also specify that the bundle is included or excluded from being 
hosted on a specified Primary Server. 

For more information on content replication, see “Content Replication” in ZENworks 10 
Configuration Management System Administration Reference

 Satellite Server Replication: Lets you manage content replication to Satellite devices. 
You can specify whether or not new Satellites added to the system are assigned to host the 
bundle. You can also specify that the bundle is included or excluded from being hosted on 
a specified Satellite.

For more information on content replication, see “Content Replication” in ZENworks 10 
Configuration Management System Administration Reference 

3.9  Managing Bundle Variables
The Bundles Settings page lets you manage the variables that are available for use on bundles.

The Inherited Variables panel displays all system variables that are inherited from the ZENworks 
Management Zone or parent folders. You cannot delete or modify inherited variables. However, if 
you add the same system variable, but give it a different value, the new variable value overrides the 
inherited variable value.

When specifying the variable in a field, use the following syntax:

${VAR_NAME}

Replace VAR_NAME with the name of the variable.

The System Variables panel lets you define variables that can be used to replace paths, names, and 
so forth as you enter information.

You can define system variables at three levels:

 Management Zone: The system variables are inherited by the following: device folders, 
devices, and bundles.

 Device Folder: The system variables are inherited by all devices contained within the folder or 
its subfolders.

 Device or Bundle: The system variables apply only to the device or bundle for which they are 
configured.

The following table lists the tasks you can perform to manage the system variables:
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3.10  Deleting a Bundle
Deleting a bundle removes the bundle content from the ZENworks content servers but does not 
uninstall it from devices where it has already been installed. To uninstall it from devices, you should 
use the Uninstall options before deleting the bundle.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Delete.

Task Steps Additional Details

Add a variable 1. If you are configuring system 
variables for an object (not for the 
entire Management Zone), click 
Override settings to activate the 
System Variables panel. 

2. Click Add, provide the name and 
value for the variable, then click 
OK.

3. Click Apply.

When configuring system variables for 
an object, you can override an inherited 
variable by defining a new variable with 
the same name but a different value. 
For example, if Var1=c:\ is inherited, 
you can override it by defining 
Var1=d:\.

Variable names cannot include spaces 
and must be unique at the level where 
they are defined. For example, you 
cannot have two variables named Var1 
defined at the device level (unless one 
is inherited, in which case the device 
level variable overrides the inherited 
variable).

Variable values cannot include the 
characters & and <.

Remove a variable 1. Select the check box next to the 
variable (or variables).

2. Click Remove.

3. Click Apply.

Edit a variable 1. Select the check box next to the 
variable.

2. Click Edit.

3. Modify the Name and Value fields 
as desired, then click OK.

4. Click Apply.

Variable names cannot include spaces 
and must be unique at the level where 
they are defined. For example, you 
cannot have two variables named Var1 
defined at the device level (unless one 
is inherited, in which case the device 
level variable overrides the inherited 
variable).

Variable values cannot include the 
characters & and <.

Use a variable 1. Use the following syntax:

${VAR_NAME}

Replace VAR_NAME with the name 
of the variable.
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3.11  Editing Bundle Schedules
After you have assigned a bundle to a device or user, you can choose to edit the bundle schedule:

1 In ZENworks Control Center, click the Bundles tab.

2 Click the desired bundle for which you want to edit the schedule. 

3 Click the Relationships tab.

4 Click the Assignment Details link of the assignment for which you want to edit the schedule.

5 In the View Assignment Details dialog box, click the link next to the schedule type you want to 
edit.

6 In the dialog box that displays, edit the schedule as desired. For more information on how to 
edit the schedule, click Help.

3.12  Incrementing a Bundle’s Version Number
Incrementing a bundle’s version number causes the bundle changes to be applied on the managed 
devices.

If this bundle is included in the action set of another bundle (primary bundle), you must also 
increment the version of the primary bundle to reinstall the primary bundle. 

For example, assume that you have two bundles, A and B, and that the Install set of bundle A 
includes the Install Bundle B, Launch Bundle B, Uninstall Bundle B, or Verify Bundle B action. If 
you increment the version of Bundle B, you must also increment the version of the bundle A to 
reinstall it.

NOTE: If you change the dependencies of a bundle that has already been replicated to content 
servers, you must redeploy the bundle to ensure that each content server has all of the dependencies 
required by the bundle. This process is different than incrementing a bundle’s version number. 

For more information on Dependency Bundles, see “Dependency Bundles” on page 13. 

For more information on Redeploying a Bundle to Refresh Its Dependencies, see “Redeploying a 
Bundle to Refresh Its Dependencies:” on page 16.

3.12.1  Using the Action menu

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Increment Version.
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4 In the Confirm Version Increment dialog box, click Yes.

3.12.2  Editing the Bundle

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary 
page.

3 Click Increment Version.

4 In the Confirm Version Increment dialog box, click Yes.

3.13  Installing a Bundle
The Install Bundle option in the Bundle Tasks list in the left navigation pane of ZENworks Control 
Center lets you immediately install a bundle to one or more devices.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 In the Bundle Tasks list in the left navigation pane, select Install Bundle.

4 In the Devices section, click Add to select the devices where you want to install the bundle.

5 In the Select Objects dialog box, browse to and select the objects on which you want to install 
the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you have 
created in the Devices folder.
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Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

5a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, user, group, or folder you want to 
select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Item name box to search for the 
item.

5b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.

6 Click OK.

If the bundle has not already been assigned to a device, then the bundle’s icon is placed in the 
application window of the device. 

3.14  Launching a Bundle
The Launch Bundle option lets you immediately launch a bundle to one or more devices. If the 
bundle is not already installed, it is installed and then launched.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Quick Tasks > Launch Bundle.

4 In the Devices section, click Add to select the devices where you want to launch the bundle.

5 In the Select Objects dialog box, browse to and select the objects on which you want to launch 
the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you have 
created in the Devices folder.
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Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

5a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, user, group, or folder you want to 
select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Item name box to search for the 
item.

5b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.

6 Click OK.

If the bundle has not earlier been assigned to a device, then the bundle’s icon is placed in the 
application window of the device. 

3.15  Copying a Bundle to a Content Server
By default, a bundle is copied to each content server. If you specify certain content servers as hosts, 
the bundle is hosted on only those content servers; it is not copied to all content servers. You can 
also specify whether the selected bundle is replicated to new content servers (ZENworks Servers 
and satellite servers) that are added to the Management Zone.

To specify a content server:

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Specify Content Server to display the New Content Replication Rules page.
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4 Specify the default replication behavior for new servers added to the system:

 New Primary Servers Will: Specify the default replication behavior for new ZENworks 
Primary Servers added to the system:

 Include This Content: Replicates the content to any servers created in the future.

 Exclude This Content: Excludes the content from being replicated to any servers 
created in the future.

 New Satellite Servers Will: Specify the default replication behavior for new ZENworks 
satellite servers added to the system:

 Include This Content: Replicates the content to any servers created in the future.

 Exclude This Content: Excludes the content from being replicated to any servers 
created in the future.

Be aware that any content replication relationships previously set between the content and 
servers are lost upon completion of this wizard.

5 Click Next to display the Include or Exclude Primary Servers/Satellite Servers page:

This page lets you specify on which content servers (ZENworks Servers and satellite servers) 
the content is hosted.

The relationships between content and content servers that you create using this wizard 
override any existing relationships. For example, if Bundle A is currently hosted on Server 1 
and Server 2 and you use this wizard to host it on Server 1 only, Bundle A is excluded from 
Server 2 and is removed during the next scheduled replication.

5a In the Excluded Primary Servers or Excluded Satellite Servers list, select the desired 
content server.

You can use Shift+click and Ctrl+click to select multiple content servers. 
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You cannot include content on a satellite server without including it on the satellite 
server’s parent ZENworks Server. You must select both the satellite server and its parent.

5b Click the  button to move the selected content server to the Included Primary 
Servers or Included Satellite Servers list. 

6 Click Next to display the Finish page, then review the information and, if necessary, use the 
Back button to make changes to the information.

7 Click Finish to create the relationships between the content and the content servers. Depending 
on the relationships created, the content is replicated to or removed from content servers during 
the next scheduled replication.

3.16  Preventing a Bundle from Being Deployed
A disabled bundle is not deployed to new managed devices or replicated to content servers. It 
remains on the device and content server to which it has already been deployed until the next device 
refresh.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Disable.

3.17  Enabling a Bundle to Be Deployed
1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Action > Enable.
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3.18  Enabling a Bundle to Be Uninstalled
When you create a bundle, the Undo Install action is enabled by default; however, the Uninstall 
Action Set is not enabled. Therefore, in order for any actions in the action set to run (including the 
Undo Install action), you must enable the action set.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its 
Summary page.

3 Click the Actions tab, then click the Uninstall tab.

4 Click Options to display the Uninstall Options dialog box.

5 Select the Enable Uninstall option. The following uninstall options are available only if Enable 
Uninstall option is selected:

User Options: 

Specify whether the user should be allowed to uninstall or cancel the uninstallation of an 
application from a device:

Allow User to perform uninstall: Select this option to enable users to remove the application 
from their devices. 

Display message to the user before uninstalling the application: Select this option to 
specify that a message warning the user that the application is going to be uninstalled from the 
device is displayed.

Allow user to cancel the uninstallation of the application: Select this option to specify 
whether the user can cancel the uninstallation of the application. You can enable this option 
only if the Display message to the user before uninstalling the application option is enabled.

Other Options: 

Specify additional options to enable the uninstallation of the application from the device:

Uninstall application if not used within _days: Select this option to automatically remove 
the application if the user has not run it within the specified number of days (the default is 30).
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Ignore Chained Dependencies: Select this option to enable the uninstallation of a dependent 
application that is referenced by two or more applications. For example, consider three 
applications (A, B, and C), where C is the dependent application. Assume application A installs 
application C, and application B uninstalls application C. Application C is uninstalled only if 
Ignore Chained Dependencies is selected.

Do not uninstall application on unassignment: Select this option to prevent the application 
from being uninstalled after it is unassigned from the device or user.

6 Click OK, then click Apply.

3.19  Uninstalling a Bundle
The Uninstall Bundle quick task lets you uninstall a bundle from one or more devices. Uninstalling 
a bundle does not, however, remove its assignments nor prevent the bundle from being reinstalled.

NOTE: To use the Uninstall Bundle quick task, you must enable the bundle’s uninstall options 
(which are disabled by default), increment the bundle’s version, and refresh the device. For more 
information, see Section 3.18, “Enabling a Bundle to Be Uninstalled,” on page 69 and Section 3.12, 
“Incrementing a Bundle’s Version Number,” on page 63.

To uninstall a bundle:

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle (or bundles).

3 Click Quick Tasks > Uninstall Bundle.

4 In the Bundles section, click  to browse to and select the desired bundle (if necessary). 

5 In the Devices section, click Add to select the devices where you want to uninstall the bundle.

6 In the Select Objects dialog box, browse to and select the objects on which you want to 
uninstall the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the 
Servers and Workstations folders are displayed along with any custom folders that you have 
created in the Devices folder.

Browse for and select the devices, groups, and folders to which you want to assign the bundle. 
To do so:

6a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, user, group, or folder you want to 
select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can also use the Item name box to search for the 
item.

6b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

6c Click OK to add the selected devices, folders, and groups to the Devices list.

7 Click OK, then click Apply.

If ZENworks Control Center shows that the uninstall fails, examine the device’s log file for more 
information.
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3.19.1  Bundle

Click  to browse to and select the desired bundle (if necessary). 

3.19.2  Devices

Select the devices from which you want to remove the bundle. You can browse to and select a device 
that the bundle is not currently assigned to because the bundle may have been assigned to and 
installed on that device previously.

1 In the Devices section, click Add.

Because you are removing the bundle from devices, the Add Assignments dialog box opens 
with the Devices folder as the root folder. By default, the Servers and Workstations folders 
are displayed along with any custom folders that you have created in the Devices folder. 

2 Browse for and select the devices, device groups, and device folders from which you want to 
remove the bundle. To do so:

2a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. Also, if you 
know the name of the item you are looking for, you can also use the Item name box to 
search for the item.

2b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

2c Click OK to add the selected devices, folders, and groups to the Devices list.

3.20  Understanding the Bundle Page
The Bundles page displays the following information: 

 Status: Gives a quick indication of message logging and enforcement status of the bundle. The 
status icons are:

 - No warning or error messages; bundle enforcement succeeded
 - Warning messages; bundle enforcement succeeded
 - Error messages; bundle enforcement failed

 Name: Displays the object’s (bundle, bundle group, or the bundle folder) name. Click the name 
to view or edit the object’s information. 

 Type: Displays the type of the object. For example, a Folder, Bundle Group, or Windows 
Bundle.

 Category: Displays the bundle category selected during the creation of the bundle.For 
example, Copy Directory.

 Enabled: Displays whether the bundle is enabled to be deployed on a device or not. The 
possible values are Yes and No.

 Version: Displays the version of the bundle.
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3.21  Modifying Action Set Options
When you create a bundle, all actions are enabled by default, meaning that after you add them to a 
action set, they run according to the action set’s options. However, not all action sets are enabled by 
default. The Install, Launch, and Terminate action sets are enabled, meaning that after you add an 
action, it runs on assigned devices according to its action set’s options. The Uninstall action set is 
not enabled by default. 

The following sections contain information about modifying action set options and enabling the 
Uninstall action set:

 Section 3.21.1, “Install Action Set Options,” on page 72

 Section 3.21.2, “Launch Action Set Options,” on page 73

 Section 3.21.3, “Uninstall Action Set Options,” on page 73

 Section 3.21.4, “Terminate Action Set Options,” on page 75

3.21.1  Install Action Set Options

The Install Options dialog box lets you specify the how often the bundle’s install actions are 
performed on managed devices and to specify if users can postpone the bundle’s installation.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary 
page.

3 Click the Actions tab, then click the Install tab.

4 Click Options to display the Install Options dialog box.

5 Specify how often you want the bundle’s install actions performed:

Install once per device: Performs the bundle’s install actions once on each managed device.

Install once per user per device: Performs the bundle’s install actions once for each user on 
each managed device.

Install always: Performs the bundle’s install action each time the bundle is run on the managed 
device.

6 Specify whether to allow users to postpone performing the bundle’s install actions and specify 
the number of postpones to allow.
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Always allow postpones: Allow the user to postpone the installation an unlimited number of 
times.

Never allow postpones: Do not allow the user to postpone the installation.

Limit postpones to: Specify the number of times that the user can postpone the installation.

7 Click OK, then click Apply.

3.21.2  Launch Action Set Options

The Launch Options dialog box lets you configure how often the bundle’s launch actions are 
performed on managed devices. By default, the launch actions are performed according to the 
bundle’s schedule or when the user launches the bundle using its shortcut (from the Application 
Window, desktop, and so forth).

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary 
page.

3 Click the Actions tab, then click the Launch tab.

4 Click Options to display the Launch Options dialog box.

5 Fill in the fields:

Run Once: Select this option to configure the bundle’s launch actions, then select one of the 
following options. If you do not select this option (the default), the launch actions are 
performed each time a user launches the application contained in the bundle.

 For each device: Launches the bundle’s actions once on each managed device.

 For the first user that logs in: Launches the bundle’s actions once on each managed 
device when the first user logs in to that device. If subsequent users log in to the device, 
the action set is not launched. If you select this option, the bundle’s icon is removed from 
the device’s Application Window, desktop, and so forth.

 For every user that logs in: Launches the bundle’s actions for every user that logs in to 
the device.

6 Click OK, then click Apply.

3.21.3  Uninstall Action Set Options

The Uninstall Options dialog box lets you enable the application to be uninstalled, allow the user to 
perform the uninstall, and specify that the application is uninstalled if it is not used with in a 
specified number of days.
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When you create a bundle, the Undo Install action is enabled by default; however, the Uninstall 
Action Set is not enabled. Therefore, in order for any actions in the action set to run (including the 
Undo Install action), you must enable the action set.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its 
Summary page.

3 Click the Actions tab, then click the Uninstall tab.

4 Click Options to display the Uninstall Options dialog box.

5 Select the Enable Uninstall option. The following uninstall options are available only if Enable 
Uninstall option is selected:

User Options: 

Specify whether the user should be allowed to uninstall or cancel the uninstallation of an 
application from a device:

Allow User to perform uninstall: Select this option to enable users to remove the application 
from their devices. 

Display message to the user before uninstalling the application: Select this option to 
specify that a message warning the user that the application is going to be uninstalled from the 
device is displayed.

Allow user to cancel the uninstallation of the application: Select this option to specify 
whether the user can cancel the uninstallation of the application. You can enable this option 
only if the Display message to the user before uninstalling the application option is enabled.

Other Options: 

Specify additional options to enable the uninstallation of the application from the device:

Uninstall application if not used within _days: Select this option to automatically remove 
the application if the user has not run it within the specified number of days (the default is 30).

Ignore Chained Dependencies: Select this option to enable the uninstallation of a dependent 
application that is referenced by two or more applications. For example, consider three 
applications (A, B, and C), where C is the dependent application. Assume application A installs 
application C, and application B uninstalls application C. Application C is uninstalled only if 
Ignore Chained Dependencies is selected.
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Do not uninstall application on unassignment: Select this option to prevent the application 
from being uninstalled after it is unassigned from the device or user.

6 Click OK, then click Apply.

3.21.4  Terminate Action Set Options

The Terminate Options dialog box lets you specify that the bundle’s actions can be terminated. This 
setting is used if a bundle has an availability schedule. For example, if a bundle can be installed only 
between 1 p.m. and 5 p.m. and the bundle is in the process of being installed at 5 p.m., the 
installation process terminates.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its 
Summary page.

3 Click the Actions tab, then click the Terminate tab.

4 Click Options to display the Terminate Options dialog box.

5 Select or deselect the Enable Terminate check box.

6 Click OK, then click Apply.

3.22  Show Bundle Activity on the Managed 
Device
You can display the bundle activity indicator window during the distribution, installation, 
verification, and uninstallation of a bundle on the managed device.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its 
Summary page.

3 In the General panel, click Yes for Show Bundle Activity.

4 Click Increment Version to increment the version of the bundle.

5  In the Confirm Version Increment dialog box, click Yes.

The activity indicator is used to notify the user on the managed device that some ZENworks 
activities such as downloading files or installing an MSI are being performed on the device. The 
user on the managed device cannot close this bundle activity indicator window. 

On Windows 2000 devices, the control that indicates the progress of the bundle execution on the 
managed device is not displayed in the bundle activity indicator window.

3.23  Viewing the Predefined Reports
You must have installed ZENworks Reporting Server to view the predefined reports. For more 
information on how to install ZENworks Reporting Server, see the ZENworks 10 Configuration 
Management Reporting Server Installation Guide.

To view the predefined reports for bundles:

1 In ZENworks Control Center, click the Reports tab.
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2 In the ZENworks Reporting Server Reporting panel, click ZENworks Reporting Server 
InfoView to launch the ZENworks Reporting Server InfoView.

3 Navigate to the Novell ZENworks Reports > Predefined Reports > Bundles and Policies folder.

4 The following predefined reports are included for bundles: 

 Assigned Bundles and Policies by Device: Displays information on all the bundles and 
policies that are assigned to a particular device.

 Bundle Deployment Status: Prompts for the device name, deployment status, and bundle 
name and displays the deployment details of the bundle.

 Bundle Information: Displays the bundle's details such as name, type, path, version, and 
the information of the device to which it is assigned.

 Content By Server:  Displays the content information for the selected server. The 
information includes the content name, content type, replication state, and the disk space.

 Content By Bundles and Policies: Displays the content information for the bundles. This 
information includes the content server, content type, replication state, and disk space. 

For more information on creating and managing reports, see the ZENworks 10 Configuration 
Management System Reporting Reference documentation.
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4
4Managing Bundle Groups

A bundle group lets you group bundles to ease administration and to provide easier assigning and 
scheduling of the bundles in the bundle group.

You can use ZENworks Control Center or the zman command line utility to create bundle groups. 
This section explains how to perform this task using the ZENworks Control Center. If you prefer the 
zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

The following sections contain more information:

 Section 4.1, “Creating Bundle Groups,” on page 77

 Section 4.2, “Renaming or Moving Bundle Groups,” on page 78

 Section 4.3, “Copying a Bundle Group’s System Requirements,” on page 79

 Section 4.4, “Deleting a Bundle Group,” on page 79

 Section 4.5, “Assigning a Bundle Group to Devices,” on page 79

 Section 4.6, “Assigning a Bundle Group to Users,” on page 81

 Section 4.7, “Adding a Bundle to a Group,” on page 84

 Section 4.8, “Copying a Bundle Group to a Content Server,” on page 84

4.1  Creating Bundle Groups
1 In ZENworks Control Center, click the Bundles tab.

2 Click New > Bundle Group.

3 Fill in the fields:

Group Name: Provide a name for the bundle group. The name must be different than the name 
of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name 
you provide displays in ZENworks Control Center.

For more information, see “Naming Conventions in ZENworks Control Center”.
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Folder: Type the name or browse to and select the ZENworks Control Center folder where you 
want the bundle to reside. The default is /bundles, but you can create additional folders to 
organize your bundles.

If you want to create the group in another folder, browse to and select the folder. By default, the 
group is created in the current folder.

Description: Provide a short description of the bundle group's contents. This description 
displays in ZENworks Control Center.

4 Click Next to display the Add Group Members page, then specify bundles to be members for 
the group.

You can add any number of bundles to the group. You cannot add other bundle groups to the 
group.

4a Click Add to display the Select Members dialog box.

Because you are adding bundles to the group, the Select Members dialog box opens with 
the Bundles folder displayed.

4b Browse for and select the bundles you want to add to the group. To do so:

4b1 Click  next to a folder to navigate the folders until you find the bundle you want to 
select. 

If you know the name of the bundle you are looking for, you can also use the Item 
name box to search for the bundle.

4b2 Click the underlined link in the Name column to select the bundle and display its 
name in the Selected list.

4b3 (Optional) Repeat Step 4a and Step 4b to add additional bundles to the Selected list.

4b4 Click OK to add the selected bundles to the group.

5 Click Next to display the Summary page, review the information and, if necessary, use the Back 
button to make changes to the information.

6 (Optional) Select the Define Additional Properties option to display the group’s properties page 
after the group is created. You can then configure additional bundle properties.

7 Click Finish to create the group.

Before the bundle group’s contents are distributed to devices or users, you must continue with 
Section 4.5, “Assigning a Bundle Group to Devices,” on page 79 or Section 4.6, “Assigning a 
Bundle Group to Users,” on page 81.

4.2  Renaming or Moving Bundle Groups
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the 
option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.
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2 In the Bundles list, select the box next to the bundle group’s name, click Edit, then click an 
option:

Rename: Click Rename, provide a new name for the folder, then click OK.

Move: Click Move, select a destination folder for the selected objects, then click OK.

4.3  Copying a Bundle Group’s System 
Requirements

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group.

3 Click Edit > Copy System Requirements.

If more than one check box is selected, the Copy System Requirements option is not available 
on the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to 
copy the selected bundle group’s system requirements.

4.4  Deleting a Bundle Group
Deleting a bundle group does not delete its bundles. It also does not uninstall the bundles from 
devices where they have already been installed. To uninstall the bundles from devices, you should 
use the Uninstall option for each bundle before deleting the bundle group.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Delete.

4.5  Assigning a Bundle Group to Devices
1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Action > Assign to Device.
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4 Browse for and select the devices, device groups, and device folders to which you want to 
assign the group. To do so:

4a Click  next to a folder (for example, the Workstations folder or Servers folder) to 
navigate through the folders until you find the device, group, or folder you want to select. 

If you are looking for a specific item, such as a Workstation or a Workstation Group, you 
can use the Items of type list to limit the types of items that are displayed. If you know the 
name of the item you are looking for, you can use the Item name box to search for the 
item.

4b Click the underlined link in the Name column to select the device, group, or folder and 
display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Devices list.

5 Specify the locations on the managed device where ZENworks Adaptive Agent displays the 
bundle group’s icons. The possible locations are:

Application Window: Places the icons in the Application window.

Desktop: Places the icons on the device’s desktop.

Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.

Start Menu: Places the icons on the Start menu.

System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define:

 Distribution Schedule: Defines the dates and times when the bundle is distributed from 
the ZENworks Server to the managed device or user. If you do not establish a schedule, 
the bundle is distributed to the device or user when it is first launched.

 Launch Schedule: Defines the dates and times when the ZENworks Adaptive Agent 
automatically launches the bundle. If you do not establish a schedule, the bundle is 
launched only when the user launches it.

 Availability Schedule: Defines the dates and times when the bundle is available to the 
device or user. The ZENworks Adaptive Agent displays the bundle icon only during the 
times defined by the schedule. If you do not establish a schedule, the bundle is available at 
all times.

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle 
Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the 
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle 
to be distributed to the device when it is first launched.

8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.3, “Now,” on page 113

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

9 Select the following options as desired:

Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake 
on LAN (WOL) technology to power on the device. The device must support Wake on LAN.
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Install Immediately After Distribution: Performs any installation actions immediately after 
the bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle 
Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent 
automatically launches the bundle. The default schedule (no schedule) results in the bundle 
only being launched if the user launches it.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

12 (Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle 
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the 
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times 
defined by the schedule. The default schedule (no schedule) makes the bundle available at all 
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or click the following links:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

14 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

15 Click Finish.

4.6  Assigning a Bundle Group to Users
1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Action > Assign to User.
Managing Bundle Groups 81



82 ZENw
4 Browse for and select the user, user groups, and user folders to which you want to assign the 
group. To do so:

4a Click  next to a folder to navigate through the folders until you find the user, group, or 
folder you want to select. 

If you are looking for a specific item, such as a User or a User Group, you can use the 
Items of type list to limit the types of items that are displayed. If you know the name of the 
item you are looking for, you can use the Item name box to search for the item.

4b Click the underlined link in the Name column to select the user, group, or folder and 
display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Users list.

5 Specify the locations on the managed device where ZENworks Adaptive Agent displays the 
bundle group’s icons. The possible locations are:

Application Window: Places the icons in the Application window.

Desktop: Places the icons on the device’s desktop.

Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.

Start Menu: Places the icons on the Start menu.

System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define:

 Distribution Schedule: Defines the dates and times when the bundle is distributed from 
the ZENworks Server to the managed device or user. If you do not establish a schedule, 
the bundle is distributed to the device or user when it is first launched.

 Launch Schedule: Defines the dates and times when the ZENworks Adaptive Agent 
automatically launches the bundle. If you do not establish a schedule, the bundle is 
launched only when the user does so.

 Availability Schedule: Defines the dates and times when the bundle is available to the 
device or user. The ZENworks Adaptive Agent displays the bundle icon only during the 
times defined by the schedule. If you do not establish a schedule, the bundle is available at 
all times.

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle 
Distribution Schedule page.
orks 10 Configuration Management Software Distribution Reference



The distribution schedule defines the dates and times when the bundle is distributed from the 
ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle 
to be distributed to the device when it is first launched.

8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.3, “Now,” on page 113

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

9 Select the following options as desired:

Wake on LAN: If the device is not on at the scheduled time, ZENworks attempts to use Wake 
on LAN (WoL) technology to power on the device. The device must support Wake on LAN.

Install Immediately After Distribution: Performs any installation actions immediately after 
the bundle is distributed to the device.

Launch Immediately After Installation: Performs any launch actions immediately after the 
bundle is installed. This option is available only if the Install Immediately After Distribution 
option is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle 
Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Adaptive Agent 
automatically launches the bundle. The default schedule (no schedule) results in the bundle 
only being launched if the user launches.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or see the following sections:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113

 Section D.2, “Event,” on page 112

12 (Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle 
Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the 
managed device. ZENworks Adaptive Agent displays the bundle icon only during the times 
defined by the schedule. The default schedule (no schedule) makes the bundle available at all 
times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user 
has not yet installed the bundle, it is only available for installation at the times specified by the 
schedule. If a user has already installed the bundle, it is only available for running during the 
scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For 
detailed information, click the Help button on the wizard page or click the following links:

 Section D.1, “Date Specific,” on page 111

 Section D.4, “Recurring,” on page 113
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14 Click Next to display the Finish page, review the information and, if necessary, use the Back 
button to make changes to the information.

15 Click Finish.

4.7  Adding a Bundle to a Group
For more information, see Section 3.4, “Adding a Bundle to a Group,” on page 52

4.8  Copying a Bundle Group to a Content Server
By default, a bundle is copied to each content server. If you specify certain content servers as hosts, 
the bundle is hosted on only those content servers; it is not copied to all content servers.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Action > Specify Content Server.

4 On the Content Servers/Distribution Points Where Content Will Be Specifically Included page, 
select the content servers.

This page lets you identify the content servers (ZENworks Servers and Distribution Points) that 
you want to host the previously selected content (bundles and policies). The content is hosted 
only on the content servers you select; it is excluded from all other content servers.

The relationships between content and content servers that you create using this wizard 
override any existing relationships. For example, if Bundle A is currently hosted on Server 1 
and Server 2 and you use this wizard to include it on Server 1 only, Bundle A is no longer 
available on Server 2.

4a In the Available list, select the desired ZENworks Servers and Distribution Points.

You can use Shift+click and Ctrl+click to select multiple bundles or policies. 

You cannot include content on a Distribution Point without including it on the Distribution 
Point’s parent ZENworks Server. You must select both the Distribution Point and its 
parent.

4b Click the  button to move the selected content servers to the Selected list. 

5 Click Next to display the Finish page, then review the information and, if necessary, use the 
Back button to make changes to the information.

6 Click Finish to create the relationships between the content and the content servers. Depending 
on the relationships created, the content is replicated to or removed from content servers during 
the next scheduled replication.
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5
5Managing Folders

A folder is an organizational object. You can use folders to structure your bundles and bundle groups 
into a manageable hierarchy for your ZENworks system. For example, you might want a folder for 
each type of bundle (Directive Bundles folder, Windows Bundles folder, File Bundles folder, and so 
forth), or, if applications are department-specific, you might want a folder for each department 
(Accounting Department folder, Payroll Department folder, and so forth).

The following sections contain additional information:

 Section 5.1, “Creating Folders,” on page 85

 Section 5.2, “Renaming or Moving Folders,” on page 85

 Section 5.3, “Deleting a Folder,” on page 86

5.1  Creating Folders
1 In ZENworks Control Center, click the Bundles tab.

2 Click New > Folder.

3 Provide a unique name for your folder. This is a required field.

When you name an object in ZENworks Control Center (folders, bundles, bundle groups, 
catalogs, and so forth), ensure that the name adheres to the naming conventions not all 
characters are supported. For more information on naming conventions, see “Naming 
Conventions in ZENworks Control Center” in ZENworks 10 Configuration Management 
System Administration Reference.

4 Type the name or browse to and select the folder that contains this folder in the ZENworks 
Control Center interface. This is a required field.

5 Provide a short description of the folder's contents.

6 Click OK.

5.2  Renaming or Moving Folders
Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-
down list, you must select an object by clicking the check box next to the object's name in the list.
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Depending on the type of object you select, you can rename, copy, or move the selected object. For 
example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a 
Folder object, you can rename or move the Folder object, but not copy it. If the option is dimmed, 
that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is 
selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the folder’s name, then click Edit.

3 Select an option:

 Rename: Click Rename, provide a new name for the folder, then click OK.

 Move: Click Move, choose a destination folder for the selected objects, then click OK.

5.3  Deleting a Folder
Deleting a folder also deletes all of its contents (bundles, bundle groups, subfolders).

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the folder (or folders).

3 Click Delete.
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6
6Managing Bundles by using the 
ZENworks Adaptive Agent

The ZENworks Adaptive Agent is part of the Novell ZENworks Configuration Management 
software that lets your administrator manage devices over the network. 

NOTE: This section contains information from the Adaptive Agent online Help system and is 
written from the perspective of the end-user.

The ZENworks Adaptive Agent, commonly referred to as the Adaptive Agent, provides services 
that help your administrator do the following without visiting devices:

 Deliver software, patches, and other files to your device

 Manage policies that determine the behavior of your device.

 Take inventory of your device’s hardware and software.

 Access your device from a remote location to troubleshoot and fix problems with hardware and 
software.

Software applications and other files are distributed to your device as bundles. A bundle contains all 
of the content (files, etc.) and instructions (registry modifications, shortcut information, etc.) 
required to install the software on the device.

The following information discusses how to manage bundles by using the ZENworks Adaptive 
Agent:

 Section 6.1, “Bundles vs. Applications,” on page 87

 Section 6.2, “User-Assigned vs. Device-Assigned Bundles,” on page 88

 Section 6.3, “Accessing Bundles,” on page 88

 Section 6.4, “Understanding Bundle Icons,” on page 92

 Section 6.5, “Launching a Bundle,” on page 93

 Section 6.6, “Postponing a Bundle Download,” on page 93

 Section 6.7, “Verifying a Bundle,” on page 94

 Section 6.8, “Viewing a Bundle’s Properties,” on page 94

 Section 6.9, “Uninstalling a Bundle,” on page 94

6.1  Bundles vs. Applications
Bundles are different than standard applications, such as Windows Notepad, that already reside on 
your device. When you double-click a bundle to launch it, the ZENworks Adaptive Agent might 
first complete a variety of distribution tasks before the application is launched, including installing 
the application files, running scripts, and changing the device’s registry, specific INI files, or 
environment variables. These tasks are all configured by your administrator to ensure that the 
application runs correctly on your device.
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In some instances, a bundle’s icon appears dimmed or grayed out. This indicates that your device 
does not meet the requirements that the administrator defined for the application, or the bundle is not 
scheduled to be available to you at that time. The Adaptive Agent does not distribute the application 
to your device until the requirements are met or the schedule is appropriate.

6.2  User-Assigned vs. Device-Assigned Bundles
The bundles that you see on your device might be assigned to you or they might be assigned to the 
device. Bundles assigned to you are referred to as user-assigned bundles, and bundles assigned to 
your device are referred to as device-assigned bundles.

The ZENworks Adaptive Agent displays your user-assigned bundles only when you are logged in to 
your user directory (Microsoft Active Directory or Novell eDirectory. If you are not logged in, you 
can log in through the ZENworks Configuration Management login screen. To do so, right-click the 

 icon in the notification area, then click Login. 

The Adaptive Agent always displays the device-assigned bundles regardless of whether or not you 
are logged in. Device-assigned bundles can be launched by anyone who uses your device.

6.3  Accessing Bundles
The ZENworks Adaptive Agent provides three ways for you to access the bundles that are assigned 
to you:

 Section 6.3.1, “ZENworks Window,” on page 88

 Section 6.3.2, “ZENworks Explorer,” on page 91

 Section 6.3.3, “ZENworks Icon,” on page 91

6.3.1  ZENworks Window

The ZENworks Window is a standalone window that you can launch from the Start menu or the 
command prompt.

 “Using the Start Menu” on page 88

 “Using the Command Prompt” on page 89

 “Using the ZENworks Window as the Windows Shell” on page 90

Using the Start Menu

1 Click Start > Programs > Novell ZENworks > ZENworks Application Window
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The ZENworks Window left pane displays the following:

 [All] folder: Contains all bundles that have been distributed to you, regardless of the folder in 
which they are located.

 ZENworks folder: Contains all bundles that have not been assigned to a different folder. The 
ZENworks folder is the default folder for bundles; however, your administrator can create 
additional folders to organize bundles, and can even rename the ZENworks folder.

When you select a folder in the left pane, the right pane displays the bundles that are contained 
within the folder. You can:

 Install a bundle or launch an application for an already installed bundle.

 View the properties of a bundle. The properties include a description of the bundle, information 
about people to contact for help with the bundle, the times when the bundle is available for use, 
and the system requirements established for the bundle.

 Repair an installed application.

 Uninstall an application. This is an administrator-controlled feature that might not be enabled.

Using the Command Prompt

1 Open the command prompt and execute the following command:

nalwin

The following command line switches can be used when starting the Application Window using 
nalwin. 

Table 6-1   Application Window Command Line Switches

Switch Description

:

EXAMPLE: nalwin :

Hides the initial splash screen.

/?

EXAMPLE: nalwin /?

Displays the help.

/c="window_title"

EXAMPLE: nalwin /
c="%Username%'s Apps" 

Uses the specified text as the title for the Application Window. The 
default window title is “ZENWorks Window for User,” where User is 
the distinguished name of the user.

The text specified can contain macros (variables) to display 
eDirectory information. The example, c="%Username%'s Apps"  
substitutes the user's common name in the title (for example, 
JSmith's Apps). 

NOTE: The quotation marks are required only if a space is used in 
the window title.

/max

EXAMPLE: nalwin /max

Displays the Application Window maximized when first loaded, 
overriding the window state (size and position) that was saved 
when exiting the previous Application Window session.
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 Using the ZENworks Window as the Windows Shell

If the ZENworks Window is used as a Windows shell, only the ZENworks Window is visible on the 
device. You do not have access to the device desktop so the Start menu, Quick Launch toolbar, and 
the ZENworks Icon are also not visible. Also, help is disabled on the device.

Using the ZENworks Window as a Windows shell is useful in scenarios where you want to restrict 
the user on the managed device to access only the applications displayed in the ZENworks Window. 
For example, if you want the user to access only applications such as Notepad and Calculator, ensure 
that the ZENworks Windows displays only these applications. To shut down the device, click File > 
Shutdown. 

To use the ZENworks Window as a shell on a Windows 2000/XP device:

1 On the Windows 2000/XP workstation, run regedit.exe and locate the following setting:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

2 Change the SHELL value from explorer.exe to:

c:\program files\novell\zenworks\bin\nalwin.exe

If you want the ZENworks Window to be maximized when it comes up, add the /max switch to 
nalwin.exe (for example, nalwin.exe /max).

3 Close regedit.exe.

4 Restart Windows.

/min

EXAMPLE: nalwin /min

Displays the Application Window minimized when first loaded, 
overriding the window state (size and position) that was saved 
when exiting the previous Application Window session.

/r

EXAMPLE: nalwin /r

Resets the Application Launcher launch flag to 0. This occurs 
automatically when Application Launcher terminates normally. 
However, if Application Launcher terminates abnormally (for 
example, a user uses Ctrl+Alt+Del to shut down nalwin.exe), the 
launch flag is not reset and Application Launcher cannot be 
restarted until the workstation is rebooted or this switch is used. 

/s

EXAMPLE: nalwin /s

Makes the Application Window act like the Windows shell. For 
example, on the File menu, the Exit Application Launcher option 
changes to Shutdown and gives the user the standard Windows 
shutdown options.

The Contents option on the Help menu is disabled. So, you cannot 
view the help.

This is not a true replacement for the Windows shell. If users 
minimize the Application Window, they have access to the normal 
desktop. 

/d

EXAMPLE: nalwin /d

Displays the Application Window with the Contents option on the 
Help menu disabled. So, you cannot view the help. 

Switch Description
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6.3.2  ZENworks Explorer

ZENworks Explorer is an extension to Windows Explorer that enables bundles to be displayed in 
Windows Explorer, on the desktop, on the Start menu, on the Quick Launch toolbar, and in the 
notification area.

Figure 6-1   Bundles Displayed in Windows Explorer

Figure 6-2   Bundles Displayed on the Desktop

You can perform the same tasks on the bundles in the ZENworks Explorer as you can in the 
ZENworks Window.

NOTE: Windows does not allow certain characters in folder paths ( \ / : * ? “< > | ). If you use any 
of these characters as part of the name of the ZENworks Explorer folder path, each character 
displays as an underscore ( _ ) in the Start menu. The characters display correctly in the ZENworks 
Window.

6.3.3  ZENworks Icon

The ZENworks Icon  is located in the Windows notification area. You can double-click the icon to 
display the ZENworks Adaptive Agent properties. Located in the left navigation pane, the Bundles 
link lets you view the bundles that are assigned to you and to your device. 
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Figure 6-3   ZENworks Adaptive Agent

The bundle list includes the following information:

 Name: Displays the name of the bundle. Click the name to display the properties for the 
bundle, including such information as the version, folder and icon locations, and help contacts.

 Status: Displays the installation status for the bundle.

 Effective: Displays whether or not the bundle can be used on the device. If the Effective box is 
selected, the bundle meets all system requirements and schedule constraints to be used. You can 
click the bundle icon  to launch the bundle. 

If the box is not selected, it cannot be used; to find out why, click the bundle name to display 
the system requirements and schedule properties.

6.4  Understanding Bundle Icons
A bundle icon changes to reflect the current status of the bundle. The following table shows the 
bundle icons with the default light blue background icon. Your administrator might choose to use a 
different background icon; however, the status icons such as  and , remain the same. 

Icon Status Description

Available The bundle is available on the device. You can launch the bundle. Installed 
bundles can be verified. To verify the bundle, right-click the icon and click 
Verify. For more information on verifying the bundle, see Verifying a Bundle.

Unavailable You cannot launch the bundle. Either the device does not meet the system 
requirements established for the bundle or the bundle is not scheduled to be 
available at the current time.

Downloading The bundle is downloading from the network location where it is stored.

Installing The bundle is installing to the device.

Running The bundle is currently running.
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6.5  Launching a Bundle
By default, the ZENworks Adaptive Agent does not distribute (download and install) a bundle to 
your device until the first time you launch it. The distribution process might include installing the 
bundle’s files, running scripts, and changing the device’s registry, specific INI files, or environment 
variables. Or, the process might include nothing more than providing a shortcut to the application's 
executable file on your local device or a network server.

To launch a bundle:

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks 
Window.

ZENworks Explorer: Open Windows Explorer and find the  ZENworks Adaptive Agent 
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon 
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area. 

ZENworks Icon: In the notification area, double-click the  icon, then click Bundles. 

2 Double-click the bundle icon.

NOTE: You must not launch multiple personality migration bundles at the same time. If you do so, 
the bundles are not launched correctly, and the logs of only the bundle that was launched first is 
stored in the personalitylog.xml file. Also, the dynamic administrator user profile of only the 
bundle that was launch first is deleted. The dynamic administrator user profiles of the remaining 
bundles must be manually deleted.

6.6  Postponing a Bundle Download
If, after you launch a bundle, it begins to download and you need to stop the download, you can 
postpone the download to a later time. When you resume the download, it continues from the point 
where it previously stopped.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks 
Window.

ZENworks Explorer: Open Windows Explorer and find the  ZENworks Adaptive Agent 
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon 
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area. 

2 Right-click the bundle icon, then click Postpone.

Uninstalling The bundle is being removed from the device.

Not Installed The bundle failed to install or is not yet installed.

Icon Status Description
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6.7  Verifying a Bundle
If an installed application is not functioning correctly or you think it might be outdated, you can 
verify that the application’s bundle information is still correct. If it is not, the ZENworks Adaptive 
Agent reinstalls the bundle to your workstation.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks 
Window.

ZENworks Explorer: Open Windows Explorer and find the  ZENworks Adaptive Agent 
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon 
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area. 

2 Right-click the bundle icon, then click Verify.

6.8  Viewing a Bundle’s Properties
You can view a bundle’s properties to see its version number, current installation status, and help 
contacts. In addition, if the bundle is unavailable, you can see if it is unavailable because of system 
requirements or schedule restrictions.

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks 
Window.

ZENworks Explorer: Open Windows Explorer and find the  ZENworks Adaptive Agent 
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon 
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area. 

2 Right-click the bundle icon, then click Properties.

6.9  Uninstalling a Bundle
Uninstall is an administrator-controlled feature. By default, uninstall is not enabled, which means 
that you can only uninstall bundles if your administrator has enabled the feature. Uninstall is 
enabled on a per-bundle basis. Depending on what your administrator enables, you might be able to 
uninstall some bundles but not others.

When you uninstall a bundle, the ZENworks Adaptive Agent removes all files from your device and 
undoes all configuration settings made to your device during the bundle installation. Only files that 
the Adaptive Agent installs specifically for the bundle are removed. For example, the Adaptive 
Agent does not remove any shared files (files used by another application) or any user-created files 
such as word processing documents or spreadsheets.

After you uninstall a bundle, the bundle’s icon remains on your device. This enables you to install 
the bundle again whenever necessary.

To uninstall a bundle:

1 Access the bundle in one of the following locations:

ZENworks Window: From the Start menu, click Programs > Novell ZENworks > ZENworks 
Window.
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ZENworks Explorer: Open Windows Explorer and find the  ZENworks Adaptive Agent 
entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon 
might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area. 

2 Right-click the bundle icon, then click Uninstall.
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A
AInstall, Uninstall, and Repair 
Parameters

While creating Windows MSI bundles, you can select install, uninstall, and repair parameters. The 
following sections contain information to help you select the desired options:

 Section A.1, “Install Parameters,” on page 97

 Section A.2, “Uninstall Parameters,” on page 99

 Section A.3, “Repair Parameters,” on page 101

A.1  Install Parameters
The Install Parameters dialog box lets you specify the desired parameters.

Figure A-1   Install Parameters Dialog Box

The following sections contain additional information:

 Section A.1.1, “Restart Options,” on page 98

 Section A.1.2, “Display Options,” on page 98

 Section A.1.3, “Install Options,” on page 98

 Section A.1.4, “Command Line Parameters,” on page 99
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A.1.1  Restart Options

In some cases, installing an application requires restarting the workstation.

In the Install Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
ZENworks does not force a Restart option. 

Do Not Restart (/norestart): Never restarts the workstation during the install process. The 
installation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the installation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.1.2  Display Options

In the Install Parameters dialog box, select the desired Display options. You can choose to perform 
the installation with or without a user interface, whether to display a modal dialog box at the end of 
the install process (a modal dialog box demands a response from the user before the installation is 
complete), or to hide the Cancel button so that users cannot cancel the installation.

No UI (/qn): Installs the application with no user interface (silent installation).

NOTE: This is the default installation option. If you want users to be aware that ZENworks 
Configuration Management is installing an application to help prevent them from rebooting or 
calling the help desk, change the display options to Basic UI (/qb) with No modal dialog at end (-) 
and Hide Cancel button (!). 

You can select the options in the dialog box or you can type /i /qb-! in the Command Line 
Parameters field.

Full UI (/qf): Installs the application with the full user interface and a modal dialog box displayed at 
the end of the installation. 

Reduced UI (/qr): Installs the application with a reduced user interface and a modal dialog box 
displayed at the end of the installation.

Basic UI (/qb): Installs the application with a basic user interface consisting of a progress bar. The 
following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box 
displayed at the end of the installation.

 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at 
the end of the installation.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the installation process.

A.1.3  Install Options

In the Install Parameters dialog box, select the desired Install options:
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Install (/i): Installs the application.

Administrative Install (/a): Creates an administrative installation point for the application. This 
option is useful for a network installation.

For All Users (/im): Advertises the application on the computer and installs the application for all 
users on first use.

For Logged In User Only (/iu): Advertises the application on the computer for the logged-in 
(current) user and installs the application on first use. Do not use this option when performing a 
System installation or when using a dynamic administrator to install the application.

A dynamic administrator is an administrator account that is created on the fly to perform certain 
procedures, such as installing applications. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required tasks, and 
then the account is deleted.

A.1.4  Command Line Parameters

Displays the install command line parameters used during the application’s installation. As you 
select Restart, Display, and Install options, the command line parameters in this field are 
automatically populated.

A.2  Uninstall Parameters
The Uninstall Parameters dialog box lets you specify the desired parameters.

Figure A-2   Uninstall Parameters Dialog Box
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The following sections contain additional information:

 Section A.2.1, “Restart Options,” on page 100

 Section A.2.2, “Display Options,” on page 100

 Section A.2.3, “Command Line Parameters,” on page 100

A.2.1  Restart Options

In some cases, uninstalling an application requires restarting the workstation.

SIn the Uninstall Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
ZENworks does not force a Restart option. 

Do Not Restart (/norestart): Never restarts the workstation during the uninstall process. The 
uninstallation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the uninstallation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.2.2  Display Options

In the Uninstall Parameters dialog box, select the desired Display options. You can choose to 
perform the uninstallation with or without a user interface, whether to display a modal dialog box at 
the end of the uninstallation process (a modal dialog box demands a response from the user before 
the uninstallation is complete), or to hide the Cancel button so that users cannot cancel the 
uninstallation.

No UI (/qn): Uninstalls the application with no user interface (silent uninstallation).

Full UI (/qf): Uninstalls the application with the full user interface and a modal dialog box 
displayed at the end of the uninstallation. 

Reduced UI (/qr): Uninstalls the application with a reduced user interface and a modal dialog box 
displayed at the end of the uninstallation.

Basic UI (/qb): Uninstalls the application with a basic user interface consisting of a progress bar. 
The following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box 
displayed at the end of the uninstallation.

 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at 
the end of the uninstallation.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the uninstallation process.

A.2.3  Command Line Parameters

Displays the command line parameters used during the application’s uninstallation. As you select 
Restart and Display options, the command line parameters in this field are automatically populated.
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A.3  Repair Parameters
The Repair Parameters dialog box lets you specify the desired parameters.

Figure A-3   Repair Parameters Dialog Box

The following sections contain additional information:

 Section A.3.1, “Restart Options,” on page 101

 Section A.3.2, “Display Options,” on page 102

 Section A.3.3, “Repair Options,” on page 102

 Section A.3.4, “Command Line Parameters,” on page 103

A.3.1  Restart Options

In some cases, repairing an application requires restarting the workstation.

In the Repair Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. 
ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the repair process. The repair 
process is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users 
answer No, the repair process is not completed until the next time they manually restart.
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Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.3.2  Display Options

In the Repair Parameters dialog box, select the desired Display options. You can choose to perform 
the repair process with or without a user interface, whether to display a modal dialog box at the end 
of the repair process (a modal dialog box demands a response from the user before the repair process 
is complete), or to hide the Cancel button so that users cannot cancel the repair process.

No UI (/qn): Repairs the application with no user interface (silent repair process).

Full UI (/qf): Repairs the application with the full user interface and a modal dialog box displayed 
at the end of the repair process. 

Reduced UI (/qr): Repairs the application with a reduced user interface and a modal dialog box 
displayed at the end of the repair process.

Basic UI (/qb): Repairs the application with a basic user interface consisting of a progress bar. The 
following settings are available with this option: 

 No modal dialog at end (-): Displays a basic user interface with no modal dialog box 
displayed at the end of the repair process.

 Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at 
the end of the repair process.

 Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user 
cannot cancel the repair process.

A.3.3  Repair Options

In the Repair Parameters dialog box, select the desired Repair options:

Missing File (p): Instructs Windows Installer to repair a file only if it is missing.

Older File (o): Instructs Windows Installer to repair a file if it is missing or if the installed file’s 
version is older than the file in the MSI package.

Equal or Older File (e): Instructs Windows Installer to repair a file if it is missing or if the installed 
file’s version is the same as or older than the file in the MSI package.

Different File Version (d): Instructs Windows Installer to repair a file if it is missing or if the 
installed file’s version is not exactly the same as the file in the MSI package.

Force All (a): Instructs Windows Installer to repair all files.

User Registration Keys (u): Instructs Windows Installer to repair all per-user entries from the MSI 
package to the Windows system registry. Per-user entries are those entries contained in the 
HKEY_CURRENT_USER and HKEY_USERS registry hives.

Computer Registry Keys (m): Instructs Windows Installer to repair all per-machine entries from 
the MSI package to the Windows system registry. Per-machine entries are those entries contained in 
the HKEY_LOCAL_MACHINE and HKEY_CLASSES_ROOT registry hives.
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Failed Checksum (c): Instructs Windows Installer to perform a checksum on all executable files 
and to repair a file if it is missing or if the checksum verifies that the file is corrupt. Only files that 
have msidbFileAttributesChecksum in the Attributes column of the MSI package’s File Table 
are repaired.

Install and Re-Cache (v): Instructs Windows Installer to repair files from the re-cache (local) 
source rather than the source package.

Shortcut(s): Instructs Windows Installer to repair the MSI application’s shortcuts, overwriting any 
existing shortcuts and icons.

A.3.4  Command Line Parameters

Displays the command line parameters used during the application’s repair process. As you select 
the Restart, Display, and Repair options, the command line parameters in this field are automatically 
populated.
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B
BAuthentication Hook

An authentication hook enables you to control the installation or launching of the bundle. 

Create an executable file containing your authentication logic and begin its name with authhook. 
For example, authhookinstall.exe. During the installation or launching of the bundle, the bundle 
manager searches for a file matching authhook*.* in the bin directory of ZENworks. If the file is 
found, the bundle manager passes four arguments: zone name, bundle ID, bundle name, and 
username of the current bundle to the file. On execution, the file returns a code. The bundle manager 
installs or launches the bundle only if the returned error code matches 264.
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C
CNovell File Upload Extension

If the Novell File Upload extension is not installed on this device, it must be installed before you can 
browse for file paths and upload files.

After installing the Novell File Upload extension, you do not need to perform this procedure again 
on this device, assuming you use the same Web browser (Mozilla Firefox or Microsoft Internet 
Explorer, for example) to upload files. However, an update to the Novell File Upload extensions in 
the subsequent release requires you to reinstall them on the device. For more information on 
reinstalling the Novell File Upload extension, see Section C.2, “Reinstalling the Novell File Upload 
Extension,” on page 108.

The following sections contain browser-specific information:

 Section C.1, “Installing the Novell File Upload Extension,” on page 107

 Section C.2, “Reinstalling the Novell File Upload Extension,” on page 108

C.1  Installing the Novell File Upload Extension
The Novell File Upload extension must be installed on the device before you can browse for file 
paths and upload files. 

C.1.1  On Mozilla Firefox

Perform the following steps:

1 Click the Install the Novell File Upload extension link.

Depending on your Web browser’s security settings, you might receive a message indicating 
that your browser has prevented installation of the Novell File Upload extension.

You receive the following message at the top of your browser window:

Firefox prevented this site from asking you to install software on your 
computer.

Figure C-1   Firefox Message

2 Click the Edit Options button on the right side of the message, click Allow, then click Close.

3 Click the Install the Novell File Upload extension link again.

4 Click Install Now, then restart your Web browser.
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C.1.2  On Microsoft Internet Explorer

When a Web page refers to an ActiveX control that is not currently on the workstation, users are 
asked whether or not they want the ActiveX control to be downloaded. This prompt is displayed in 
the information bar. The information bar displays in between the Internet Explorer toolbars and the 
Web page when a notification is present, and disappears on the next navigation.

Figure C-2   Internet Explorer Message

Displaying the information bar is enabled by default; however, the user can change the default 
setting so that the information bar does not display. Additionally, the ActiveX controls are installed 
automatically, without the information bar being displayed, if the publisher of the control (such as 
Novell) has been previously marked by the user as trusted.

If you are running Internet Explorer (assuming that you are using the default settings and have not 
marked Novell as trusted), the following message displays in the information bar:

To help protect your security, Internet Explorer stopped this site from 

installing an ActiveX control on your computer. Click here for options.

1 Click the information bar, then click Install ActiveX Control.

2 If you are prompted that Internet Explorer needs to resend information that you have previously 
submitted, click Retry.

3 Click OK to install the Novell File Upload extension.

You do not need to restart Internet Explorer.

C.2  Reinstalling the Novell File Upload Extension
To update the ZENworks 10 Configuration Management File Upload extension that is already 
installed on the device which is running ZENworks Control Center, do the following: 

1 Uninstall the Novell File Upload extension.

On Internet Explorer: Perform the following steps:

1. Close all instances of the Internet Explorer browser.

2. Start a new instance of the browser.

3. Click Tools > Internet Options > General.

4. In the Browsing History panel, click Settings.

5. In the Temporary Internet Files and History Settings window, click View Objects.

6. In the Downloaded Program Files window, right-click NFileUpload Class, then click 
Remove.

On Firefox: Perform the following steps:

1. Click Tools > Add-ons.

2. In the Add-ons window, click Novell ZENworks File Upload Extension 10.1.0, 
then click Uninstall.
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3. Close the Firefox browser.

4. Locate the Firefox_Install_directory/plugins directory and delete the 
npzenworks.dll and nsINZENScriptablePlugin.xpt files from the directory.

5. Restart Firefox.

2 Install ZENworks 10 Configuration Management File Upload extension. You are prompted to 
install the latest Novell File Upload Extension the next time you use ZENworks Control Center 
to browse for file paths and upload files. Follow the prompts to install the Novell File Upload 
extension. For more information, see Section C.1, “Installing the Novell File Upload 
Extension,” on page 107.
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D
DBundle Schedules Types

The following schedules are available:

 Section D.1, “Date Specific,” on page 111

 Section D.2, “Event,” on page 112

 Section D.3, “Now,” on page 113

 Section D.4, “Recurring,” on page 113

D.1  Date Specific
The Date Specific scheduling option lets you specify one or more dates on which to run the event.

Figure D-1   Date Specific Schedule

Start Dates: Click  to display a calendar you can use to select a date for the event. You can add 
multiple dates one at a time. 

Run Event Every Year: Select this option to run the event every year on the dates shown in the 
Start Date(s) list.

Select When Schedule Execution Should Start: Select one of the following options:

 Start Immediately at Start Time: Starts the event at the time you specify in the Start Time 
field.

 Start at a Random Time between Start Time and End Time: Starts the event at a randomly 
selected time between the time you specify in the Start Time and End Time fields. You can use 
this option to avoid possible network overload from concurrently scheduled events.
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Use Coordinated Universal Time (UTC): The Start Time is converted to Universal Coordinated 
Time (UTC). Select this option to indicate that the Start Time you entered is already in Coordinated 
Universal Time and should not be converted. For example, suppose you are in the Eastern time zone. 
If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 10:00 UTC. If you 
don’t select this option, the Start Time is scheduled for 14:00 UTC because Eastern time is UTC - 4 
hours.

D.2  Event
This scheduling option lets you specify the event you want to trigger the scheduled action. 

Figure D-2   Event Schedule

Select from the following triggers:

User Login: A user logs in to the device’s operating system.

User Logout: A user logs out of the device’s operating system.

Device Boot: The device powers on.

Device Shutdown: The device powers off.

On Device Lock: The device’s operating system is locked.

On Device Unlock: The device’s operating system is unlocked.

ZENworks Login: A user logs in to the ZENworks Management Zone.

ZENworks Logout: A user logs in out of the ZENworks Management Zone.

Device Connecting to Network (Windows Only): The disconnected device detects a new wired or 
wireless network connection.

NOTE: At device startup, the ZENworks Adaptive Agent contacts a ZENworks Server according to 
the device’s refresh schedule to refresh its bundle, policy, configuration, and registration 
information. If information changes, the Adaptive Agent must refresh its information before the 
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changes can show up on the device, even if one of the event triggers occur. By default, devices 
refresh randomly between 300 and 360 seconds after device startup with a full refresh every 12 
hours.

For example, if you create a bundle and schedule it to launch when the device connects to the 
network, the device must be manually refreshed or refreshed according to schedule before the 
Adaptive Agent can upload or launch the bundle, even if the device connects to the network.

D.3  Now
Select this scheduling option to run the event immediately. The Now option is available if you 
configure the Distribution Schedule as a part of the bundle assignment process in the Assign Bundle 
Wizard. However, if you choose to edit the Assignment Details, the Schedule Type field does not list 
the Now option. 

D.4  Recurring
The Recurring scheduling option lets you repeat the event at a specified interval.

NOTE: The following sections describe all of the Recurring schedule options. Depending on the 
event or action you are scheduling, some options might not be available.

Figure D-3   Recurring Schedule
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When a Device Is Refreshed: This schedule causes the event to occur each time the ZENworks 
Adaptive Agent performs a refresh on the device. If you want to delay the event so that it does not 
happen immediately upon refresh, select the Delay execution after refresh option and specify the 
number of days, hours, or minutes you want to delay the event. 

Days of the Week: This schedule lets you specify the days during the week that you want the event 
to run. The event is run on these same days each week.

Select Days of the Week, then fill in the following fields:

 Sun... Sat: Specifies the days of the week you want to run the event.

 Start Time: Specifies the time you want to run the event.

 Process Immediately if Device Unable to Execute on Schedule: The event is run 
immediately if, for some reason, the schedule you configured results in the event not being able 
to run.

 Use Coordinated Universal Time: The Start Time is converted to Universal Coordinated 
Time (UTC). Select this option to indicate that the Start Time you entered is already in 
Coordinated Universal Time and should not be converted. For example, suppose you are in the 
Eastern time zone. If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 
10:00 UTC. If you don’t select this option, the Start Time is scheduled for 14:00 UTC because 
Eastern time is UTC - 4 hours.

 Start at a Random Time between Start Time and End Time: Starts the event at a randomly 
selected time between the time you specify in the Start Time and End Time fields. You can use 
this option to avoid possible network overload from concurrently scheduled events.

 Restrict Schedule Execution to the Following Date Range: Limits running the event to the 
time period specified by the starting and ending dates.

Monthly: This schedule lets you specify one or more days during the month to run the event.

Select Monthly, then fill in the following fields:.

 Day of the Month: Specifies the day of the month to run the event. Valid entries are 1 through 
31. If you specify 29, 30, or 31 and a month does not have those days, the event is not run that 
month.

 Last Day of the Month: Runs the event on the last day of the month, regardless of its date (28, 
30, or 31).

 First Sunday: Specifies a specific day of a week. For example, the first Monday or the third 
Tuesday. Click  to add multiple days. 

 Start Time: Specifies the time you want to run the event.

 Process Immediately if Device Unable to Execute on Schedule: The event is run 
immediately if, for some reason, the schedule you configured results in the event not being able 
to run.

 Use Coordinated Universal Time: The Start Time is converted to Universal Coordinated 
Time (UTC). Select this option to indicate that the Start Time you entered is already in 
Coordinated Universal Time and should not be converted. For example, suppose you are in the 
Eastern time zone. If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 
10:00 UTC. If you don’t select this option, the Start Time is scheduled for 14:00 UTC because 
Eastern time is UTC - 4 hours.
orks 10 Configuration Management Software Distribution Reference



 Start at a Random Time between Start Time and End Time: Starts the event at a randomly 
selected time between the time you specify in the Start Time and End Time boxes. You can use 
this option to avoid possible network overload from concurrently scheduled events.

 Restrict Schedule Execution to the Following Date Range: Limits running of the event to 
the time period specified by the starting and ending dates.

Fixed Interval: This schedule lets you specify an interval between days to run the event. For 
example, you can run the event every 14 days.

Select Fixed Interval, then fill in the following fields:.

 Months, Weeks, Days, Hours, Minutes: Specifies the interval between times when the event 
is run. You can use any combination of months, weeks, days, hours, and minutes. For example, 
both 7 days, 8 hours and 1 week, 8 hours provide the same schedule.

 Start Date: Specifies the initial start date for the interval.

 Start Time: Specifies the initial start time for the interval.

 Process Immediately if Device Unable to Execute on Schedule: The event is run 
immediately if, for some reason, the schedule you configured results in the event not being able 
to run.

 Use Coordinated Universal Time: The Start Time is converted to Universal Coordinated 
Time (UTC). Select this option to indicate that the Start Time you entered is already in 
Coordinated Universal Time and should not be converted. For example, suppose you are in the 
Eastern time zone. If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 
10:00 UTC. If you don’t select this option, the Start Time is scheduled for 14:00 UTC because 
Eastern time is UTC - 4 hours.

 Restrict Schedule Execution to the Following Date Range: Limits running of the event to 
the time period specified by the start date, end date, and end time.
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E
EActions

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, 
the possible action sets are Distribute, Install, Launch, Verify, Uninstall, Terminate, and Preboot. For 
example, if you select a Windows bundle, five actions sets are available. If you select an Imaging 
bundle, Preboot is the only available action set available.

You can add an action to any of the available action sets. When you do so, that action is performed 
whenever the action set is applicable. For example, when you add an action to the Install action set, 
that action is performed whenever the bundle is installed.

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down 
list, then select an available action. 

The following sections contain information about the actions you can configure for the Distribute, 
Install, Launch, Verify, and Terminate action sets. For more information about the actions you can 
configure for the Preboot action set, see “Preboot Actions” in the ZENworks 10 Configuration 
Management Preboot Services and Imaging Reference.

 Section E.1, “Action - Apply Personality,” on page 118

 Section E.2, “Action - Copy Directory,” on page 119

 Section E.3, “Action - Copy Files,” on page 121

 Section E.4, “Action - Create/Delete Directory,” on page 123

 Section E.5, “Action - Delay,” on page 124

 Section E.6, “Action - Display Message,” on page 126

 Section E.7, “Action - Distribute Files,” on page 127

 Section E.8, “Action - Edit INI File,” on page 127

 Section E.9, “Action - Edit Text File,” on page 130

 Section E.10, “Action - End Process,” on page 132

 Section E.11, “Action - File Removal,” on page 133

 Section E.12, “Action - Install Bundle,” on page 135

 Section E.13, “Action - Install Directory,” on page 135

 Section E.14, “Action - Install Files,” on page 138

 Section E.15, “Action - Install MSI,” on page 141

 Section E.16, “Action - Install MSP,” on page 144

 Section E.17, “Action - Install Network MSI,” on page 145

 Section E.18, “Action - Launch Bundle,” on page 148

 Section E.19, “Action - Launch Java Application,” on page 149
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 Section E.20, “Action - Launch URL,” on page 151

 Section E.21, “Action - Launch Executable,” on page 152

 Section E.22, “Action - Launch Windows Thin Client Application,” on page 156

 Section E.23, “Action - Prompt User,” on page 159

 Section E.24, “Action - Reboot/Shutdown,” on page 160

 Section E.25, “Action - Registry Edit,” on page 162

 Section E.26, “Action - Run Script,” on page 167

 Section E.27, “Action - Start/Stop Service,” on page 173

 Section E.28, “Action - Store Personality,” on page 174

 Section E.29, “Action - Terminate Application,” on page 175

 Section E.30, “Action - Terminate Application Prompt,” on page 176

 Section E.31, “Action - Undo Install Actions,” on page 177

 Section E.32, “Action - Uninstall Bundle,” on page 177

 Section E.33, “Action - Verify Bundle,” on page 178

 Section E.34, “Action - Verify Install Actions,” on page 179

E.1  Action - Apply Personality
The Apply Personality page lets you specify the personality migration template and the Platform 
Neutral Package (PNP) file to be used for the migration.

For more information on personality migration template, see ZENworks 10 Personality Migration 
Reference.

Figure E-1   Action - Apply Personality Dialog Box
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You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click the Add drop-down list, then select 
the Apply Personality action.

Upload a template from this device  Select this option and click  to display the Upload content 
dialog box. Browse to and select the template to upload.

Specify a template on the managed device  Select this option to specify the path of personality 
migration template file on the managed device. You can also specify the UNC path of the file.

Path from where the PNP file is to be loaded Specify the path of the PNP file containing the 
migration settings and data on the managed device. You can also specify the UNC path of the file.

Password to decrypt the PNP file Select this check box to enter the password to decrypt the PNP 
file.

NOTE: If you spanned the PNP file, be sure to keep the spanned files and the PNP file in the same 
folder.

E.2  Action - Copy Directory
The Action - Copy Directory dialog box lets you specify the directory to be copied and its 
destination directory. You can also specify the executable security level.

NOTE: Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the ZENworks content repository. Copying a file or directory is described as 
copying without using content. When copying a file or directory, the managed device performs the 
copy operation and must be able to resolve both the source and destination paths. Also, when 
copying a file or directory, the file or directory is not cached on the managed device. 

Installing a file or directory uploads the file or directory to the ZENworks content repository before 
it is distributed to assigned devices. Installing a file or directory is described as copying using 
content. When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to 
the bundle.
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Figure E-2   Action - Copy Directory Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Source Directory: If you have not installed the Novell File Upload extension on this device, you 
must do so before you can browse for a directory. For more information, see Novell File Upload 
Extension.

Click Browse to display the Browse for Folder dialog box. Browse to and select the directory to 
copy.  The path must be resolvable by the device on which the bundle is run.

Destination Directory: Specify the destination path on the device where you want to copy the 
directory. The path must be resolvable by the device on which the bundle is run.

Hidden: Select the Hidden check box to specify that the directory is hidden after installation.

Read-only: Select the Read-only check box to specify that the directory is read-only after 
installation.

Copy Option: Select a copy option from the list:

 Copy Always: Copies the contents of the directory regardless of whether the files currently 
exists on the workstation.

 Copy If Exists: Copies the contents of the directory only if the files currently exists on the 
workstation.
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 Copy If Does Not Exist: Copies the contents of the directory only if the files does not 
currently exist on the workstation.

 Copy If Newer: Copies the contents of the directory only if the modified date and time of the 
file is newer than the existing file’s date and time, or if the files does not currently exist on the 
workstation.

 Copy If Newer and Exists: Copies the contents of the directory only if it already exists on the 
workstation and the date and time of the file is newer than the existing file’s date and time.

 Copy if Newer Version: Copies the contents of the directory only if the internal version of the 
file is newer than the existing file’s version (if version information is present).

 Request Confirmation: Prompts the user to confirm that the content of the directory should be 
copied when the directory already exists on the workstation.

 Copy If Different: Copies the contents of the directory if the creation date, creation time, or 
size of the file is different than the existing file’s date, time, or size.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the 
action has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention. If you use mapped network drives to 
specify files and directories, the action fails because system users do not have access to user 
mapped drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.3  Action - Copy Files
The Action - Copy Files dialog box lets you specify files to copy to the device.
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Figure E-3   Action - Copy Files Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

File Details: Click Add to display the Select Files dialog box. Click the Help button for more 
information.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the 
action has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention. If you use mapped network drives to 
specify files and directories, the action fails because system users do not have access to user 
mapped drives. 
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 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.4  Action - Create/Delete Directory
The Action -Create/Delete dialog box lets you create or delete directory on the managed device.

Figure E-4   Action - Create/Delete Directory Dialog Box

You can access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Create Directory: Creates a directory on the managed device when the action is performed.

Delete Directory: Deletes a directory on the managed device when the action is performed.

Directory Name: Specify the complete path of the directory you want to create or delete on the 
managed device.This path must be resolved by the device on which the bundle is run.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.
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If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the 
action has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention. If you use mapped network drives to 
specify files and directories, the action fails because system users do not have access to user 
mapped drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.5  Action - Delay
The Action - Delay dialog box lets you specify a system delay between two actions in the action set.
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Figure E-5   Action - Delay Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Delay for a Specific Time: Specify the desired time delay, in seconds. After completing the action, 
the system delays for the specified amount of time before performing the next action.

Wait for Processes or Services to Start: Specify the processes or services that must start before the 
next action in the action set is performed. 

To add a process or service to the list:

1 Click Add to display the Add Service/Process dialog box.

2 Select Process, specify the process that must start before performing the next action, then click 
OK. You can specify either the name of the process or its full path. For example, you can 
specify notepad.exe or ${SystemRoot}\system32\notepad.exe.

or

Select Service, specify the service that must start before performing the next action, then click 
OK.

3 Repeat Step 2 as needed.
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4 Specify the maximum amount of time to wait for the process or service to start before 
performing the next action in the action set. If the process or service does not start in the 
specified amount of time, the next action is performed.

5 Click OK.

Click Edit to change a process or service, or click Remove to delete a process or service.

E.6  Action - Display Message
The Action - Display Message dialog box lets you specify a message to display on devices when the 
action is performed.

Figure E-6   Action - Display Message Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Seconds to be Displayed: Specify the number of seconds that you want the message displayed on 
the device.

Define Prompts: Define the prompt that you want to display on the device. Additionally, you can 
specify different locales with different messages.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the 
specified locale. You can create different messages, each with its own locale setting.

3 Specify the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:
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Please save your work and close any open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

Click Edit to change the prompt, or click Remove to delete the prompt.

E.7  Action - Distribute Files
The Distribute Files Action distributes the content of the bundle from the ZENworks Server to the 
managed device or user. There are no configuration tasks that you need to perform for this action.

E.8  Action - Edit INI File
The Action - Edit INI File dialog box lets you specify a file and configure the list of changes to be 
performed on the file. You can also create a file, if one does not exist.

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

The following sections contain additional information:

 Section E.8.1, “Filename,” on page 127

 Section E.8.2, “Encoding,” on page 127

 Section E.8.3, “Create File, If Does Not Exist,” on page 128

 Section E.8.4, “INI Changes,” on page 128

 Section E.8.5, “Advanced Options,” on page 130

E.8.1  Filename

Specify the file that you want to change. For example, C:\Program Files\OpenOffice.org 
2.0\program\setup.ini.

E.8.2  Encoding

Specify the encoding that you want to use:

Auto detect:  Use the encoding used in the original file that you specified in the Filename field. 
This is the default option.

ASCII: Use ASCII encoding.

Unicode:  Use Unicode encoding.

UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.
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E.8.3  Create File, If Does Not Exist

Specify whether you want to create the file specified in the Filename field, if it does not exist. The 
file is created with the same name and the extension as specified in File Path. If the file specified in 
File Path does not have an extension, then the created file also does not have any extension.

If this option is selected and Encoding is set to Auto detect, the file is created in UTF-8 format with 
the same name and the extension as specified in File Path.

E.8.4  INI Changes

The INI Changes page lets you specify the INI file to change, add sections to the file, add keys to a 
section in the file, and import changes from another INI file. 

Figure E-7   Action - Edit INI File Dialog Box: INI Changes Page

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

The following table lists the tasks you can perform to manage INI changes.
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Table E-1   INI Tasks

Task Steps Additional Details

Specify the INI file to 
change

1. Specify the file that you want to 
change. 

For example, C:\Program 
Files\OpenOffice.org 
2.0\program\setup.ini.

Add a section 1. Click Add, then click New Section 
Change to open the Add a Change 
dialog box.

2. Fill in the fields, then click OK.

Click the Help button for additional 
information.

If you specify an existing section and 
add new keys to the list, then the 
existing section is updated with the 
newly added keys. For example, if a 
section sect1 with k1=v1 already exists 
and if you specify a new section sect1 
with k1=v1,  k2=v2, then the newly 
added key k2=v2 is added to sect1.

Add keys to a 
section

1. Click the section to which you want 
to add the keys.

2. Specify the keys to be added to the 
section in the INI file. Type the key, 
such as key1 or key1=value1, then 
click Add to move the key to the 
list.

You can edit or remove an entry, or 
you can use the Move Up and 
Move Down buttons to order the 
list. The changes to the file are 
made in the order listed.

Edit an INI Change 1. Click the desired item you want to 
edit. The Add a Change dialog box 
is displayed. 

The Section Change Type configured 
for the section is displayed by default in 
the Add Change dialog box.

Remove a section or 
keys

1. Select the check box next to the 
desired item, then click Delete.

Import INI changes 
from another file

1. Click Import to display the Import 
INI Changes from File dialog box.

2. Specify the file from which you 
want to import changes, then click 
OK.

Change the order of 
items

1. Select the check box next to an 
item, click Edit, then select an 
option (Sort, Move Up, Move 
Down).

Select all the objects 
of a parent folder 

1. Select the check box next to the 
parent folder, then click Edit > 
Select All Children.

Deselect all the 
objects of a parent 
folder 

1. Select the check box next to the 
parent folder, then click Edit > 
Deselect All Children.

Clear Selection 1. Click Edit > Clear Selection.
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Run Action As: Specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User.

E.8.5  Advanced Options

The Advanced Options page lets you create the file (if it does not exist), specify the number of 
backup files to retain, and specify key-value separators and comment characters.

Figure E-8   Action - Edit INI File Dialog Box: Advanced Options Page

Create File, If Does Not Exist: Specify whether you want to create the file specified in the 
Filename field, if it does not exist.

Number of File Backup(s) to Retain: Specify the number of backups of the INI file to retain. The 
default is 5 backup copies, but you can specify any number between 1 and 25. When the number of 
backup copies of the file exceeds the number specified here, the oldest backup file is overwritten.

Key-Value Separator: Specify the character you want to separate key values. You can use an 
equals sign (=) or a colon (:).

Value Separator: Specify the character you want to separate the multiple values. You can use 
characters such as equals sign (=), comma(,), space(  ), hash (#), semicolon (;) or a colon (:).

Comment Character: Specify the character you want precede comments in the INI file. You can 
use a semicolon (;) or a pound sign (#).

Append key-value separator to the key when value is not available: Select this option to append 
the key-value separator to the key even if the value is not available. For example, in the setup.ini file 
used by Acrobat Reader, the CmdLine key does not have a value but requires a key-value separator. 

E.9  Action - Edit Text File
The Action - Edit Text File dialog box lets you specify a file and configure the list of changes to be 
performed on the file.
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Figure E-9   Action - Edit Text File Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Filename: Specify the file that you want to change. For example, ${SystemDrive}\Program 
Files\myfile.txt.

File Backup(s) to Retain: Specify the number of backups of the text file to retain. The default is 5 
backup copies, but you can specify any number between 1 and 25. When the number of backup 
copies of the file exceeds the number specified here, the oldest backup file is overwritten.
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Encoding: Specify the encoding that you want to use:

 Auto detect: Use the encoding used in the original file that you specified in the Filename field. 
This is the default option.

 ASCII: Use ASCII encoding.

 Unicode: Use Unicode encoding.

 UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

File Operation > Specify Contents of the File: Use this option to specify the contents of the text 
file.

 Import Contents from an Existing File on this Device: Browse to and select the text file 
from which you want to import its contents.

 Contents of the File: Specify the contents of the newly created file.

 Create File, If Does Not Exist: Specify whether you want to create the file specified in the 
Filename field, if it does not exist. If this option is selected and Encoding is set to Auto detect, 
the file is created in UTF-8 format with the same name and the extension as specified in File 
Path. 

File Operation > Specify Changes to the File: Use this option to specify the changes to the text 
file.

 Change List: Specify the changes that you want to make to the text file. Click Add to open the 
Add a Change dialog box, fill in the fields, then click OK. Click the Help button for additional 
information.

You can edit or remove an entry, or you can use the Move Up and Move Down buttons to order 
the list. The changes to the file are made in the order listed.

 Create File, If Does Not Exist: Specify whether you want to create the file specified in the 
Filename field, if it does not exist.

 Contents of the File: If you selected the Create File, If Does Not Exist check box, specify the 
contents of the newly created file that is created if the specified file does not exist.

 Apply Changes Configured in the Change List: Specify whether you want to apply the 
changes that you added to the Change List box to the newly created file.

Run Action As: Specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User.

E.10  Action - End Process
The Action - End Process dialog box lets you specify the executable name of the process that you 
want to stop (for example, notepad, mspaint, winword, and so forth). If the process is not running 
on the device, the End Process task completes.
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Figure E-10   Action - End Process Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

E.11  Action - File Removal
The Action - File Removal dialog box lets you specify files or directories to remove from the device.
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Figure E-11   Action File Removal Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

You can use this action to perform an automated system cleanup. For example, you can specify that 
the c:\windows\Temp\Temporary Internet Files directory and all files matching 
c:\windows\Temp\*.log in are removed from the device.

You cannot remove read-only files. If you specify a directory that contains several files (including 
some read-only files), the directory and the read-only files are not removed when the File Removal 
action runs. The files that are not read-only, however, are removed from the device.

Full Path to Source Files/Directories: Specify the full path to the file or directory that you want to 
remove, then click Add to add the file or directory to the list. You can use wildcard characters. If you 
use a mapped network drive to specify the path, you must select User from the Run Action As list.

Include System Files: Select this option to remove system files. If you specify a directory for 
removal that includes both system and non-system files, only non-system files are deleted, unless 
you specify this option.

Delete Folder Only if Empty: Select this option if you want to remove the specified folders only if 
they are empty.
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When a File is Locked, Retry _Times, Every _Seconds: If a file is locked when the action is 
performed, the file cannot be removed. Select the check box and then specify the number of retry 
attempts and the time interval between attempts. By default, the action is retried 3 times with 5 
seconds between each attempt.

Run Action As: Specify System (the default) or User from the Run Action As list. Specify System if 
removing files requires access to all areas of the device’s file system. If you use mapped network 
drives to specify files and directories, you must run the action as User, else the action fails because 
system users do not have access to user mapped drive

E.12  Action - Install Bundle
The Action - Install Bundle dialog box lets you browse to and select the bundle to install on the 
device. The bundle is installed on the device even if it has not been previously assigned to that 
device.

Figure E-12   Action - Install Bundle Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

You must not use the Install Bundle action to install Directive bundles. 

Creating this action creates a bundle dependency. For more information, see Section 1.4, 
“Dependency Bundles,” on page 13.

E.13  Action - Install Directory
The Action - Install Directory dialog box lets you specify the directory to be installed, specify a 
destination path, specify whether the directory is hidden or read-only after being installed on the 
device, and specify a copy option. You can also use this page to install the Novell File Upload 
extension, which allows you to browse for directories.

Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the ZENworks content repository. Copying a file or directory is described as 
copying without using content. When copying a file or directory, the managed device performs the 
copy operation and must be able to resolve both the source and destination paths. Also, when 
copying a file or directory, the file or directory is not cached on the managed device. 
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Installing a file or directory uploads the file or directory to the ZENworks content repository before 
it is distributed to assigned devices. Installing a file or directory is described as copying using 
content. When installing a file or directory, the file or directory is cached on the managed device. If 
a directory does not have any content, it is not uploaded to the content repository. This causes any 
successive action depending on this empty directory to fail.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to 
the bundle.

Figure E-13   Action - Install Directory Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 As part of the process of creating a File bundle. For more information, see Section 2.2, 
“Creating File Bundles,” on page 23.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Source Directory: Click  to browse to and select the directory you want to install on the device. 

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse to and upload directories to be installed. For more information, see “Novell File Upload 
Extension” on page 107.

By default, the content uploaded to the ZENworks content repository is encrypted and compressed 
before it is distributed to assigned devices. However, if you do not want the content to be encrypted 
and compressed, then select the Do not compress or encrypt uploaded content option. 
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Packaging Specifies how the content is packaged before it is distributed to assigned devices.

If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is not 
selected, the value of Packaging option is initially displayed as Auto as the content is in the process 
of being encrypted and compressed. After the content has been encrypted and compressed, the value 
of Packaging option changes to Compressed, Encrypted

If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is 
selected, the value of Packaging option is displayed as None because the content is neither 
compressed nor encrypted.

Destination Directory: Specify the destination directory on the device in which you want to install 
the directory.

Hidden: Select the Hidden check box to specify that the directory is hidden after installation.

Read-Only: Select the Read-only check box to specify that the directory is read-only after 
installation.

Copy Option: Select a copy option from the list:

 Copy Always: Copies the contents of the directory regardless of whether the files currently 
exists on the workstation. 

 Copy If Exists: Copies the contents of the directory only if the files currently exists on the 
workstation.

 Copy If Does Not Exist: Copies the contents of the directory only if the files does not 
currently exist on the workstation.

 Copy If Newer: Copies the contents of the directory only if the modified date and time of the 
file is newer than the existing file’s date and time, or if the files does not currently exist on the 
workstation.

 Copy If Newer and Exists: Copies the contents of the directory only if it already exists on the 
workstation and the date and time of the file is newer than the existing file’s date and time.

 Copy if Newer Version: Copies the contents of the directory only if the internal version of the 
file is newer than the existing file’s version (if version information is present).

 Request Confirmation: Prompts the user to confirm that the contents of the directory should 
be copied when the directory already exists on the workstation.

 Copy If Different: Copies the contents of the directory if the creation date, creation time, or 
size is different than the existing file’s date, time, or size.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the 
action has the same rights to the registry and the file system as the logged-in user.
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 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention. If you use mapped network drives to 
specify files and directories, the action fails because system users do not have access to user 
mapped drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.14  Action - Install Files
The Action - Install Files dialog box lets you specify the file to copy to the content server and from 
content server to the device, the destination directory and filename, and the copy options. 

Figure E-14   Action - Install Files Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 As part of the process of creating a File bundle. For more information, see Section 2.2, 
“Creating File Bundles,” on page 23.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.
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In the Action- Install dialog box, click Add to display the Select Files dialog box.

Figure E-15   Select Files Dialog Box

The Select Files dialog box lets you specify the files to be copied, specify a destination and source 
directory, specify whether the files are hidden or read-only after being copied to the device, and 
specify a copy option. You can also use this page to install the Novell File Upload extension, which 
must be installed before you can browse for and upload files.

Copying a file or directory copies the file or directory from one location to another without 
uploading the files into the ZENworks content repository. Copying a file or directory is described as 
copying without using content. When copying a file or directory, the managed device performs the 
copy operation and must be able to resolve both the source and destination paths. Also, when 
copying a file or directory, the file or directory is not cached on the managed device. 

Installing a file or directory uploads the file or directory to the ZENworks content repository before 
it is distributed to assigned devices. Installing a file or directory is described as copying using 
content. When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you 
must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to 
the bundle.

File: Click Add to display the Select Files dialog box, specify the files you want to copy to the 
device, then click Open. Repeat this step as many times as necessary to copy the desired files.

If the Novell File Upload extension is not installed on this device, you must install it before you can 
browse for file paths. For more information, see “Novell File Upload Extension” on page 107.

By default, the content uploaded to the ZENworks content repository is encrypted and compressed 
before it is distributed to assigned devices. However, if you do not want the content to be encrypted 
and compressed, then select the Do not compress or encrypt uploaded content option. 

Click OK to upload the files to the server. The File option lists all the uploaded files, the size of the 
files, and how the content is packaged
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Destination Directory: Specify the destination directory on the device in which you want to install 
the file.

Hidden: Select the Hidden check box to specify that the file is hidden after installation.

Read-Only: Select the Read-only check box to specify that the file is read-only after installation.

Copy Option: Select a copy option from the list:

 Copy Always: Copies the file regardless of whether the file currently exists on the workstation.

 Copy If Exists: Copies the file only if the file currently exists on the workstation.

 Copy If Does Not Exist: Copies the file only if the file does not currently exist on the 
workstation.

 Copy If Newer: Copies the file only if its modified date and time is newer than the existing 
file’s date and time, or if the file does not currently exist on the workstation.

 Copy If Newer and Exists: Copies the file only if it already exists on the workstation and the 
date and time of the file is newer than the existing file’s date and time.

 Copy if Newer Version: Copies the file only if its internal version is newer than the existing 
file’s version (if version information is present).

 Request Confirmation: Prompts the user to confirm that the file should be copied when the 
file already exists on the workstation.

 Copy If Different: Copies the file if its creation date, creation time, or size is different than the 
existing file’s date, time, or size.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The action uses the logged-in user’s credentials. For example, the 
action has the same rights to the registry and the file system as the logged-in user.

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention. If you use mapped network drives to 
specify files and directories, the action fails because system users do not have access to user 
mapped drives. 

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.
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You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.15  Action - Install MSI
The Action - Install MSI dialog box lets you specify the location of the MSI file; its Install, 
Uninstall, and Repair parameters; the transform file; and the executable security level.

Figure E-16   Action - Install MSI Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Windows bundle by using the Actions bundle category. For 
more information, see Section 2.4, “Creating Windows Bundles,” on page 31.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.
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.msi File: Click  to display the Select .msi File dialog box. Browse to and select the .msi file to 
install. 

Select the Include all files in and below the directory of this file option to include all the supporting 
files that are within the directory containing the .msi file and the subdirectories within it. 

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse to and upload files. For more information, see “Novell File Upload Extension” on 
page 107.

Install Parameters: Click  to display the Install Parameters dialog box, then specify the desired 
parameters. Click the Help button for additional information. 

Uninstall Parameters: Click  to display the Uninstall Parameters dialog box, then specify the 
desired parameters. Click the Help button for additional information. 

Repair Parameters: Click  to display the Repair Parameters dialog box, then specify the desired 
parameters. Click the Help button for additional information. 

Transform File: Click Add to browse to and select the desired transform file. You can upload the 
transform file or you can specify its location.

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse for a file path. For more information, see “Novell File Upload Extension” on page 107.

Different groups within an organization often use the same application, but they might not require 
the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 
10 different feature sets or other alterations for the same application, you can deploy the same MSI 
package to all 10 user groups, but with a different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification 
information, such as whether features are installed; how they are installed; which files, shortcuts, 
and registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create 
and manage transforms.

MSI Properties: The MSI package contains the property values that were defined during the 
administrative installation of the application. These property values determine the way the Microsoft 
Windows Installer installs the application to the workstation. In some cases, you might want to 
change one or more of the property values. For example, a property value might define the default 
location for a user’s work files. By adding the property to the list and changing the property’s value, 
you can override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing 
so, you should be careful to add only those properties that are valid for the package. The following 
options are available:

 Add: To override a property value, you change the property value and add the property to the 
Properties list so that Application Launcher knows to use that property value rather than the 
one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. 
In the Name field, select the property whose value you want to override, specify the new value 
in the Value field, then click OK to add the property to the MSI Properties list.

 Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, 
modify the value data, then click OK.
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 Remove: To remove a property from the MSI Properties list, select the property, then click 
Remove. Deleting the property causes future installations of the application to use the property 
value defined in the MSI package.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below: 

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you 
want the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator 
privileges to the logged-in user. However, providing administrator privileges to a user might 
pose security risks. If this option is selected, the user on the managed device is prompted to 
enter the password when the MSI is installed on the device. To install the MSI, the user must 
log in to the device with a user account that has a password configured.

NOTE: On a Vista device, if the administrator is logged in to the device and the Grant 
administrator privilege to user during installation is selected, the action is performed in the 
quiet mode. 

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.
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E.16  Action - Install MSP
The Action - Install MSP dialog box lets you specify the location of the MSP file, command line 
parameters, and executable security level.

Figure E-17   Action - Install MSP Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Windows bundle by using the Actions bundle category. For 
more information, see Section 2.4, “Creating Windows Bundles,” on page 31.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

.msp File: Click  to display the Select .msp File dialog box. Browse to and select the MSP file. 
You can also enter the UNC path of the .msp file for a network install. 

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse for a file path. For more information, see “Novell File Upload Extension” on page 107.

Command Line Parameters: Specify the command line parameters that you want to run when the 
MSP file is installed. 

Executable Security Level: Click More Options to specify the executable security level options:

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.
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Select the application’s initial window size: Normal, Minimized, Maximized, or Hidden. In 
Hidden mode, the application runs normally without a user interface available. This is useful if 
you want the application to process something then go away without user intervention.

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.17  Action - Install Network MSI
The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install, 
Uninstall, and Repair parameters; the transform file; and the executable security level.
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Figure E-18   Action - Install Network MSI Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Windows bundle by using the Actions bundle category. For 
more information, see Section 2.4, “Creating Windows Bundles,” on page 31.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

.msi File: Specify the .msi file to install. 

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse for a file path. For more information, see “Novell File Upload Extension” on page 107.

Install Parameters: Click  to display the Install Parameters dialog box, then specify the desired 
parameters. Click the Help button for additional information. 

Uninstall Parameters: Click  to display the Uninstall Parameters dialog box, then specify the 
desired parameters. Click the Help button for additional information. 
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Repair Parameters: Click  to display the Repair Parameters dialog box, then specify the desired 
parameters. Click the Help button for additional information. 

Transform File: Click Add to browse to and select the desired transform file. You can upload the 
transform file or you can specify its location.

If you have not installed the Novell File Upload extension on this device, you must do so before you 
can browse to for a file path. For more information, see “Novell File Upload Extension” on 
page 107.

Different groups within an organization often use the same application, but that doesn’t mean they 
require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups 
needing 10 different feature sets or other alterations for the same application, you can deploy the 
same MSI package to all 10 user groups, but with a different transform file (MST) applied for each 
group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification 
information, such as whether features are installed; how they are installed; which files, shortcuts, 
and registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create 
and manage transforms.

MSI Properties: The MSI package contains the property values that were defined during the 
administrative installation of the application. These property values determine the way the Microsoft 
Windows Installer installs the application to the workstation. In some cases, you might want to 
change one or more of the property values. For example, a property value might define the default 
location for a user’s work files. By adding the property to the list and changing the property’s value, 
you can override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing 
so, you should be careful to add only those properties that are valid for the package. The following 
options are available:

 Add: To override a property value, you change the property value and add the property to the 
Properties list so that Application Launcher knows to use that property value rather than the 
one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. 
In the Name field, select the property whose value you want to override, specify the new value 
in the Value field, then click OK to add the property to the MSI Properties list.

 Edit: To modify a property that is in the MSI Properties list, select the property, click Edit, 
modify the value data, then click OK.

 Remove: To remove a property from the MSI Properties list, select the property, then click 
Remove. Deleting the property causes future installations of the application to use the property 
value defined in the MSI package.

Executable Security Level: Click More Options to specify the executable security level options.

On Windows 2000/XP/Vista, the application executable can run in either the “user” space or the 
“system” space. By default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in user.
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If the logged-in user's security level does not provide sufficient rights and file access to run the 
application, you can configure the application to run in the “system” space or as a dynamic 
administrator, as described below:

 Run as logged in user: The MSI application inherits the logged-in user’s credentials. For 
example, the application has the same rights to the registry and the file system as the logged-in 
user.

Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden 
mode, the application runs normally without a user interface available. This is useful if you 
want the application to process something, then go away without user intervention.

Select Grant administrator privilege to user during installation to provide administrator 
privileges to the logged-in user. However, providing administrator privileges to a user might 
pose security risks. If this option is selected, the user on the managed device is prompted to 
enter the password when the MSI is installed on the device. To install the MSI, the user must 
log in to the device with a user account that has a password configured.

NOTE: On a Vista device, if the administrator is logged in to the device and the Grant 
administrator privilege to user during installation is selected, the action is performed in the 
quiet mode. 

 Run as secure system user (Don't allow system to interact with desktop): The application 
is run under the Local System user and inherits Administrator-level credentials. For example, 
the application has full rights to the registry and the file system. Because the security level is 
set to Secure, the application's interface is not displayed to the user and the application is only 
visible in the Task Manager. This option is useful when running applications that require full 
access to the workstation but require no user intervention.

 Run as dynamic administrator: A dynamic administrator is an administrator account that is 
locally created on the fly to perform certain procedures, such as installing applications. Using a 
dynamic administrator is helpful when installing applications (some MSI applications, for 
example) that cannot be installed in the system space. Because the dynamic administrator does 
not have access to the network, the network shares on which the MSI is available must be made 
publicly accessible. When you select this action, the dynamic administrator is created, it 
performs the required tasks, and then the account is deleted. 

You cannot use mapped network drives to specify files and directories because dynamic 
administrators do not have access to mapped drives.

NOTE: Performing this action as a dynamic administrator on a Windows domain controller 
fails because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

E.18  Action - Launch Bundle
The Action - Launch Bundle dialog box lets you specify the bundle to launch on the device. 
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Figure E-19   Action - Launch Bundle Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

In the Action - Launch dialog box, click  to display the Select the Bundle to Launch dialog box. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down- arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed (Directive, File, Imaging, and Windows bundles). Also, if you know 
the name of the bundle you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 1.4, 
“Dependency Bundles,” on page 13.

E.19  Action - Launch Java Application
The Action - Launch Java Application dialog box lets you configure a Java program to be executed 
on the managed device.
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Figure E-20   Action - Launch Java Application Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down 
list, then select an available action.

Java Program Name: Specify the Java program name. For example, com.novell.TestProg.

Program Parameters: Specify the program parameters. 

Path to Java Runtime Executable (JRE): Specify the path to the Java Runtime Executable (JRE).

JRE Parameters: Specify the JRE parameters. 

Wait Before Proceeding to Next Action: Specify what happens after the Java application 
launches:

 No wait: The next action in the list is immediately performed.

 When launch action is complete: The next action in the list is performed after the launch 
action completes.

 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next 
action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds option, 
this option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.
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Success Return Codes: Specify the non-zero success codes that the script returns. You can specify 
multiple success codes separated by commas.

If a script returns non-zero success codes, you should specify these non-zero success codes while 
launching the action. For example, explorer.exe in Windows returns a success code of 1. To 
successfully launch the Explorer application, you should add 1 as the success code while launching 
the action.

Specify the Success Return Code as * to enable any non-zero code returned by a script to be treated 
as success.

Working Directory: Click More Options to specify the Java application’s working directory.

Specify the initial working directory for the application.

Priority: Click More Options to specify the Java application’s priority.

Specify the priority of the process that runs the application. This option lets you configure how 
much of the CPU usage the application process consumes. Select from the following priorities: Real 
Time, High, Above Normal, Normal, Below Normal, and Low.

Run As: Click More Options to specify the Java application’s Run As settings.

 System: Runs the application as the system account (as a service).

 Administrator: Runs the application as a dynamic administrator user. A dynamic 
administrator is an administrator account that is created on the fly to perform certain 
procedures, such as installing applications or running scripts. Using a dynamic administrator is 
helpful when installing applications (some MSI applications, for example) that cannot be 
installed in the system space. When you select this action, the dynamic administrator is created, 
it performs the required tasks, and then the account is deleted.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails 
because Microsoft does not allow the use of local administrator accounts on domain 
controllers.

 User: The application runs using the logged-in user’s credentials. For example, the application 
has the same rights to the registry and the file system as the logged-in user.

E.20  Action - Launch URL
The Action - Launch URL dialog box lets you specify the URL to launch on the device.

Figure E-21   Action - Launch URL Dialog Box
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You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Click Test URL to open a Web browser to verify that the URL is correct.

E.21  Action - Launch Executable
The Add Actions - Launch Windows Executable dialog box lets you specify the Windows 
executable, command line parameters, and additional optional settings.

Figure E-22   Actions - Launch Executable Dialog Box
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You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down 
list, then select an available action.

E.21.1  General

The General page lets you specify the location of the Windows executable, the command line 
parameters to run when the executable launches, the working directory for the executable, and the 
non-zero success codes that the executable returns. 

Field Description

Command Specify the location of the Windows executable, including its filename. 

You can specify a local path or a network drive. If you specify the local path, you 
must include the executable’s full path, unless the executable is included in the 
workstation’s search path. If you specify a network drive, you can use a mapped 
drive or a UNC path, if the workstation can resolve the path.

Click Add to browse to and select the desired transform file. You can upload the 
transform file or you can specify its location.

If you have not installed the Novell File Upload extension on this device, you must 
do so before you can browse for a file path. For more information, see Novell File 
Upload Extension.

Command Line 
Parameters 

Specify the command line parameters that you want to run when the executable 
launches.

Working Directory Specify the working directory for the executable.

Success Return 
Codes

Specify the non-zero success codes that the executable returns. You can specify 
multiple success codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-
zero success codes while launching the action. For example, explorer.exe in 
Windows returns a success code of 1. To successfully launch the Explorer 
application, you should add 1 as the success code while launching the action.

Specify the Success Return Code as * to enable any non-zero code returned by a 
script to be treated as success.

Environment 
Variables

Lets you add, edit or remove the environment variables as follows:

 Add: Click Add to display the Add Environment Variable dialog box. Specify 
the name and value of the environment variable you want to add. For 
example, Name = JAVA_HOME; Value = C:\java1.4\.

 Remove: Select the environment variables to remove and click Remove.

 Edit: Select the environment variable you want to edit, then click Edit. In the 
Edit Environment Variable dialog box, specify the new value for the variable. 
For example, Name = JAVA_HOME; Value = C:\Program 
Files\Java\jdk1.6.0_06. 
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E.21.2  Advanced

The Advanced page lets you specify the Window executable’s security level and the wait time after 
launch of windows executable and before proceeding to the next action. 

Field Description

Executable Security 
Level

Click More Options to specify the Window executable’s security level.

The executable can run in either the “user” space or the “system” space. By 
default, the Run normal option is selected, which causes the application to run in 
the “user” space and inherit the same workstation security level as the logged-in 
user.

If the logged-in user's security level does not provide sufficient rights and file 
access to run the executable, you can configure the executable to run in the 
“system” space or as a dynamic administrator, as described below:

 Run as logged in user: The executable inherits the logged-in user’s 
credentials. For example, the executable has the same rights to the registry 
and the file system as the logged-in user.

Select the executable’s initial window size: Normal, Minimized, Maximized, or 
Hidden. In Hidden mode, the executable runs normally without a user 
interface available. This is useful if you want the executable to process 
something, then go away without user intervention.

 Run as secure system user (Don't allow system to interact with 
desktop): The executable is run under the Local System user and inherits 
Administrator-level credentials. For example, the executable has full rights to 
the registry and the file system. Because the security level is set to Secure, 
the executable's interface is not displayed to the user and the executable is 
only visible in the Task Manager. This option is useful when running 
executables that require full access to the workstation but require no user 
intervention.

 Run as dynamic administrator: A dynamic administrator is an 
administrator account that is created on the fly to perform certain procedures, 
such as installing applications. Using a dynamic administrator is helpful when 
installing applications (some MSI applications, for example) that cannot be 
installed in the system space. When you select this action, the dynamic 
administrator is created, it performs the required tasks, and then the account 
is deleted.

When performing actions as a dynamic administrator, ensure that you select 
the When action is compete option in the Wait before proceeding to next 
action group box. Selecting this option ensures that the action is completed 
and the process has terminated and released its resources before ZENworks 
begins cleaning up and deleting the dynamic administrator account.

You cannot use mapped network drives to specify files and directories 
because dynamic administrators do not have access to mapped drives.

NOTE: Performing this action as dynamic administrator on a Windows 
domain controller fails because Microsoft does not allow the use of local 
administrator accounts on domain controllers.
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E.21.3  Launch Options

The Launch Options page lets you specify the Window executable’s compatibility mode, display 
settings, and the input settings. 

Wait Before 
Proceeding to Next 
Action

Click More Options to specify how long to wait after launching the Windows 
executable and before proceeding to the next action.

Specify what happens after the executable launches:

No wait: The next action in the list is immediately performed.

When launch action is complete: The next action in the list is performed after 
the launch action completes. For example, enable this option if you are running the 
action as a dynamic administrator and you want the profile cleaned up and deleted 
immediately. If you do not enable this option, the profile is cleaned up and deleted 
at the device’s next reboot.

Wait for _ seconds: Wait the specified number of seconds before proceeding to 
the next action.

 Terminate action if wait period exceeded: If you select the Wait for _ 
seconds option, this option is enabled. If the specified number of seconds is 
exceeded and the action is not successfully performed, the action 
terminates.

Field Description

Compatibility Mode Click More Options to specify the Window executable’s compatibility mode.

Launches the executable in a contained environment. Some executables cannot 
run on workstations with newer versions of Microsoft Windows because of 
incompatibility issues. The drop-down list is available after you select the 
Compatibility mode option.

Select this option if you successfully ran an executable on a previous Windows 
version but you are unable to run the executable on the device’s current Windows 
version. Select the desired platform from the list.

Field Description
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E.22  Action - Launch Windows Thin Client 
Application
The Action - Launch Windows Thin Client Application dialog box lets you specify to launch an ICA 
(Independent Computing Architecture) or RDP (Remote Desktop Protocol) client session and 
configure the appropriate settings. 

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

The following sections contain additional information:

 Section E.22.1, “ICA Session,” on page 156

 Section E.22.2, “RDP Session,” on page 157

E.22.1  ICA Session

Select this option if the terminal server requires the application to run in an ICA client session. 
Citrix MetaFrame requires ICA client sessions.

Display Click More Options to specify the Window executable’s display settings.

Select the desired display options:

Run in 256 colors:

Sets the color quality setting to 256 colors while this executable is running. The 
color quality setting reverts back to your default setting when you close the 
executable.

Run in 640 × 480 screen resolution:

Sets the screen resolution setting to 640 × 480 while this executable is running. 
The color quality setting reverts back to your default setting when you close the 
executable.

Disable visual themes:

Disables visual themes from being applied to the executable. If you are 
experiencing problems with menus or buttons on the title bar of the executable, 
this setting might solve these problems. The theme settings revert back to your 
default setting when you close the executable.

Input Settings Click More Options to specify the Window executable’s input settings.

Temporarily turns off handwriting recognition, speech recognition, and some 
accessibility features. Turning off text services does not affect multiple languages 
or keyboards that you have added.

Field Description
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Figure E-23   Action - Launch Windows Thin Client Application Dialog Box: ICA Session

Published Application Name: Type the published application name exactly as it is defined in 
Citrix.

Servers Hosting the Application: Add the Citrix servers that host the application.

1 Type the server’s IP address or hostname.

2 Click Add.

The order in which the servers are listed is the preferred order for launching. You can use the Move 
Up and Move Down buttons to change the order if necessary.

E.22.2  RDP Session

Select this option if the terminal server requires the application to run in an RDP client session. 
Microsoft Windows Terminal Server requires RDP client sessions.
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Figure E-24   Action - Launch Windows Thin Client Application Dialog Box: RDP Session

Terminal Server Address: Specify the terminal server’s IP address or hostname.

Server Port: If the terminal server is not using default port 3389, specify the correct port number.

Server Domain: If the terminal server is part of a Windows NT domain or an Active Directory 
domain, specify the domain name. If the user’s name and password in the domain matches the user 
name and password in Novell eDirectory, the user is not prompted to log in to the terminal server 
when launching the application.

Application Path: Specify the path to the application’s executable file from the perspective of the 
terminal server.

Application Working Directory: Specify the path to the directory you want the application to use 
for its working files.

Color Depth: Select the number of colors for the RDP client session. You can select 256 Colors, 
High Color (15 bits), High Color (16 bits), or True Color (24 bits). The default is True Color (24 
bits).

Screen Size: If you want the RDP client session to use the entire desktop area, select Operate in full 
screen mode. Otherwise, select Use specified screen size and manually set the width and height (in 
pixels).
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Advanced Settings for redirection: Select the settings, such as drivers, printers, serial ports, and 
smart cards, that you want to map to the remote desktop machine.

E.23  Action - Prompt User
The Action - Prompt User dialog box lets you specify that a prompt displays on the device and 
configure its settings.

Figure E-25   Action - Prompt User Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down 
list, then select an available action.

User Cancels Allowed: Specify whether the user can cancel the remaining actions in the action set. 
For example, if the action set installs an application that requires a reboot, and you select this option, 
the user can cancel the reboot, which, cancels the installation. The install action set is performed 
again according to its schedule. For this reason, use this option carefully. There is no Cancel button 
on the dialog box if you use the default setting of 0.

Seconds to be Displayed: Specify the number of seconds that the prompt is displayed before the 
action is performed. For example, suppose you configure a prompt that appears during an 
application installation before the device performs a required reboot. If you specify that the user can 
cancel the action set and you specify that the prompt displays for 10 seconds, the prompt displays 
for 10 seconds and then the device reboots.
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How Often to Prompt: Select the desired option:

 Always: Display the prompt every time the action is performed.

 Once per device: Display the prompt once on the device, regardless of how many users log in.

 Once per user: Display the prompt once per user, regardless of how many devices the user 
logs in to.

Define Prompts: Define the prompt that you want to display on the device. Additionally, you can 
specify different locales with different messages.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the 
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:

The machine will reboot in {0} seconds. Please save your work and close any 

open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

E.24  Action - Reboot/Shutdown
The Action - Reboot/Shutdown dialog box lets you specify the reboot or shutdown action for the 
device.
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Figure E-26   Action - Reboot/Shutdown Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

NOTE: The Reboot action should not normally be used in conjunction with a Recurring launch 
schedule set to When a device is refreshed. Although there are some valid use scenarios for this 
configuration, scheduling a device to reboot upon refresh can cause a continuous loop. 

Reboot: Reboot the device when this action is performed.

Shutdown: Shut down the device when this action is performed.

Time to Wait Before Reboot/Shutdown: Specify the number of seconds (between -1 and 1800) 
before the device reboots or shuts down. When the number of seconds specified passes, the device 
reboots or shuts down, regardless of whether the user clicks OK or not. Clicking OK does not cause 
the device to immediately reboot or shut down. 

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device 
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a 
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If 
you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a 
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message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If 
you select both this option and the Allow user to cancel option, a message displays indefinitely until 
the user clicks OK or Cancel.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device 
from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a 
warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If 
you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a 
message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If 
you select this option and the Allow user to cancel option, a message displays indefinitely until the 
user clicks OK or Cancel.

Display a Warning Message Before Doing Reboot/Shutdown: Specify that a message displays 
on the device, warning the user that the device is going to reboot or shut down.

For example, you could provide the following prompt:

The machine will reboot in _ seconds. Please save your work and close any open 
applications.

Before performing the action, the message displays on the device only if the user is logged in.

Allow User to Cancel: Specify whether the user can cancel the reboot or shutdown procedure.

Define Prompts: Define the prompt that you want to display on the device. Additionally, you can 
specify different locales with different messages. If you do not specify another locale, a default 
English message displays.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the 
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:

The machine will reboot in {0} seconds. Please save your work and close any 
open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

E.25  Action - Registry Edit
The Action - Registry Edit dialog box lets you configure the registry settings to apply. We 
recommend that you back up the registry before applying the specified registry settings, and ensure 
that the registry is properly formatted and well tested.

Click the Registry Tree tab to select hives in the tree to which you want to add values and keys, 
rename or remove sections, or import a registry file. Click the Advanced Settings tab to specify how 
you want the action to run (as system or user) and to back up the registry file before applying the 
modified registry file.
orks 10 Configuration Management Software Distribution Reference



You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

The following sections contain additional information:

 Section E.25.1, “Registry Tree,” on page 163

 Section E.25.2, “Advanced Settings,” on page 166

E.25.1  Registry Tree

The Registry Tree page lets you select hives in the tree to which you want to add values and keys, 
rename or remove sections, or import a registry file. 

Figure E-27   Action - Registry Edit Dialog Box: Registry Tree Page

The following table lists the tasks you can perform to manage registry tree changes.
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Task Steps

Add a registry 
key

1. Select a registry hive, click New, then click Key.

2. Specify the key’s name. For example, Software.

You can also specify multiple levels of keys by separating them with a backslash 
(\). For example, Novell\ZENworks\Zfd.

 Do not use the forward slash (/) as a separator.

3. Select one of the following registry operations:

 Create Always: Creates the key regardless of whether the key currently 
exists in the workstation’s registry.

 Create If Does Not Exist: Creates the key only if the key does not currently 
exist in the workstation’s registry.

 Rename: Renames the key if it currently exists in the workstation’s registry.

 Delete: Deletes the key if it currently exists in the workstation’s registry.

 Delete and Recreate: Deletes the key if it currently exists in the 
workstation’s registry, then re-creates the key.

 Delete if Empty: Deletes the key if it currently exists in the workstation’s 
registry and the key is empty.

 None: Does not perform any registry operation.
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Add a registry 
value 

1. Select the check box next to the desired item, then click Value to display the Add 
Value To dialog box.

2. Select one of the following options from the Value Type list:

 Default: Adds a default string value to the selected key.

 String: Adds a string value to the selected key.

 Binary: Adds a binary value to the selected key. Most hardware component 
information is stored as binary data and is displayed in hexadecimal format. 

 Dword: Adds a DWORD value to the selected key. DWORD values are 
represented by a number that is 4 bytes long. Many parameters for device 
drivers and services are this type and are displayed in binary, hexadecimal, 
or decimal format.

 Expandable String: Adds an expandable-string value to the selected key. 
An expandable string is a variable-length data string. This data type includes 
variables that are resolved when a program or service uses the data.

 Multiple String: Adds a multi-value string to the selected key. Multiple string 
values contain lists or multiple values in a form that people can read. Entries 
are separated by spaces, commas, or other marks.

 Qword: Adds a Qword string to the selected key. A Qword value is data 
represented by a number that is a 64-bit integer. This data is displayed in the 
Registry Editor as a binary value.

 Link: Adds a link string value to the selected key. A link string value is a 
Unicode string naming a symbolic link.

 None: Does not perform any registry operation.

 Full Resource Descriptor: Adds a full resource descriptor value to the 
selected key. A full resource descriptor is a series of nested arrays designed 
to store a resource list for a hardware component or driver.

 Resource List: Adds a resource list to the selected key. A resource list is a 
series of nested arrays that is designed to store a resource list that is used by 
a hardware device driver or one of the physical devices it controls.

 Resource Requirement List: Adds a resource requirements list to the 
selected key. A resource requirements list is a series of nested arrays 
designed to store a device driver's list of possible hardware resources that 
the driver or one of the physical devices it controls can use.

3. Specify the data. Depending on which value type you selected in the previous 
step, the type of data varies.

4. Select one of the following registry operations:

 Create Always: The setting is always created in the registry, even if it 
already exists. If it exists, the setting's current values are overwritten. For 
example, if PATH=C:\ already exists, PATH=C:\TEMP replaces it.

 Create If Exists: The setting is created only if it already exists. The setting's 
current values are overwritten. For example, if PATH=C:\ already exists, 
PATH=C:\TEMP replaces it.

 Create If Does Not Exist: The setting is created only if it does not already 
exist.

 Delete: The setting is deleted. If the registry setting has subordinate settings, 
the subordinate settings are also deleted.

 Append If Exists, Otherwise Create: Appends the registry value if the 
value currently exists in the workstation’s registry. If the registry value does 
not exist, it is created.

Task Steps
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E.25.2  Advanced Settings

The Advanced Settings page lets you configure the registry settings to apply. 

Figure E-28   Action - Registry Edit Dialog Box: Advanced Settings Page

Run Action As: Specify how you want the action to run:

 System: The action is run under the Local System user and inherits Administrator-level 
credentials. For example, the action has full rights to the HKEY_LOCAL_MACHINE hive.

Select the Apply HKEY_CURRENT_USER changes to the logged in user's hive instead of 
.DEFAULT option to enable the changes to be made in the user’s hive instead of the DEFAULT 
hive of HKEY_USERS.

 User: The registry file is applied using the logged-in user’s credentials. For example, the action 
has the same rights to the registry and the file system as the logged-in user. If you are changing 
keys in the HKEY_CURRENT_USER hive, you must run the action as User. Depending on the 

Rename an 
entry

1. Select the check box next to the desired item, then click Edit > Rename.

2. Specify the new name.

Remove an 
entry

1. Select the check box next to the desired item, then click Delete.

Import the 
contents of a 
registry file

1. Click Import, then specify the registry file whose contents you want to import.

Search for a 
registry value 
name, registry 
key, or both.

1. Specify the name of the value or key that you want to search for.

2. Select Registry Key/Value, Registry Value Data, or Both.

3. Select the Search within the selected nodes only check box to limit the search to 
the node you selected in the Registry Tree list.

4. Click Search.

Task Steps
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rights assigned to the user, the action might or might not have rights to the 
HKEY_LOCAL_MACHINE hive. If you select User, the user must be logged in to the device or the 
action fails.

Take a Backup of the Registry Before Applying the Registry File: Select the check box, then 
specify the path to the backup file, for example, c:\BackupFile.reg.

If you select this option, the entire registry is backed up before importing the configured registry 
file. The backup process is performed every time this action executes. This can be a time-consuming 
operation and the backup file can be large.

Before you edit the registry, export the keys in the registry that you plan to edit, or back up the entire 
registry by selecting this option. If a problem occurs, you can then restore the registry to its previous 
state.

E.26  Action - Run Script
The Action - Run Script dialog box lets you configure a script to be executed on the managed 
device. For the Run Script action to successfully complete, ensure that the script is silent (requires 
no user intervention). 

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs 
(Distribute, Install, Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down 
list, then select an available action.

The settings vary, depending on the type of script you select from the Script to run list. The 
following options are available:

 Section E.26.1, “Specify a File on a Managed Device,” on page 167

 Section E.26.2, “Define Your Own Script,” on page 169

 Section E.26.3, “Select From This Device,” on page 171

E.26.1  Specify a File on a Managed Device

Select this option to run a script that exists on the managed device.
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Figure E-29   Action - Run Script Dialog Box

Script Filename: Specify the path to the script file on the target device, for example, 
C:\scripts\xyz.pl.

Script Parameters: Specify any additional parameters you want to place on the command line after 
the script filename is specified. This results in parameters being passed to your executable script.

Path to Script Engine: Specify the interpreter that launches to run your script. For example, 
C:\Program Files\Perl\bin\Perl.exe.

For Windows scripts other than batch scripts (for example, VBScript), the Path to Script Engine 
field should specify the path to the Windows Based Script Host, such as 
(C:\Windows\System32\wscript.exe)

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 No wait: The next action in the list is immediately performed.

 When launch action is complete: The next action in the list is performed after the launch 
action completes.

 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next 
action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds option, 
this option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.

Success Return Codes: Specify the non-zero success codes that the script returns. You can specify 
multiple success codes separated by commas.
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If a script returns non-zero success codes, you should specify these non-zero success codes while 
launching the action. For example, explorer.exe in Windows returns a success code of 1. To 
successfully launch the Explorer application, you should add 1 as the success code while launching 
the action.

Specify the Success Return Code as * to enable any non-zero code returned by a script to be treated 
as success.

Working Directory: Click More Options to specify the script’s working directory. Specify the 
initial working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that 
runs the script. This option lets you configure how much of the CPU usage the script process 
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below 
Normal, and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

 System: Runs the script as the system account (as a service).

 Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an 
administrator account that is created on the fly to perform certain procedures, such as installing 
applications or running scripts. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required 
tasks, and then the account is deleted.

 User: The script runs, using the logged-in user’s credentials. For example, the script has the 
same rights to the registry and the file system as the logged-in user.

E.26.2  Define Your Own Script

Select this option to type a script in ZENworks Control Center.
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Figure E-30   Action - Run Script Dialog Box

Script Content: Click Edit to display a text box where you type your script. This script is delivered 
to the assigned devices and is executed in the standard device shell environment.

For example, you can automate drive mapping using the script capabilities of bundles. Your 
bundle’s script could read:

net use m: \\server\sys 

net use w: \\server\vol1

If the user is logged in as an eDirectory user with rights, then the mapping works. They can map a 
drive to a Windows share using a domain account by putting the username/password on the script 
line. If they are a logged in as an Active Directory user and have rights, the username/password is 
not required.

Save File with Extension: Specify the extension that you want appended to the script when it is 
saved. For example, .bat.

Path to Script Engine: Specify the interpreter that launches to run your script.

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 No wait: The next action in the list is immediately performed.

 When launch action is complete: The next action in the list is performed after the launch 
action completes.
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 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next 
action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds option, 
this option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.

Working Directory: Click More Options to specify the script’s working directory. Specify the 
initial working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that 
runs the script. This option lets you configure how much of the CPU usage the script process 
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below 
Normal, and Low.

Run As: Click More Options to specify the script’s run as setting. Specify an option:

 System: Runs the script as the system account (as a service).

 Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an 
administrator account that is created on the fly to perform certain procedures, such as installing 
applications or running scripts. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required 
tasks, and then the account is deleted.

 User: The script runs, using the logged-in user’s credentials. For example, the script has the 
same rights to the registry and the file system as the logged-in user.

E.26.3  Select From This Device

Select this option to specify a script file that is already on the device on which you are running 
ZENworks Control Center.
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Figure E-31   Action - Run Script Dialog Box

Select From This Device: Browse to and select the script file.

Script Parameters: Specify any additional parameters you want to place on the command line after 
the script filename is specified. This results in parameters being passed to your executable script.

Path to Script Engine: Specify the interpreter that launches to run your script.

Script Engine Parameters: Specify any parameters you want included on the command line when 
the script engine launches.

Wait Before Proceeding to Next Action: Specify what happens after the script is run:

 No wait: The next action in the list is immediately performed.

 When launch action is complete: The next action in the list is performed after the launch 
action completes.

 Wait for _ seconds: Wait the specified number of seconds before proceeding to the next 
action.

 Terminate action if wait period exceeded: If you select the Wait for _ seconds option, 
this option is enabled. If the specified number of seconds is exceeded and the action is not 
successfully performed, the action is terminated.

Working Directory: Click More Options to specify the script’s working directory. Specify the 
initial working directory for the script.

Priority: Click More Options to specify the script’s priority. Specify the priority of the process that 
runs the script. This option lets you configure how much of the CPU usage the script process 
consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below 
Normal, and Low.
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Run As: Click More Options to specify the script’s run as setting. Specify an option:

 System: Runs the script as the system account (as a service).

 Administrator: Runs the script as a dynamic administrator user. A dynamic administrator is an 
administrator account that is created on the fly to perform certain procedures, such as installing 
applications or running scripts. Using a dynamic administrator is helpful when installing 
applications (some MSI applications, for example) that cannot be installed in the system space. 
When you select this action, the dynamic administrator is created, it performs the required 
tasks, and then the account is deleted.

 User: The script runs, using the logged-in user’s credentials. For example, the script has the 
same rights to the registry and the file system as the logged-in user.

E.27  Action - Start/Stop Service
The Action - Start/Stop Service dialog box lets you specify the service that you want to start or stop.

Figure E-32   Action - Start/Stop Service Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Service Name: Specify a service and indicate whether you want to start or stop that service.

Select Action: Select one of the following actions:

 Start Service: Starts the specified service. If the service is already running on the device, the 
Start Service task completes.

 Stop Service: Stops the specified service. If the service is not running on the device, the Stop 
Service task completes.
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E.28  Action - Store Personality
The Store Personality page lets you specify the personality migration template and the path where 
the Platform Neutral Package (PNP) file is to be created. 

Figure E-33   Action - Store Personality Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click the Add drop-down list, then select 
the Apply Personality action.

Upload a template from this device  Select this option and click  to display the Upload content 
dialog box. Browse to and select the template to upload. 

Specify a template on the managed device  Select this option to specify the path of personality 
migration template file on the managed device. You can also specify the UNC path of the file.

Path where the PNP file is to be created Specify the path of the PNP file on the managed device 
for storing the migration settings and data. You can also specify the UNC path of the file.

Password to encrypt the PNP file Select this check box to enter a password to protect the PNP file.

In the Re-enter the password field, re-enter the password to confirm it.
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Span to multiple files You can choose to span the personality migration data across multiple files to 
enable you to store data in removable media. The available options are:

 Never span. Select this option to migrate personalities without spanning the files.

 Span at the size. Select this option to specify a span size for the files. The default span size is 
650 MB.

E.29  Action - Terminate Application
The Action - Terminate Application dialog box is displayed when you add a Terminate Application 
action. This dialog box lets you undo all operations that are performed in the launch action set. You 
can also configure a prompt to notify users of the termination. However, you are allowed to add the 
Terminate Application action only if it is not already added. 

The name and type of each process that is reversed displays in the list.

Figure E-34   Action - Terminate Application Dialog Box

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined 
link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. Click Add > 
Terminate Application.

Notify the User of Termination: Define the prompt that you want to display on the device. You can 
also specify different locales with different messages.

To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the 
specified locale. You can create different messages, each with its own locale setting.

3 Specify the text you want to display on the device.
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You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:

The application will terminate in {0} seconds. Please save your work.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

To remove a prompt, select the check box, then click Remove.

E.30  Action - Terminate Application Prompt
The Action - Terminate Application Prompt dialog box is displayed when you add a Terminate 
Application Prompt action. This dialog box lets you configure a prompt to notify users before the 
application terminates, including the number of seconds to notify the user, the number of times the 
prompt retries, and different messages for different locales. However, you are allowed to add the 
Terminate Application Prompt action only if it is not already added. 

Figure E-35   Action - Terminate Application Prompt Dialog Box

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined 
link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. Click Add > 
Terminate Application Prompt.  

Seconds to be Displayed: Specify the number of seconds that the prompt is displayed before the 
action is performed. For example, suppose you configure a prompt to notify the user that an 
application is in the process of terminating. If you specify that the prompt display for 10 seconds, the 
prompt displays for 10 seconds, then the application terminates.

Number of Retries Allowed: Specify the number of times the prompt displays before performing 
the next action.

Prompt the User to Save Any Unsaved Data: Define the prompt that you want to display on the 
device. You can also specify different locales with different messages.
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To create a message:

1 Click Add to display the Select Locale and Prompt dialog box.

2 Select a language from the Locale drop-down list. The message displays only on devices in the 
specified locale. You can create different messages, each with its own locale setting.

3 Type the text you want to display on the device.

You can include {0} in your text to provide a running counter that counts down the number of 
seconds to 0, after which the prompt is auto-accepted. For example, you could specify the 
following text:

The application will terminate in {0} seconds. Please save your work.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

E.31  Action - Undo Install Actions
The Action - Undo Install Actions dialog box lets you undo all operations that are performed in the 
install action set. The list displays the name and type of each operation that is reversed. There are no 
configuration tasks that you need to perform for this action.

You access this dialog box by using the following methods:

 As part of the process of creating a File bundle by using the Actions bundle category. For more 
information, see Section 2.2, “Creating File Bundles,” on page 23.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

E.32  Action - Uninstall Bundle
The Action - Uninstall Bundle dialog box lets you select a bundle to remove from the device.

Figure E-36   Action - Uninstall Bundle Dialog Box
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You access this dialog box by using the following methods:

 As part of the process of creating a File bundle by using the Actions bundle category. For more 
information, see Section 2.2, “Creating File Bundles,” on page 23.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Click  to browse to and select the bundle to uninstall from the device. 

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed (Directive, File, Imaging, and Windows bundles). If you know the 
name of the bundle you are looking for, you can use the Item name box to search for the bundle.

You must not use the Uninstall Bundle action to uninstall Directive bundles. 

Creating this action creates a bundle dependency. For more information, see Section 1.4, 
“Dependency Bundles,” on page 13.

E.33  Action - Verify Bundle
The Action - Verify Bundle dialog box lets you verify a bundle on the device. 

Verifying a bundle ensures that the specified bundle or bundle group has been properly installed on 
the device.

For example, for an MSI bundle, verifying the bundle results in the task running an MSI /repair 
process against the bundle.

Figure E-37   Action - Verify Bundle Dialog Box

You access this dialog box by using the following methods:

 As part of the process of creating a Directive bundle by using the Actions bundle category. For 
more information, see Section 2.1, “Creating Directive Bundles,” on page 19.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.

Click  to browse to and select the bundle to verify on the device. 
orks 10 Configuration Management Software Distribution Reference



The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the 
down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all 
types of bundles are displayed (Directive, File, Imaging, and Windows bundles). If you know the 
name of the bundle you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 1.4, 
“Dependency Bundles,” on page 13.

E.34  Action - Verify Install Actions
The Verify Install Actions action verifies all operations that are performed in the Install action set. 
This action does not require any configuration.

You access this dialog box by using the following methods:

 As part of the process of creating a File bundle by using the Actions bundle category. For more 
information, see Section 2.2, “Creating File Bundles,” on page 23.

 In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the 
Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Install, 
Launch, Verify, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an 
available action.
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F
FTroubleshooting

The following sections explains the scenarios that you might encounter while using the Bundles 
component of Novell ZENworks 10 Configuration Management.

 “Unable to locate the active text box in the user interface of ZENWorks Control Center” on 
page 181

 “Uploading content from a text file to a Directive bundle corrupts the content” on page 181

 “While launching applications, the window prompting for user input might not be displayed” 
on page 182

 “Unable to select a large number of files to upload to the content server while performing the 
Install Directory or Install Files action with the Firefox browser” on page 182

 “Unable to execute the Install MSI action on a Windows 2000 device” on page 182

 “Directive bundles might be shown as effective even though bundles cannot be assigned to 
Linux devices” on page 182

 “Cannot back up the registry and edit the HKEY_CURRENT_USER by using a single registry 
action on a Windows Vista device” on page 183

 “The Undo Install Actions fails to uninstall a directory” on page 183

 “Unable to launch a RDP session from a 64-bit device” on page 183

 “Unable to select an icon with the 64-bit Internet Explorer” on page 183

 “If the Wake-on-LAN schedule on the managed device is behind the server’s time zone, the 
device fails to wake up” on page 183

 “Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7 device taskbar” 
on page 184

 “Repairing an MSI that is installed on a device might reboot the device even if the norestart 
parameter is specified” on page 184

Unable to locate the active text box in the user interface of ZENWorks Control Center

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you use Firefox 2.0 to open ZENworks Control Center, the cursor might fail 
to appear in the active text box.

Action: Use Internet Explorer.

Uploading content from a text file to a Directive bundle corrupts the content

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you use the Edit Text File action to upload a text file containing extended 
characters, the content is corrupted. 

Action: Open the text file, save it as UTF-8, then upload the file.
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While launching applications, the window prompting for user input might not be 
displayed

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you use bundles to launch applications that require user input, the window 
prompting for the input might be hidden behind the application. This problem 
might occur if the applications are launched for the first time for each user 
login. 

Action: If you want to immediately view the window, minimize the application. To fix 
the problem, restart the system.

Unable to select a large number of files to upload to the content server while 
performing the Install Directory or Install Files action with the Firefox browser

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: You cannot select a large number of files to upload to the content server while 
performing the Install Directory or Install Files action with the Firefox 
browser.

Action: Upload a smaller number of files with the Firefox browser, or use the Internet 
Explorer browser to perform the action.

Unable to execute the Install MSI action on a Windows 2000 device 

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If Grant administrator privilege to user during installation is selected in the 
Install MSI dialog box to provide administrator privileges to the logged in 
user, the user is prompted to provide the log in credentials when the Install 
MSI action is executed on the device. The action fails to execute even if the 
user has provided the correct password.

Action:  Add the user as a part of the operating system as follows:

1 Run MMC.

2 Click File > Add/Remove Snap-in, click Add.

3 In the Add Standalone Snap-in dialog box, select Group Policy Object 
Editor, click Add > Finish.

4 Click Close to close the Add Standalone Snap-in dialog box.

5 Click OK.

6 In the Console Root window, double-click Computer Configuration > 
Windows Settings > Security Settings > Local Policies > User Rights 
Assignment > Act as part of the operating system

7 Click Add User or Group.

8 In Enter the object names to select, specify the user name. Click OK.

9 Click OK.

Directive bundles might be shown as effective even though bundles cannot be 
assigned to Linux devices

Source: ZENworks 10 Configuration Management; Software Distribution.
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Explanation: Because Linux devices cannot have the ZENworks Adaptive Agent, you 
cannot assign bundles to be sent to them. However, in ZENworks Control 
Center, Directive bundles assigned to a Linux device might show as effective, 
which is incorrect.

Action: Ignore.

Cannot back up the registry and edit the HKEY_CURRENT_USER by using a single 
registry action on a Windows Vista device

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you set up an action to both back up the registry and edit the 
HKEY_CURRENT_USER registry entry on Windows Vista, the action fails 
because all user-initiated processes in Vista run as the lowest privileged user.

Action: Use two different registry actions, one to back up the registry in the system 
context, and another to edit HKEY_CURRENT_USER in the user context.

The Undo Install Actions fails to uninstall a directory

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: When you create an Install Directory File bundle, the directory is installed 
even if its name contains spaces; however, it cannot currently be uninstalled by 
using the Undo Install Actions action.

Action: Avoid spaces in directory names if you want to enable the uninstallation of that 
directory.

Unable to launch a RDP session from a 64-bit device 

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you launch a Launch Windows Thin Client Application action configured 
with the RDP Session on a 64-bit managed device, the action might fail.

Action: Apply the KB925876 patch (http://support.microsoft.com/kb/925876).

Unable to select an icon with the 64-bit Internet Explorer 

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you use the 64-bit Internet Explorer to launch ZENworks Control Center, 
then click the browse icon to browse to and select an icon from the icon 
resources such as an .exe, .dll, or .ico file, one of the icons from the resource 
file is selected by default. You cannot select any other icon.

Action: Use the 32-bit Internet Explorer to launch ZENworks Control Center.

If the Wake-on-LAN schedule on the managed device is behind the server’s time 
zone, the device fails to wake up 

Source: ZENworks 10

 Configuration Management; Software Distribution.
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Explanation: If a bundle having the distribution schedule configured is assigned to a 
managed device such that the Wake-on-LAN schedule is behind the server’s 
time zone, the device fails to wake up.

Action: Ensure that the Wake-on-LAN schedule on the managed device is not behind 
the server’s time zone.

Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7 device 
taskbar

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you assign a bundle to a Windows 7 managed device and choose to place the 
bundle shortcut icon in the Quick Launch area of the device, the bundle 
shortcut icon is not visible because Quick Launch is disabled by default on a 
Windows 7 device.

Action: To enable Quick Launch on a Windows 7 device taskbar:

1 Right-click the taskbar and click Toolbars.

2 Click New Toolbar to open the New Toolbar window.

3 In the Folder option, specify the following: 
%UserProfile%\AppData\Roaming\Microsoft\Internet 

Explorer\Quick Launch.

4 Click Select Folder.

To customize Quick Launch on a Windows 7 device taskbar: 

1 Right-click the taskbar and deselect Lock the Taskbar.

2 (Optional) Click and drag the Quick Launch to the desired position on the 
taskbar.

3 Right-click Quick Launch and deselect Show Title and Show Text to 
disable title or text display.

4 Right-click Quick Launch. Click View > Small Icons to enable small 
icons.

Repairing an MSI that is installed on a device might reboot the device even if the 
norestart parameter is specified 

Source: ZENworks 10 Configuration Management; Software Distribution.

Explanation: If you run the Install MSI action to repair an MSI that has already been 
installed on a device, the device might reboot. This is because /f option that 
repairs a product can reboot the device. For more information, see Microsoft 
Support Site (http://support.microsoft.com/kb/961883/EN-US).

Action: Perform the following steps to repair a package without a reboot: 

1 In ZENworks Control Center, click the MSI Application Bundle you want 
to repair.

2 Click Actions > Install. 

3 Click the Install MSI action to display the Edit Action - Install MSI dialog 
box. 
orks 10 Configuration Management Software Distribution Reference

http://support.microsoft.com/kb/961883/EN-US
http://support.microsoft.com/kb/961883/EN-US


4 In the Repair Parameters option, Click  to display the Repair 
Parameters dialog box.

5 In the Command Line Parameters option, specify /i instead of /f, then 
click OK.

6 In the MSI Properties panel, add the following properties:

 Name = REINSTALLMODE ; Value = omus 

 Name = REBOOT ; Value = ReallySupress 

7 Click OK.
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G
GBest Practices

The following sections contain information on the best practices to follow while using the Bundles 
component of Novell ZENworks 10 Configuration Management:

 Section G.1, “Changing the Look and Feel of the Start Menu on a Windows Vista Device,” on 
page 187

 Section G.2, “Pinning Applications to the Start Menu on a Windows Vista Device,” on 
page 187

 Section G.3, “Assigning Bundles to a Device or User,” on page 187

 Section G.4, “ZENworks Explorer Folder Naming Convention,” on page 188

 Section G.5, “Creating Bundles with Large Content,” on page 188

G.1  Changing the Look and Feel of the Start 
Menu on a Windows Vista Device
On a Windows Vista device, the folders on the Start menu have a cascading effect. To have the same 
look and feel as the Windows XP Start menu:

1. Right-click Start.

2. Click Properties.

3. Select Classic Start Menu.

4. Click OK.

G.2  Pinning Applications to the Start Menu on a 
Windows Vista Device
On a Windows Vista device, you can choose to have the folders pinned to the Start menu to have the 
same look and feel as the pinned folders on the Windows XP Start menu.

1. Right-click Start.

2. Click Properties.

3. Select Classic Start Menu.

4. Click OK.

5. Restart the system.

G.3  Assigning Bundles to a Device or User
Do not assign more than two bundles that has the same name to a Windows managed device because 
only the first two bundles that are assigned to the device are displayed on the device.
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Sample Scenario: Assume that bundles named test, Test, TEST are assigned to a Windows managed 
device. The first bundle that is assigned to the device has the specified name. The second bundle that 
is assigned to the device has the management zone name appended to the specified name. However, 
the third bundle is not displayed on the device.

G.4  ZENworks Explorer Folder Naming 
Convention
If the ZENworks Explorer Folder name for two or more bundles is the same but has a different case, 
then only one folder and containing all the bundle's shortcuts is displayed in the start menu and the 
ZENworks Explorer window.

G.5  Creating Bundles with Large Content
By default, ZENworks Control Center has a 30-minute timeout value. If you choose to create 
bundles with a large amount of content, you must change the ZENworks Control Center timeout 
value as required. For information on the changing the timeout value for ZENworks Control Center, 
see  “Changing the Timeout Value for ZENworks Control Center” in the ZENworks 10 
Configuration Management System Administration Reference.
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H
HMacros

The following sections contain information on the macros supported in Novell ZENworks 
Configuration Management:

 Section H.1, “Windows Macros,” on page 189

 Section H.2, “Login Script Macros,” on page 194

 Section H.3, “Novell eDirectory Attribute Macros,” on page 195

H.1  Windows Macros
A Windows macro is one that defines the Windows directories. The typical paths listed below are 
based on default installations and might not match your specific setup.

Suppose that you have installed Windows to drive D: (for example, D:\WINDOWS). However, an 
application installation expects Windows to be on drive C: (for example, C:\WINDOWS). You can use 
the WinDisk macro to substitute drive D: for the files that require it.

Table H-1   Windows Macros

Macro Description

${AdminTools} File system directory that contains the administrative tools that appear in the 
Control Panel when a specific user logs on to the device. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Start 
Menu\Programs\Administrative Tools.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Start 
Menu\Programs\Administrative Tools. 

${AllUsersProfile} File system directory that contains common profile for all the users.

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically  
C:\ProgramData.

${AppData} File system directory that serves as a common repository for application-
specific data. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Application Data.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming.
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${CommonDesktop} File system directory that contains files and folders that appear on the desktop 
for all users. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Desktop.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Public\Desktop.

${CommonPrograms} File system directory that contains the directories for the common program 
groups that appear on the Start menu for all users.

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Start Menu\Programs.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\ProgramData\Microsoft\Windows\Start Menu\Programs.

${CommonStartMenu} File system directory that contains the programs and folders that appear on the 
Start menu for all users. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Start Menu. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\ProgramData\Microsoft\Windows\Start Menu. 

${CommonStartup} File system directory that contains the programs that appear in the Startup 
folder for all users. The system starts these programs whenever any user logs 
on. 

On a Windows Server 2003 or Windows XP device, typically this directory is 
C:\Documents and Settings\All Users\Start 
Menu\Programs\Startup. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, typically this 
directory is C:\ProgramData\Microsoft\Windows\Start 
Menu\Programs/Startup. 

${CommonAdminTools
}

File system directory that contains the administrative tools that appear in the 
Control Panel for all users who logs in to the device. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Start 
Menu\Programs\Administrative Tools.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\ProgramData\Microsoft\Windows\Start 
Menu\Programs\Administrative Tools.

${CommonAppData} File system directory that contains the application-specific data for all users 
who logs in to the device. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Application Data.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\ProgramData.
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${CommonDocuments} File system directory that contains the documents shared by all users who log 
in to the device.

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\All Users\Documents.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Public\Documents.

${CommonProgramFile
s}

File system directory that contains the program files shared by multiple 
applications. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Program Files\Common Files.

${CommonTemplates} File system directory that contains the document templates shared by all users 
who log in to the device. 

On a Windows Server 2003 or Windows XP device, it is typically  
C:\Documents and Settings\All Users\Templates.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically  
C:\ProgramData\Microsoft\Windows\Templates.

${Cookies} Files system directory that contains the user’s cookies.

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Cookies.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Cookie
s.

${Desktop} File system directory used to physically store file objects on the desktop (not 
the desktop folder itself). 

On a Windows Server 2003 or Windows XP device, typically this directory is 
C:\Documents and Settings\Username\Desktop.

On a Windows Server 2008, Windows Vista, or Windows 7 device, typically this 
directory is C:\Users\Username\Desktop.

${Favorites} File system directory that serves as a common repository for the user’s favorite 
items. 

On a Windows Server 2003 or Windows XP device, typically this directory is 
C:\Documents and Settings\Username\Favorites.

On a Windows Server 2008, Windows Vista, or Windows 7 device, typically this 
directory is C:\Users\Username\Favorites.

${Fonts} Virtual folder containing fonts. Typically C:\Windows\Fonts. 

${History} File system directory that contains the user’s history of visited Internet 
addresses. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Local Settings\History.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Local\Microsoft\Windows\History.

Macro Description
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${LocalAppData} File system directory that serves as a common repository for application-
specific data. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically, 
C:\Users\Username\AppData\Local.

${MyPictures} File system directory that contains a specific user’s graphics files. 

On a Windows Server 2003 or Windows XP device, it is typically 
c:\Documents and Settings\Username\My Documents\My 
Pictures.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
c:\Users\Username\Pictures.

${NetHood} File system directory containing objects that appear in the network 
neighborhood. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\NetHood.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\Roaming\Microsoft\Windows\Network 
Shortcuts.

${Personal} File system directory that serves as a common repository for documents. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\My Documents.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\Documents.

${PrintHood} File system directory that serves as a common repository for printer links. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\PrintHood.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Printe
r Shortcuts.

${Programs} File system directory that contains the user’s program groups, which are also 
file system directories. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Start Menu\Programs.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Start 
Menu\Programs.

${ProgramData} File system directory that contains the user’s program groups, which are also 
file system directories. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\ProgramData.

Macro Description
orks 10 Configuration Management Software Distribution Reference



${ProgramFiles} File system directory that contains the user’s program files on a 32-bit device or 
the user’s 64-bit program files on a 64-bit device. 

Typically C:\Program Files.

${ProgramFiles32} File system directory that contains the user’s 32-bit program files on a 64-bit 
device. Typically C:\Program Files(x86).

${ProgramFilesCommo
n} 

File system directory that contains the program files shared by multiple 
applications. Typically C:\Program Files\Common Files.

${Public} File system directory that has public access to all the users on the network. 

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Public.

${Recent} File system directory that contains the user’s most recently used documents. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Recent.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Recent

${SendTo} File system directory that contains Send To menu items.

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\SendTo.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\username\AppData\Roaming\Microsoft\Windows\SendTo

${StartMenu} File system directory containing Start menu items. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Start Menu.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Start 
Menu.

${Startup} File system directory that corresponds to the user’s Startup program group. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Start 
Menu\Programs\Startup.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Startu
p.

${TempDir} Windows temporary directory. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Local Settings\Temp.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Local\Temp.

Macro Description
Macros 193



194 ZENw
NOTE: For compatibility with traditional ZENworks, the macros can also be specified in one of the 
following formats:

 %macro%

For example, %ProgramFiles%

 %*macro%

For example, %*ProgramFiles%

H.2  Login Script Macros
The following table lists the supported login script macros: 

Table H-2   Supported Login Script Macros

${Templates} File system directory that serves as a common repository for document 
templates. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Templates.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\AppData\Roaming\Microsoft\Windows\Templa
tes.

${UserProfile} File system directory that contains the logged-in user’s profile. 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username.

${WinDesktop} Windows desktop directory 

On a Windows Server 2003 or Windows XP device, it is typically 
C:\Documents and Settings\Username\Desktop.

On a Windows Server 2008, Windows Vista, or Windows 7 device, it is typically 
C:\Users\Username\Desktop.

${WinDir} Windows directory. Typically C:\WINDOWS.

${WinDisk} Drive letter (plus colon) for the Windows directory. Typically C:.

${WinSysDir} Windows system directory. Typically C:\WINDOWS\system32.

${WinSysDisk} Drive letter (plus colon) for the Windows system directory. Typically C:.

Macro Description

${COMPUTER_NAME} The name of the computer. For example: work_pc.

${DAY} Numeric day of the month. For example: 01, 10, 15.

Macro Description
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NOTE: For compatibility with traditional ZENworks, the macros can also be specified in one of the 
following formats:

 %macro%

For example, %MONTH%

 %*macro%

For example, %*MONTH%

H.3  Novell eDirectory Attribute Macros
Application Launcher supports macros that pull information from the attributes of the currently 
logged-in user or from the attributes of other eDirectory objects.

The following sections explain the macro syntax and provide examples:

 Section H.3.1, “Syntax,” on page 195

 Section H.3.2, “Examples,” on page 196

 Section H.3.3, “Configuring the eDirectory Attribute Macros,” on page 196

H.3.1  Syntax

eDirectory attribute macros use the following syntax:

${HOUR24} Time of the day according to a 24-hour clock. For example: 02, 05, 14, 22.

${HOUR} Hour of the day. For example: 0 = 12, 13 = 1.

${LAST_NAME} Last name of the current user (also known as the user’s eDirectory 
Surname attribute). For example: Jones.

${MINUTE} Current minute. For example: 02, 59.

${MONTH} Current month number. For example: 01 for January.

${NDAY_OF_WEEK} Numeric day of the week. For example: 1 for Sunday, 2 for Monday.

${NETWORK} Workstation network address. For example: 01010120.

${OS_VERSION} Version of the OS. For example: v5.00.

${OS} OS type. For example: MSDOS, WIN98, WINNT, WIN2000, WINXP. 

${PLATFORM} Platform running. For example: WIN32NT.

${PHYSICAL_STATION} MAC address. For example: 0000C04FD92ECA.

${SECOND} Number of seconds. For example: 03, 54.

${SHORT_YEAR} Short year number. For example: 97, 00.

${WINVER} Windows version. For example: v3.11, v4.00.

${YEAR} Full year number. For example: 2008.

Macro Description
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${eDirectory_attribute}

Table H-3   Macro Syntax

H.3.2  Examples

The following table provides examples of eDirectory attribute macros.

Table H-4   Macro Examples

NOTE: For compatibility with traditional ZENworks, the macros can also be specified in one of the 
following formats:

 %macro%

For example, %CN%

 %*macro%

For example, %*CN%

H.3.3  Configuring the eDirectory Attribute Macros

To use eDirectory attributes as a reference in the bundle macros, you must do the following:

Element Description

$ Flags the text as a macro. The entire macro must be enclosed in $  
characters.

eDirectory_attribute Defines the attribute to be read.

You can use the ConsoleOne Schema Manager (available from the Tools 
menu) to view an eDirectory object’s available attributes.

Macro Description

${CN} Returns the common name of the currently logged-in user.

${DN} Returns the distinguished name of the currently logged-in user.

${FullName} Returns the full name of the currently logged-in user. This is 
the name defined in User object > General tab > Identification 
page > Full Name field. 

${Given Name} Returns the first name of the currently logged-in user. This is 
the name defined in User object > General tab > Identification 
page > Given Name field.

${Surname} Returns the last name of the currently logged-in user. This is 
the name defined in the User object > General tab > 
Identification page > Last Name field.
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On the eDirectory Server:

Define a name mapping between LDAP attribute types and eDirectory attribute definitions. You can 
log in to Novell iManager and click Attribute Map to do the mapping. For example, you can choose 
to map an eDirectory attribute named GWMailID, which stores the user e-mail id, to a Primary LDAP 
Attribute named Mail.

Only User attributes are supported.

For information on mapping the LDAP attribute types and eDirectory attribute, see Novell 
eDirectory Administration guide at the Novell Documentation Website (http://www.novell.com/
documentation/). 

On the ZENworks Server:

1 Edit the following sample file to create a file that contains the attribute that you want to use 
with ZENworks:

 On Windows: ZENworks_Home/novell/zenworks/datamodel/authsource/
edirectory-users-additional.zls.xml.sample

 On Linux: /etc/opt/novell/zenworks/datamodel/authsource/edirectory-
users-additional.zls.xml.sample

2 Add an entry for the attribute that you want to use with ZENworks. For example:

<attribute name="ZEN" ldapName="Mail" 
builder="com.novell.zenworks.datamodel.session.jndi.builder.StringAttribu
teBuilder" />

where ZEN is the attribute that you want to use with ZENworks and  Mail is the Primary LDAP 
Attribute that you mapped with the eDirectory attribute named GWMailID.

NOTE: You have to use the right builder depending on whether the syntax is a string, integer, 
or boolean. The edirectory-users-additional.zls.xml.sample file lists the different type of 
builders.

3 Save the sample file as edirectory-users-additional.zls.xml.

4 Replace the edirectory-users-additional.zls.xml file on all the Primary Servers in the 
Management Zone. 

5 Restart the zenserver service.

6 Create a bundle with an action that references the macro and is running in the user 
impersonation mode. For example, create a bundle with a Run Script action that references the 
macro ${ZEN}  and the executable security level is set to Run as logged in user. 

7 Perform the bundle assignment.

When the action gets executed on the managed device, the value of the LDAP attribute is substituted 
for the macro. In the stated example, the email id stored in the GWMailID attribute is substituted for 
the macro ${ZEN}. Consequently, when the action gets executed on the managed device, the e-mail 
id stored in the GWMailID attribute is displayed on the device.
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I
IDocumentation Updates

This section contains information on documentation content changes that were made in this 
ZENworks Software Distribution Guide for Novell ZENworks 10 Configuration Management SP3. 
The information can help you to keep current on updates to the documentation.

The documentation for this product is provided on the Web in two formats: HTML and PDF. The 
HTML and PDF documentation are both kept up-to-date with the changes listed in this section.

If you need to know whether a copy of the PDF documentation that you are using is the most recent, 
the PDF document includes a publication date on the title page.

The following updates were made to the document:

 Section I.1, “November 17, 2011: Update for ZENworks 10 Configuration Management SP3 
(10.3.4),” on page 199

 Section I.2, “December 24, 2010,” on page 199

 Section I.3, “November 22, 2010,” on page 200

I.1  November 17, 2011: Update for ZENworks 10 
Configuration Management SP3 (10.3.4)
Updates were made to the following changes sections:

I.2  December 24, 2010
Updates were made to the following changes sections:

Location Change

Appendix G, “Best Practices,” 
on page 187

Updated the section

Section H.3, “Novell eDirectory 
Attribute Macros,” on page 195

Updated the section

Appendix E, “Actions,” on 
page 117

Added the following information in Run Script, Launch Java 
Application, and the Launch Executable actions sections:

Specify the Success Return Code as * to enable any non-zero code 
returned by a script to be treated as success.

Location Change

Appendix E, “Actions,” on 
page 117

Added information about the Apply HKEY_CURRENT_USER changes 
to the logged in user's hive instead of .DEFAULT option in the section, 
“Run Action As:” on page 166.
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I.3  November 22, 2010
Updates were made to the following changes sections:

Location Change

Appendix H, “Macros,” on 
page 189

Updated the section.

Section 3.11, “Editing Bundle 
Schedules,” on page 63

Added the section.
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